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About this guide

This guide explains concepts and features, as well as their usage in the application. To display the
online help while working in the application, select Infor Fashion PLM from the Help menu or press
F1.

Intended audience

This document is primarily for Infor Fashion PLM users and Infor consultants who need to understand
how the application works and how to maximize its features.

Organization

The document is structured based on what users must understand to navigate and use the application.
In general, the document covers these topics:

DescriptionTopic

This chapter explains concepts and first steps that you must
do to be able to use the application. It also describes how to
navigate Infor Fashion PLM across all features.

Getting started

These chapters describe the basic features of a product lifecyle
management (PLM) application. It also explains how to set up
these features, as well as how they relate to one another in
creating fashion products. This chapter also explains how to
create and set up reports within the application.

Understanding the basics and set-
ting up the application

This chapter describes how you can track operations within
the application. It also explains how you can monitor the
progress of your product development by planning work capac-
ity and setting deadlines.

Tracking and planning

This chapter explains who to create, manage, and customize
styles. It describes how to define the costing, bill of materials
(BOM), measurements, and care instructions of a style record.
This chapter also explains how to create and update multiple
styles simultaneously within the application.

Style

This chapter explains how to create, manage, and customize
materials that you use in creating styles. It describes how to
define the construction of materials in the application, as well
as how to create and update multiple materials simultaneously
within the application.

Material
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DescriptionTopic

This chapter explains how to create, manage, and customize
trims that you use in creating styles. It also explains how to
create and update multiple trims simultaneously within the
application.

Trim

Related documents
You can find these documents in the product documentation section of the Infor Xtreme Support portal,
as described in:

• Infor Fashion PLM Planning Application Host Installation Guide
• Planning Application Host Administration Guide (also available as PAH Online Help)
• Infor Fashion PLM Partner Collaboration Installation Guide
• Infor Fashion PLM Partner Collaboration User Guide
• Infor Fashion PLM Localization Tool Installation Guide
• Infor Fashion PLM Localization Tool User Guide
• Infor Fashion PLM Connector Toolbox Installation Guide
• Infor Fashion PLM Connector Toolbox User Guide
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Contacting Infor

If you have questions about Infor products, go to Infor Concierge at https://concierge.infor.com/ and
create a support incident.

If we update this document after the product release, we will post the new version on the Infor Support
Portal. To access documentation, select Search > Browse Documentation. We recommend that you
check this portal periodically for updated documentation.

If you have comments about Infor documentation, contact documentation@infor.com.
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Chapter 1: Getting started

Learn the concepts and basic features of the application.

Infor Fashion PLM overview
Infor Fashion PLM is a product lifecycle management application that is designed for customers in the
apparel, footwear, home textile, and accessories industries. The application supports these processes:

• Product development
• Merchandise planning
• Product data management
• Collaboration
• Vendor management
• Testing
• Pricing and costing
• Sample management

For information on system requirements, see Infor Fashion PLM Planning Application Host Installation
Guide.

Accessing the application
By default, the authentication of Infor Fashion PLM is set to Windows Authentication and users are not
required to sign in. If authentication is set to Basic Authentication, users are required to sign in by using
a login name and a password. When the authentication is set, for the first time, to Basic Authentication,
the password of your existing account in multi-user mode is set to password. Upon initial sign in, you
will be asked to change your password.

See “Set the authentication mode” in the Infor Fashion PLM Planning Application Host Installation
Guide.

If the E-mail Settings of Infor Fashion PLM is set up and Basic Authentication is enabled, a newly
created user will be assigned a random password that will be sent through email. If E-mail Settings is
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not set up and Basic Authentication is enabled, the default password for a newly created user is
password. Upon initial sign in, the user will be asked to change the password.

See Configuring email messages on page 24.

See “Managing users” in the PAH Online Help.

1 Open Infor Fashion PLM.

2 If authentication is set to Basic Authentication, specify this information:

Login
Specify the login name.

Password
Specify the password.

3 Click Log on.

Application window
The Infor Fashion PLM window emphasizes actual functions of the application by presenting main
features as widgets. These are the sections of the application window:

DescriptionSection

Contains the menu items used in PLM and the settings for
Planning Application Host (PAH)

Main menu

Contains action icons for an open feature in PLMToolbar

Contains the main features in PLMHome menu

Contains icons that show attribute panesSidebar

Shows all the features that you open using the main menu and
the home menu

Workbench

Shows the default profile, active version, and number of records
in an active panel

Status bar

In Infor Fashion PLM, windows can be classified into these two types:

DescriptionType

Pertain to main windows or pages of information. Users do most
of the interaction and activities in panels. When opened, panels
occupy the entire workbench.

Examples of panels include overview pages, details pages, and
tabs.

Panels
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DescriptionType

Pertain to smaller windows that show secondary information,
such as associated attributes.

Panes

Managing the home dashboard
The home dashboard contains dynamic widgets, which serve as shortcuts to application modules.
Widgets enable you to access features in one click, without navigating the main menu. They also
display application data in real time.

For example, any updates in the application, such as a new comment or a newly edited style item, will
be reflected in the Comments and Recently Edited widgets within a time frame that you specify in the
dashboard settings.

These widgets can be added and customized on the home dashboard:

DescriptionWidget

Contains commonly used modules in the applicationLibraries

Contains filters from the setup of your organization structureMy Folders

Contains a list of your saved layoutsFavorites

Displays activities and milestones and their respective due datesFollow Up

Displays the most recently modified records in the applicationRecently Edited

Displays notification messages about updates to items made by other
users

Note:  Integration activities made through Infor Fashion PLM Connec-
tor Toolbox and actions made by users for requests in Infor Fashion
PLM Partner Collaboration also appear on the Notifications widget.

Notifications

Displays the most recent commentsLatest Comments

Infor Fashion PLM enables you to add, modify, and reorganize widgets on the home dashboard. Within
a widget, you can further modify the functions displayed by configuring widget settings. To customize
the dashboard, click the Edit Dashboard icon on the main menu. A list of application features is
displayed on the sidebar.

You can do these actions on the dashboard:

• To add a widget to the dashboard, select a feature from the list.
• To delete a widget from the dashboard, click the X icon on the upper right-hand corner of the widget.
• To reorganize the dashboard, drag and drop widgets anywhere on the workbench.
• To modify functions displayed within a widget, click the Settings icon on the upper right-hand corner

of the widget to open a list of functions within the widget. Specify the necessary fields and click
Save.
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• To specify the time interval between data refreshes in all widgets, drag the Refresh Interval slider
to any point within the time range. Refresh intervals range between 10 and 500 seconds.

To save the customized settings of your dashboard, click the Edit Dashboard icon.

Note:  In a multi-user setup, custom settings of the home dashboard are saved for each user and each
version. If your dashboard is set to public, you can share your dashboard settings to other users,
provided that they use the same version that you use in the application.

Configuring application settings
The application contains several configuration options that enable you to specify how features should
work.

Configuring attachments and images
Infor Fashion PLM supports the use of attachments and images for most of its entities. To attach files
and images, you must first configure Infor Fashion PLM to a central file path to store attachments and
images uploaded in Infor Fashion PLM. Attachments that are deleted from Infor Fashion PLM can still
be opened using the central file path.

Note:  File name for images and other attachments should only contain a maximum of 200 characters.
This applies to all attachments and images you must include in all items from Basic, Setup, and other
modules.

1 Select Admin > Configure - Infor Fashion PLM.

2 Click Attachments.

3 Specify the image server and folder. By default, your local computer name is displayed.

4 Use the ellipsis button to browse for and select a central file attachment path for file storage.

Note:  In a multi-user setup, the central file attachment path that you specify must be a shared
location where all users of Infor Fashion PLM have read/write access.

5 In the Resize Existing Photos - Settings section, select one of these options:

• Allow unrestricted photos
• Confirm with user if photos may be resized
• Resize photos (to the selected size) before they are saved

6 To resize existing images in the application, select a size option from the list and click Resize or
Resize Thumbnail Photos.

7 In the Image Upload Limit section, select one of these options:

• Confirm with user if photos exceed max file size
• Do not allow users to upload if photos exceed max file size
• None

8 Optionally, to set a maximum file size for images, specify the maximum file size.
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9 To associate image files to a specific program, specify this information:

File extension
Specify the image file extension in this format: “*.imageformat”.

For example, specify “*.jpg”.

Editor executable path

Provide the exe. file of the program that will open the specified image type outside the PLM
application.

For example, type c:\windows\system32\mspaint.exe to enable Microsoft Paint to open
images from the application.

10 Click Save.

Configuring organization settings
You can add basic information about your organization in the organization settings. This information
is used in purchase order reports and email signature. The logo is used in reports and on the Partner
Collaboration site.

1 Select Admin > Configure - Infor Fashion PLM.

2 Click Organization Settings.

3 Under Company Logo Settings, drag and drop an image from your local computer to the image
holder.

4 On the Main tab under Organization Settings, specify this information:

Company name
Specify the company name.

Address 1
Specify the company address 1.

Address 2
Specify the company address 2.

Postal Code
Specify the postal code.

City
Specify the city.

County
Specify the county.

Country
Select a country from the list.

Main Contact
Specify the main contact.
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Email Address
Specify the email address.

5 To identify other locations for your organization, click the Other Locations tab.

6 Specify this information:

Company name
Specify the company name.

Address 1
Specify the company address 1.

Address 2
Specify the company address 2.

Postal Code
Specify the postal code.

City
Specify the city.

County
Specify the county.

Country
Select a country from the list.

Main Contact
Specify the main contact.

Email Address
Specify the email address.

7 Click Save.

Configuring date and time settings
You can customize the display of the date and time inside the application by configuring the date and
time settings. The specified settings is applied to all features that require the date and time display.

1 Select Admin > Configure - Infor Fashion PLM.

2 Click Date and Time Settings.

3 Specify this information:

Date Format
Select a date format from the list.

Year Display
Select a year format from the list.
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Month Display
Select a month format from the list.

4 Optionally, select Display Day of Week in Day of Week Settings.

Note:  If this option is selected, the Day of Week Display field is enabled. Select a display format
from the list.

5 In Time Settings, select from the available time settings options.

6 Click Save.

Configuring color settings
1 Select Admin > Configure - Infor Fashion PLM.

2 Click Color Settings.

3 Under the BOM Color Attribute section, select one of these options:

Color Pitch Only
Displays colors only.

Name
Displays the color and the color name.

Code
Displays the color and the color code.

Name and Code
Displays the color, the color name, and the color code.

Optionally, you can further customize the format, order, and separator of the color code and code
name.

4 Under the BOM Item Colorway Restrictions section, select the items that you want to have restricted
colorway options.

Note:  If the BOM item colorway restriction is applied to a Style, Material, or Trim, only the colors
that are available in the colorway of the selected item will apply.

5 Click Save.

Configuring critical path settings
Critical path settings enable you to set your work week and work hours, which are necessary in defining
the schedule for milestones and follow-up of styles. Defining the work days and work hours enables
you to compare the working capacity of a user in a given time frame against the demands and deadlines
of a particular activity.

1 Select Admin > Configure - Infor Fashion PLM.
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2 Click Critical Path.

3 To define the basis for calculating progress of your workload, select Number of activities or
Workload.

4 To define your work week, specify this information:

Work Day
Select the corresponding check box to define a week day as a working day.

Capacity
Specify a number to define working hours in a day.

Start Time
Specify a number to define the start time in each work day.

5 To define nonworking days, specify this information:

Date From
Select a start date from the date picker.

Date To
Select an end date from the date picker.

6 Click Save.

Configuring data filtering and search filter settings
Data filtering enables you to specify users' access to nodes or levels in your organizational structure.

See Identifying user access to levels of your organizational structure on page 124.

The search filter, on the other hand, enables you to also define columns to include when users do a
search in the grid overview using the Ctrl + F keyboard shortcut. This search filter is enabled for Style,
Material, Trim, and Color.

Configure data filter
1 Select Admin > Configure - Infor Fashion PLM.

2 Click Data Filtering.

3 Specify this information:

Enable Data Filtering (Internal Users)
Select this option to enable data filtering for internal users.

Enable Data Filtering (Normal Users)
Select this option to enable data filtering for normal users.
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Configure search filter
1 On the Search Filter section, select the Enable Search by Select Columns check box.

2 On the Style, Material, Trim, and Color tabs, select columns to include in a grid overview search.

3 Click Save.

Configuring email messages
You can send emails from any network for any email address by configuring email settings in Infor
Fashion PLM.

Before you start configuring the email messages, contact your network administrator or Internet service
provider to identify the IP address and port number of your SMTP Server.

1 Select Admin > Configure - Infor Fashion PLM.

2 Click E-Mail Settings.

3 Under Mail Settings, specify a header.

4 To edit the signature, click Edit.
5 In the Signature Editor window, specify and format your email signature.

You can include on your signature predefined information from the Organization Settings by selecting
codes from the drop-down list on the right portion of the editor.

6 Click OK.

7 Under Mail Server Settings, specify this information:

Use as default setting
Optionally, select the checkbox to set the created mail server settings as default settings.

SMTP Server
Specify the IP address or IP name of the outgoing mail server (SMTP server) that you intend to
use to send emails.

Port
Specify the port number of the SMTP Server.

Windows Authentication

Optionally, select the check box to connect your email settings in Infor Fashion PLM with your
Windows login credentials.

Note:  If you enable Windows authentication, your Windows user name and password are used
automatically to send emails in Infor Fashion PLM. Specifying your user name and password is no
longer necessary.

E-mail Address
Type the email address that you intend to use in sending emails.
Note:  The email address that you provide must use the IP address of the SMTP Server that you
specified.
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User Name
Specify your user name.

Password
Specify a password.

Use SSL
Optionally, select the check box to secure your email connection and protect your data by enabling
Secure Socket Layer (SSL) protocol.

Client Certificate
Optionally, upload an SSL certificate from your local computer by clicking the ellipsis button.

8 To verify if your email settings are correct and a connection can be established, click Test
Connection.

You should receive an email verifying that a connection was successfully established.

9 Click Save.

Configuring history settings
You can track modifications that users make to style records by configuring the history settings in Infor
Fashion PLM.

1 Select Admin > Configure - Infor Fashion PLM.

2 Click History Settings.

3 Select Enable History Tracking.

4 On the History Settings, select Click here to add a new row.

5 Specify this information:

Info Cluster
Select an information cluster from the list.

Action
Select an action from the list.

Status
Select a status from the list.

Info Cluster Fields
Select information cluster fields from the list.

6 Click Save.

Note:  Modifications performed on style records that meet the defined history settings are found on
the History tab on the style details page.
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Configuring care and content settings
You can customize the display of care symbols by configuring care and content settings in the
application.

1 Select Admin > Configure - Infor Fashion PLM.

2 Click Care & Content Settings.

3 Select the check box to display text for care symbols.

4 Click Save.

Configuring request ownership settings
By configuring the request ownership settings, requests that you create can be automatically assigned
to an action owner based on a selected role.

1 Select Admin > Configure - Infor Fashion PLM.

2 Click Request Ownership Settings.

3 Specify this information:

Request Type
By default, the request type is set to Sample after you select a Request Sub Type.

Request Sub Type
Select a request subtype from the list.

Style Category
Select style categories from the list.

Ownership Information
Select a role from the list.

4 Click Save.

Configuring request tags
Configuring request tags enables you to customize the display of tags in sample and lab dip requests.

1 Select Admin > Configure - Infor Fashion PLM.

2 Click Request Tag Settings.

3 To customize the display of tags in sample requests, select or clear product categories for each
request tag:

• Workmanship
• Grading
• Color
• Construction
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• Durability
• Artwork
• Materials & Components
• Insole/Outsole
• Wear Test Comments
• Fit

4 To customize the display of tags in lab dip requests, select or clear these tags:

• Color
• Artwork/Print
• Washing

5 Click Save.

Configuring messaging settings
Infor Fashion PLM enables you to monitor and route notifications and messages. With this feature, you
can monitor updates to items made by users within the application.

Note:  Notification settings is available only after you have created a version in Infor Fashion PLM.
The notification setting for Infor Fashion PLM is a version-specific configuration for each version created
in the application.

See Managing versions on page 34.

Before you start configuring the messaging settings, you must configure the email settings. The
information defined in the email settings is used for Notifications.

See Configuring email messages on page 24.

1 Select Admin > Configure - Infor Fashion PLM.

2 Click Messaging Settings.

3 Specify this information:

MSMQ Server Name
Specify the IP address of the server where the Infor Fashion PLM Messaging Service is installed.

Windows Service Hub URL

Specify the server.

The server address should be in this format: http://servername:8090, where:

servername is the server name or IP address of the server where Fashion Messaging Service is
installed. The server should be accessible to the Infor Fashion PLM application.

Note:  You must replace 8090 with the value used by the Fashion Messaging service during
installation.

See “Installing Infor Fashion Messaging Service” in the Infor Fashion PLM Planning Application
Host Installation Guide.
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Enable notification for styles
1 In the Notification Settings, click the Style tab.

2 Select Enable Notification.

3 Specify this information:

Info Cluster
Select an information cluster from the list.

Action
Select an action from the list.
Note:  Post to Customer is only available for the Request info cluster. If this action is selected, the
Infor Fashion PLM user is notified when the Partner Collaboration user clicks the Post to Customer
option in Partner Collaboration. The Infor Fashion PLM user is notified depending on the type of
notification that is specified in the Notifications field.

Status

Select a workflow status.

You can define workflow statuses in Generic Lookup.

Previous Status

Select a previous status.

Previous Status is the original status that is being replaced on status change.

Notifications
Select a notification type.

Ownership Information
Select ownership information from the list.
Note:  If you update the ownership information in one info cluster with mass create, mass update,
or copy action, the ownership information in the other info clusters with the same action will also
be updated.

Roles
Select a system-defined or user-defined role from the list.

See PAH Online Help.

Note:  If you update the roles in one info cluster with mass create, mass update, or copy action,
the roles in the other info clusters with the same action will also be updated.

4 Click Save.

Enable notification for integration activities
1 In the Notification Settings, click the Integration tab.

2 Select Enable Notification.

3 Specify this information:
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Roles
Select the roles that will receive notification for integration activities.

Target Schema
Select the target schema from the list.

4 Click Save.

Note:  To include in notifications the changes that are related to Profile, Role, or User Accounts,
restart Infor Fashion PLM Messaging Service. A service restart is required when you perform any
of these actions:

• Add, delete, or modify a user in the application
• Assign, delete, or modify profile or role assignment for a particular user

To restart the Infor Fashion PLM Messaging Service, contact your system administrator.

See the Infor Fashion PLM Planning Application Host Installation Guide.

Enable notification for user sessions
1 In Notification Settings, click the User Session tab.

2 Select the applicable notification type.

You can multi-select the available options or leave the fields blank.

3 Click Save.

Configuring style SKU settings
In Infor Fashion PLM, you can enable generation of multiple SKUs for styles based on style status.

1 Select Admin > Configure - Infor Fashion PLM.

2 Click Style SKU Settings.

3 Specify this information:

Enable SKUGeneration
Select to enable scheduled generation of SKUs.

Style Status
Select the applicable style status from the list.

SKUs will be generated for style records that match the selected style status.

Note:  If generation of SKUs is enabled, a Generate SKUs button is displayed on the menu bar of
the Style panel. To generate SKUs for all applicable style records, click Generate SKUs.

See Generating multiple SKUs for styles on page 171.
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Configuring Partner Collaboration settings
Infor Fashion PLM Partner Collaboration is a web application that enables your partners in the product
lifecyle management process, such as your suppliers, to access relevant information from Infor Fashion
PLM. To enable the access of Partner Collaboration to the Infor Fashion PLM application, you must
configure the settings in the Admin menu.

See “Configuring Infor Fashion PLM” in the Infor Fashion PLM Partner Collaboration Installation Guide.

Note:  After saving Partner Collaboration settings, you must restart the application to allow it to reconnect
to Infor Fashion Messaging Service with the updated settings.

Configuring BOM details update settings
In Infor Fashion PLM, you can add material and trim records to a style's bill of material (BOM) page.
By default, material or trim records that have been added on the style's BOM page are not updated
when changes are made on the same records in the Material or Trim panels. Configuring the BOM
details update settings enables Infor Fashion PLM to automatically update records added on a style's
BOM page when changes are made on the same records in the Material and Trim panels.

Note:  Only the changes made after configuring the BOM update settings will be synchronized to
material and trim records on the style's BOM page.

1 Select Admin > Configure - Infor Fashion PLM.

2 Click BOM Details Update Settings.

3 Specify the number of decimal places that can be used in updating the quantity of BOM lines.

4 To enable BOM update for materials or trims, select Enable BOM Update on the Material tab or
Trim tab respectively.

5 To limit the updates based on the style status, BOM status, and BOM fields, specify this information:

Style Status
Select a style status from the list.

BOM Status
Select a BOM status from the list.

BOM Fields
Select BOM fields.

6 Click Save.

Changes on material and trim records that meet the criteria set on the BOM Details Update Settings
are updated on the style's BOM page.

Note:  If BOM update is enabled and no style status is specified, material and trim changes will be
applied to the BOM of all styles in all states.
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Configuring style measurement settings
You can set the default style measurement information that will appear in the Measurements tab of
style records by configuring the style measurement settings.

1 Select Admin > Configure - Infor Fashion PLM.

2 Click Configure Style Measurement Settings.

3 Select Enable Style Measurement Settings.

4 Specify this information:

Grade Rule Format
Select a grade rule format from the list.

Tolerance Format
Select a tolerance format from the list.

Measurement View
Select a measurement view from the list.

Decimal Places
Select a value from the list.

Fraction Denominator
Select a value from the list.

Note:  Other measurement information, including POMs, must be manually set in the style's
Measurements tab.

See Determining style measurements on page 203 .

5 Optionally, select Hide Supplier Column in Sample Page Settings to hide the supplier information
column in the style grid.

Note:  This setting is unavailable if Partner Collaboration is enabled.

6 Click Save.

Configuring pattern and marker settings
You can configure style patterns and markers to use values from BOM and display values on the Style
Overview panel.

1 Select Admin > Configure - Infor Fashion PLM.

2 Click Pattern / Marker Settings.

3 Under the Pattern Settings section, select applicable options.

4 Under the Marker Settings section, select the applicable options.

5 Click Save.

Infor Fashion PLM User Guide | 31

 

Getting started



Configuring locked record settings
You can set the behavior of Infor Fashion PLM on locking a record by configuring the locked record
settings.

1 Select Admin > Configure - Infor Fashion PLM.

2 Click Locked Record Settings.

3 Select a record lock option.

• The first option locks the record to the user that opened the specific record. Other users that will
access the locked record will be notified that the record is in read-only mode.

• The second option enables all users to open the record in read-only mode. Click Lock And Edit
to edit and lock the record. Editing capabilities will then be disabled to all other users.

Note:  A locked record also disables other users to apply changes to the record in the style grid.

4 Click Save.

Configuring mass create and mass update settings
In Infor Fashion PLM, you can set a value to limit the number of items that will be included in the Mass
Create and Mass Update feature of the application.

1 Select Admin > Configure - Infor Fashion PLM.

2 Click Mass Create/Update Settings.

3 Specify a value in the Mass Create Limit and Mass Update Limit fields.

You can set the limit up to 500 items only.

4 Click Save.

Note:  This setting only applies to Style Mass Create Carryover, Style Mass Create Variant, Mass
Create, and Mass Update for Style, Material, and Trim. The limit setting that you specified does not
apply to Mass Create Request.

Configuring tab details settings
You can change the information that is displayed in the tab's label when viewing the details of a specific
record by using the Tab Details Feature of Infor Fashion PLM.

1 Select Admin > Configure - Infor Fashion PLM.

2 Click Tab Details.

3 Select any of these display options from the list:

• Number only

Displays only the code of the record

• Name only

Displays only the name of the record

Infor Fashion PLM User Guide | 32

 

Getting started



• Number and Name

Displays the code and the name of the record

Note:  In standard configuration, Name is selected as the default setting in the application.

4 Click Save.

Configuring load grid settings
You can configure the display of styles by selecting to load or not to load all styles in the Style grid.

1 Select Admin > Configure - Infor Fashion PLM.

2 Click Load Grid Settings.

3 Select a load option:

• Always load all Styles.
• Do not load all Styles.

Note:  If you select this option, a blank list is initially loaded. Optionally, you can create a grid layout
with a grid filter to load a filtered list.

The last grid layout will always be loaded by default if you do not select the Always load all Styles
option.

4 Click Save.

Configuring field length limit
Infor Fashion PLM module items have default field length limits but you can configure these limits by
going to the Field Length Limit option. These modules includes items where the field lengths are enabled
for configuration:

• Style
• Material
• Trim
• Color Library
• Color Tab

1 Select Admin > Configure - Infor Fashion PLM.

2 Click Field Length Limit.
3 Select a module.

4 Select a module item, then click the value in the Limit Value column.

5 Specify the new limit value.

You may use the up and down arrows in the limit value fields to increase or decrease the limit value.

6 Click Save.
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Managing versions
An Infor Fashion PLM version pertains to a distinct group or planning folder of a user’s business data.
Essentially, versions are variations of data that users save in the application. By using versions in Infor
Fashion PLM, users can manipulate business data and keep all variations in the repository.

To use Infor Fashion PLM, you must first create a version before working on Manage Version menu
items. You can create, rename, copy, mark for deletion, lock, export, and import versions.

Create a version
1 Select Admin > Manage Version.

2 Select a licensed module from the list.

By default, Infor Fashion PLM is selected.

3 Click the Create a New Version icon.

4 Specify the name of the version and provide related description.

By default, the new version is active. To make the new version inactive, clear the Activate check
box.

5 Click OK.

6 Click Close.

Activate a version
1 Select Admin > Manage Version.

2 Select a licensed module from the list.

By default, Infor Fashion PLM is selected.

3 To activate a version, select a version and do any of these actions:

• Click the Activate icon.
• Double-click the version.
• Right-click the version and select Activate.

4 Click Close.

Copy a version
1 Select Admin > Manage Version.

2 Select a licensed module from the list.

By default, Infor Fashion PLM is selected.

3 Select the version you want to copy.
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4 Click the Copy Selected Version icon.

5 On the Version tab, rename the version and provide a brief description.

6 Click the Options tab and select an option to copy the version:

• Select All to copy all data in the version.
• Select Copy Basic Data to copy only the version’s basic data.

7 Click OK, then click Close.

Other version tasks
DescriptionTask

Renames an existing version. You cannot rename active ver-
sions.

Rename Selected Version

Marks a version in preparation for deletion. You cannot delete
active versions.

Mark for Deletion

Clears a version that is marked for deletion.Unmark for Deletion

Shows all the versions that are currently available and versions
that are marked for deletion.

List Box

Deletes a version. You can delete a version only if you have first
marked it for deletion.

Delete the Selected Version

Locks or unlocks a version. When you lock a version, it is only
available in read only mode regardless of the user’s authorization.

Lock Version

Imports a specific licensed module database file (.lmd) into a
new version.

Import Version

Exports a version to a specified location.Export Version

See the PAH Online Help.

Managing locked records
A locked record in Infor Fashion PLM disables a user to modify and apply changes to the record. This
happens when a user opens a record that is currently in use by another user.

If the application closed unexpectedly while you are using a record or if another user forgot to close a
record, you can use the Manage Locked Records module to release the locked status. By using this
feature, the user will also be released from using the record.

1 Select Admin > Manage Locked Records.

2 Select the record that you want to unlock.
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3 Click the Unlock icon.

4 Optionally, click the Refresh icon to refresh the status of the record.

5 Click Close.

Managing deleted records
In Infor Fashion PLM, style, material, and trim records that have been deleted are temporarily stored
in the system. You can use the Manage Deleted Records module to browse, restore, or delete records
permanently.

Note:  The dependency of the deleted record to Generic lookup is not removed to enable the user to
restore the record. You must permanently delete a Style, Material, or Trim record to remove the
dependency to Generic lookup.

1 Select Admin > Manage Deleted Records.

2 Specify this information:

Module
Select a module from the list.

Date From
Specify a date by using the date picker.

Changed by
Select a user from the list.
Note:  To search for all deleted records without selecting a user as filter, click Clear.

Date To
Specify a date by using the date picker.

3 Click Filter.

Navigate through record pages
On the display bar, perform these actions:

1 On the page number box, specify a page number.

2 Press Enter.
3 Alternatively, click |<, <, >, and >| to display the first, previous, next, and last page respectively.

Restore deleted records
1 Right-click a record and select Restore.

Infor Fashion PLM User Guide | 36

 

Getting started



2 If you want to restore multiple records, simultaneously, multi-select records while pressing Ctrl on
your keyboard. Right-click any of the selected records and select Restore.

Related operational records such as purchase orders and requests are also restored.

Permanently delete records
1 Right-click a record and select Delete Permanently.

2 If you want to delete multiple records simultaneously, multiselect records while pressing Ctrl on
your keyboard. Right-click any of the selected records and select Delete Permanently.

Related operational records such as purchase orders and requests are also permanently deleted.

Managing archived records
You can review and restore archived records through the Manage Archived Records action.

1 Select Admin > Manage Archived Records.

2 On the Manage Archived Records dialog box, specify this information to filter the archived records:

Module
Select the module of records.

Changed By
Select the user who archived the records.

Date From and Date To
Specify the date or span of date where the records were archived.

3 Click Filter.
4 To restore a record, right-click a record, then select Restore.

Note:  You may select multiple records to restore.

Understanding navigation features
Infor Fashion PLM is designed to provide ease of use by enabling navigation with fewer clicks.
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Dragging and dropping
The application uses drag and drop to perform major functions:

• Adding and removing items from a module
• Assigning attributes to existing records
• Grouping columns by preference
• Floating panes and panels
• Organizing widgets on the home dashboard

Docking windows
Docking or side-by-side viewing involves locking a pane or panel to one of the four sides of the main
window. Infor Fashion PLM supports docking, which enables you to view multiple windows at once.

1 Click the pane or panel and drag it away from its location.

You can also double-click the pane or panel header.

2 When the pane or panel becomes a floating window, docking buttons appear on the screen. Point
your cursor to a docking button.

3 Drop the pane or panel to lock it to the dock area.

You can lock panes and panels to the left, right, top, and bottom margins of the main window.

Note:  A docked pane has a pushpin icon beside the header, enabling you to minimize the pane to
the sidebar.

Floating windows
Floating windows pertain to panes and panels that are not docked to any side of the main window.

To make a floating window, drag or double-click a pane or panel header, or the tab of a docked window.
To return a floating window to its previous dock area, double-click the pane or panel header.

Opening multiple modules
You can open multiple modules by clicking:

• The Home icon to return to the home dashboard and selecting a widget
Note:  To return to the active module from the home dashboard, click the Home icon.

• The Home dashboard to select major application modules
• The main menu from the toolbar

Infor Fashion PLM User Guide | 38

 

Getting started



Common application features
Infor Fashion PLM has common features across all modules of the application.

Buttons
DescriptionName

Creates a new recordNew

Edits an existing recordEdit

Copies the selected record to create a new recordCopy

Deletes a selected record

Note:  You can also press Delete on your keyboard.

Delete

Updates the data to reflect changes made to your recordsRefresh

Creates multiple records based on information clusters

Note:  This feature is available in Style, Material, Trim, and Request
features only.

Mass Create

Creates a sampling request for a style or materialCreate Request

Saves the user interface layoutSave Layouts

Loads a preferred layout from a list of saved layoutsSaved Layout list

Saves informationSave

Saves information and closes the windowSave and Close

Uploads files to a recordAttachments

Keyboard shortcuts
ActionShortcut

SaveCtrl+S

CopyCtrl+C

PasteCtrl+V

SearchCtrl+F

Select allCtrl+A

ScrollArrow keys
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ActionShortcut

Go to the next fieldTab

CancelEsc

Open/ViewEnter

DeleteDelete

Right-click features for grid header
DescriptionFor column heading

Arranges your column records in ascending orderSort Ascending

Arranges your column records in descending orderSort Descending

Removes any grouping order to your column recordsClear Sorting

Arranges your records by column groupGroup By This Column

Shows your records by column groupsShow Group Panel

Enables you to arrange and remove columnsShow Column Chooser

Centers columns on the screen for maximum visibilityBest Fit

Centers all columns on the screen for maximum visibilityBest Fit (all columns)

Filters column records by specifying columns to displayShow Filter Editor

Displays the search panelShow Search Panel

Expands groupings to show all items under that groupFull Expand

Collapses items under a groupingFull Collapse

Displays saved grid layoutsSaved Grid Layouts

Saves your current grid layoutSave Grid Layout

Prints the current grid displayed on the workbenchPrint

Makes a column stationary during scrollingFreeze Column

Disables the stationary status of a columnUnfreeze Column

DescriptionFor row record

Opens the selected record for editingEdit

Creates a copy of the selected recordCopy

Deletes the selected recordDelete
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Search feature
Infor Fashion PLM offers you a search feature to streamline searches through large volumes of records.

1 Right-click a column header and select Show Search Panel.
You can also press Ctrl+F.

2 Type your search information in the given field.

3 Press Enter.
Note:  You can use Show Search Panel and Show Filter Editor for a more specific search result.
We recommend that you enable the pagination to improve the loading time of styles in the grid
during a search. To enable the pagination, select the Enable Paging check box.

Search for dropdown fields
For Style, Material, and Trim Overview panels, you can specify a specific search in the drop-down
fields instead of clicking the drop-down list button. The results that match the value that you specified
is displayed.

Advanced filtering
Infor Fashion PLM enables you to filter the display of your records using criteria or “conditions.” When
you use advanced filtering, these criteria consist of application fields, conditional operators, and values.
This feature helps you trim down the records that you view, showing only what is relevant or useful to
you.

Note:  Advanced filtering is available in Style, Material, and Trim only.

Create a filter
1 Click the Advanced Filter icon on the toolbar.

2 On the Advance Filter window, specify this information:

Field
Select a field from the list.

The field that you select serves as the category on which your filter is based.

Condition
Select a condition from the list.
• = displays only records that contain the exact value that you specify.
• != displays only records that do not contain the exact value that you specify.
• Like displays records that contain a similar value to the value that you specify.
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• Not Like displays records the do not contain a similar value to the value that you specify.

Value
Specify a value. The value serves as the basis of your filter results.

For example, if the field is “Collection”, the condition is “=”, and the value is “Summer”, your filter
results display only records that are included in the Summer Collection.

3 Click Add.

4 To add more conditions, repeat steps 2 and 3.

5 To define the relationship of the conditions, select AND or OR.

• AND combines all conditions to filter records.
• OR filters records using any of the conditions that you specify.

6 Optionally, click Remove to delete added conditions.

7 Click Filter.
Your filter is automatically saved as “Recent Filter”.

8 Click Close.

Save a filter
1 On the Advanced Filter window, click Save.

2 Specify the name and description.

3 Click Save and Close.

Use a saved filter
1 On the toolbar, select a filter from the Saved Filters list and click Go.

2 Optionally, on the Advanced Filter window, select a saved filter from the list and click Filter.

Copy a saved filter
1 On the Advanced Filter window, click Copy From.

2 Specify this information:

User Profile
Select a user profile from the list.

Saved Filter
Select a saved filter.

3 Click Save and Close.
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Clear a filter
1 Open the Style, Material, or Trim tab.

2 Click the Clear Advance Filter icon on the toolbar.

Delete a filter
1 On the Advanced Filter window, Click Delete.

2 Click Yes, then click Close.

Viewing options
In Infor Fashion PLM, you can view your business data in these view formats:

• Tree view

This view represents the items hierarchically by enabling each item to have subitems, which are
often called branches or nodes. This view visualizes the hierarchy by indentation in a list.

Note:  This view is available for color palettes only.
• Table view

This view represents a scrollable list of items that may be divided into sections. This view enables
you to navigate through hierarchically structured data, and review detailed information and controls
in visually distinct groupings.

• Card view

This view represents items in cards, which display fields vertically in a single column. This view
enables you to identify your data through handles and graphic displays.

Note:  This view is available for styles, materials, trims, colors, and color palettes only.
• Color palette view

This view displays a concise view of the colors in a palette.

• Mapped style view

This view displays a list of main styles that are mapped to all the line plans of a collection plan. The
retail price and style colors are also displayed in this view.

To select a view, click the View icon at the bottom left margin of the workbench.
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Saving layouts
You can save customized layouts in Infor Fashion PLM. Saving your layouts enables you to view your
modified panels, panes, filters, and column layouts at any time after closing and reopening the
application.

Infor Fashion PLM also automatically saves the last active layout before you close the
application,enabling you to retrieve and use the same layout.

1 Click the Save Layout icon on the toolbar.

2 Specify this information:

Save Layout
Select New to save your current layout.

Optionally, to update any of the saved layouts to match your current layout, select a saved layout
from the list.

Private/Public

Specify whether the layout is private or public.

A private layout is only available to the current user.

Layout Name
Provide a layout name.

3 Click Save and Close.

To activate a saved layout, select a saved layout from the list on the toolbar.

Copy a saved layout from another version
1 Click the Save Layout icon on the toolbar.

2 Click Copy From.

3 Specify this information:

Version
Select a version from the list.

User Profile
Select a user profile from the list.

Saved Panel Layout
Select a saved panel layout.

4 Click Save and Close.
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Save grid layouts
Infor Fashion PLM provides you the option to save your grid layouts. In Infor Fashion PLM, a grid is a
panel that presents your data in a tabular structure of rows and columns. Unlike saved layouts, a saved
grid layout excludes panes and filters.

1 Right-click any column header of an active panel and select Save Grid Layout.
2 Specify this information:

Save Layout
Select New to save your current grid layout.

To update any of the saved layouts to match your current layout, select a saved layout from the
list.

Private/Public

Specify whether the layout is private or public.

A private layout is only available to the current user.

Layout Name
Specify a layout name.

3 Optionally, you can copy a saved grid layout from another version. In the Save Layout dialog box,
click Copy From.

4 Specify this information:

Version
Select a version from the list.

User Profile
Select a user profile from the list.

Saved Column Layout
Select a saved column layout.

5 Click Save and Close.

Activate the last layout
Infor Fashion PLM provides you the ability to retrieve and reopen the last active layout of the grid,
panes, panels, columns, and filters before closing the application. This feature retains your active panes
and panels in cases when your computer or the application closes unexpectedly.

1 Click the saved layout list on the toolbar.

2 Select Last Layout.

Infor Fashion PLM User Guide | 45

 

Getting started



Configuring ID Generator
You can automatically create an ID with a user-defined format by using the ID Generator. The ID
Generator can be used in styles, materials, trims, colors, requests, and purchase orders.

Create an ID rule
1 Select Admin > Tools > ID Generator.
2 Click New.

3 Specify this information:

Name
Specify a name.

Description
Provide a brief description.

Max Length
Specify a value for the max length.

Module Type
Select a module type that will be associated with the ID Generator rule.

Allow Manual Override
Select to allow manual editing of generated IDs on records.

4 Create the ID format by specifying values on each of these tabs:

Note:  To verify the ID format, refer to the Generated Sample field.

• Strings (S)
a Click the Strings (S) tab.
b Select Click here to add a new row.
c Specify this information:

Value
Specify a value.

Length
This field is updated automatically.

• Number Series (NS)
a Click the Number Series (NS) tab.
b Select Click here to add a new row.
c Specify this information:

Length
Specify a value for the length.
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Increment
Specify a value for the increment.

Starting No.
Specify the starting number.

Current Value
This field is updated automatically.

• Contextual Value (CV)
a Click the Contextual Value (CV) tab.
b Select Click here to add a new row.
c Specify this information:

Info Cluster
Select an Info Cluster from the list.

Field
Select a field from the list.

Use Code/Name
Select code or name from the list.

This will determine if the field value that will be used is the record's code or name.

Starting Value
Specify the starting value.

Length
Specify a value for the length.

• External Value (EV)
Note:  The External Value (EV) tab only appears when you configure ID rules for styles.
a Click the External Value (EV) tab.
b Select Click here to add a new row.
c Specify this information:

Type
Select a type from the list.

Ref. Value
Specify a reference value from the list.

Starting Value
Specify the starting value.

Length
Specify a value for the length.

5 Optionally, click the Sequence tab and set the sequence number of each ID rule item to reorder
the ID format. You can also drag and drop ID rule items to rearrange the sequence.
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Note:  The Seq # determines where your specified ID rule item will be positioned in the ID format.
To verify the ID format, refer to the Generated Sample field.

6 After you have finalized the ID format, click Save.

Activate an ID rule
1 On the ID Generator window, click ID Generator Settings.

2 Select a rule for each module.

3 Click Save, then click Close.
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Chapter 2: Understanding the basics

Learn how to set up the key features of the application.

Care
Care instructions are provided as symbols in fashion products. You can create care symbols and attach
them to styles. Care symbols ensure that necessary instructions are provided to maintain the quality
of a product. In the application, care instructions are composed of symbols.

Adding care symbols
1 Select Basics > Care.

2 Click the New icon.

3 Specify symbol attributes:

Code

Specify a symbol code.

The code must be unique. Two or more items cannot have the same code.

Name
Specify a symbol name.

The symbol name must be unique.

Description
Specify a brief description.

Care Group
Select a care group from the list.

You can define care groups in Generic Lookup.

Status
Select Active, Inactive, or any user-defined status.

4 Drag and drop an image from your local computer to the image holder for the care symbol.
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5 In the Care Instructions section, select Click here to add new row.

6 Specify this information:

Language
Select a language from the list.

Details
Specify care instruction details.

7 Click Save or Save and Close.

Sequence of care symbols
You can organize care symbols in Infor Fashion PLM by defining their sequence relative to one another.
A style, material, or trim may use more than one care symbol to signify care instructions.

For example, a style may use two different fabrics that have different care symbols for care instructions:
One fabric should be washed at 30 degrees Celsius, while the other should be washed at 50 degrees
Celsius.

Organizing your care symbols in a sequence enables the application to identify which care symbol is
higher and lower.

To define the sequence of care symbols, open the Care panel. Reorder the symbols by dragging and
dropping records. The Sequence column will be updated to reflect the reordering.

Characteristic
Characteristics define the qualities of a product. To widen your flexibility in searching, displaying, and
categorizing products, you can define characteristics and associate their values to a style.

For example, if your product is a pair of jeans, you can add “Slim Fit” and “Skinny” as characteristics.

Creating characteristics
1 Select Basics >  > Characteristic.

2 Click the New icon.

3 Specify characteristic attributes:

Code

Specify a characteristic code.

The code must be unique. Two or more items cannot have the same code.
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Name
Specify a characteristic name.

Description
Specify a brief description.

Notes
Specify any additional comments on your characteristic.

Type
Select Style, Material, Trim, or Size as a characteristic type.
Note:  The Size type is used to add another size dimension to your sizes, for example, cup size,
inseam length, and width.

Status
Select a user-defined status.

Attachments
Drag and drop images or any file from your local drive to your new characteristic.

4 Click Save or Save and Close.

Note:  If a characteristic is mapped to any other entity, you can update all fields except for Type
and Characteristic Value Details.

Two characteristic values under the same characteristic cannot have the same code and name.

Adding values to characteristics
Characteristic values are attributes that define a product. While creating a style, you can add values
of a characteristic to generate stock keeping units (SKUs).

For example, if you define Price as a characteristic, you can assign High or Low as its value.

1 Select Click here to add a new row in the Characteristic Value Details section.

2 Specify this information:

Code

Specify a value code.

The code must be unique. Two or more items cannot have the same code.

Value

Specify a characteristic value that best describes the characteristics of the style.

Description
Specify a brief description of the characteristic value.

3 Press Enter on your keyboard.

4 Click Save or Save and Close.
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Color
Colors are a key attribute in fashion products. You can define colors in the application and then assign
them to products together with other attributes, such as sizes and characteristics.

In Infor Fashion PLM, you can define colors in three ways:

• As a color, to be used in styles, materials, or trims that use only a single color
• As a combination color, to be used in styles, materials, or trims that use two or more colors
• As a print, to be used in styles, materials, or trims that use single and combination colors

Creating colors
1 Select Basics > Color.
2 Click the New icon.

3 Specify color details:

Code

Specify a color code.

The code must be unique. Two or more items cannot have the same code.

Note:  If you are using the Infor Fashion PLM Extension for Adobe Illustrator, use only alphanumeric
characters for the color code.

See the Infor Fashion PLM Extension for Adobe Illustrator User Guide.

Name
Specify a color name.

Type
The color type is identified as Single, Combination, or Print.

Sub Type
Select a color subtype. You can define subtypes in Generic Lookup.

Color

Select a color from the list.

Theme and standard colors are displayed. Click More Colors to select specific colors from the
Color Picker.

Shade

Select a color shade from the list.

Color shades classify colors according to their lightness or shade. You can define color shades in
Generic Lookup.

Color Family

Specify a color family.

Color family is used to group similar colors.
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For example, fire red, fiery red, and blood red can be classified under the color family Reds. You
can define color families in Generic Lookup.

Start Season

Select a season from the list.

You can define seasons in Generic Lookup.

Free Field 1
Specify any other related details pertaining to the color.

Free Field 2
Specify any other related details pertaining to the color.

Free Field 3
Specify any other related details pertaining to the color.

ERP Color Code

Specify the ERP color code.

Infor Fashion PLM can interface with ERP systems, which can have their own set of colors and
corresponding color codes.

Description
Provide a description for your color.

Alt. Color Name
Specify an alternative color name.

Status

Select a user-defined status.

Note:  Colors with an Operational status are disabled for editing.

Color User Defined Field 1
Specify a value for this field.

You can create user-defined fields in Generic Lookup.

Color User Defined Field 2
Specify a value for this field.

You can create user-defined fields in Generic Lookup.

Color User Defined Field 3
Specify a value for this field.

You can create user-defined fields in Generic Lookup.

Images
Drag and drop images from your local computer to the image holder to graphically represent the
color.

4 Click Save or Save and Close.
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Modify color values
1 Go to Values section of the color details page.

2 Modify color values based on these standard color codes:

• Hex – RGB
• Pantone – CMYK
• NRF Code – Lab

Add color attributes
Color attributes can provide definition and character to a color. Using color attributes enables you to
classify colors based on your business needs.

For example, you can use a customer (Company A), a season (Fall 2012), or a theme (Monochromatic),
as color attributes.

1 Select Click here to add a new row in the Color Attributes section of the color details page.

2 Specify the attribute code and attribute value.

3 Click Save.

Assign images to a color
You can attach images to represent the colors that you create in detail. A color can have more than
one image attached to it.

1 On your computer, access the location of the image that you want to assign to the color.

Note:  If your image folder is maximized, click Restore Down to float the window.

2 Drag and drop the image from your local folder to the image section of the color details page.

3 Click Save or Save and Close.

Creating combination colors
In Infor Fashion PLM, you can create combination colors by combining two or more single colors.

You can create combination colors by combining these options:

• Existing colors
• Existing colors with new colors
• New colors
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Add new colors
1 On the color details page, select Click here to add a new row in the Combo Colors section.

2 Specify color details:

Seq #

The sequence number determines the order of colors used within a combination color. This field
is automatically populated by the application, but you can modify the sequence by changing the
sequence number for each color.

Color

Click the Color field to display the Color list.

Theme and standard colors are displayed. Click More Colors to select specific colors from the
Color Picker.

Code

Specify the color code.

The code must be unique. Two or more items cannot have the same code.

Note:  If you are using the Infor Fashion PLM Extension for Adobe Illustrator, use only alphanumeric
characters for the color code.

See the Infor Fashion PLM Extension for Adobe Illustrator User Guide.

Name
Specify a color name.

3 Click Save.

Note:  When you create a new color in the Combo Colors section, it will be included as a single
color in the Color Overview.

Add existing colors
1 Select Basics > Color.
2 Float the Color Overview panel and dock it to any side of the main window.

3 From the Color Overview panel, drag and drop a color to the Combination Colors section of the
color details page.

You can also select multiple colors and add them simultaneously to the Combination Colors section.

4 Optionally, specify the sequence number of color/s that you added in the Combination Colors section.

5 Click Save.

Note:  You can also create combination colors on the Color Overview panel by dragging and dropping
single colors to one another.
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Importing colors
You can import Pantone code-based colors or NRF colors from your local computer to Infor Fashion
PLM, enabling you to use existing sets of colors built from your company. Before importing colors,
ensure that you meet these prerequisites:

• Specify all necessary information:
• Code
• RGB Values
• Hex color code

• Save the file in Microsoft Excel (*.csv) format.

1 On your computer, browse for the location of the colors file that you want to import to Infor Fashion
PLM.

2 Drag and drop the Pantone or NRF CSV file from your local folder to the Color panel.

3 On the Import CSV File window, select a list separator.

Adding comments to a color
You can post comments to colors, and reply to comments from other users, within Infor Fashion PLM.

Depending on authorities included in your user role, you can also edit and delete comments. The most
recent comments posted across the application will be displayed in the Latest Comments widget on
the home dashboard.

1 On the Color panel, select a record and click the Color/Comments icon found on the sidebar.

2 Type your comment in the given field and click Post.
3 Optionally, click the Refresh icon to update the comments.

4 Optionally, to filter comments that are set to public, select View Public Comments Only.

Attach files to a comment
1 From your local computer, drag and drop a file to the Attachment field of a comment.

If the file that you have attached is an image, a thumbnail of that image is displayed.

If the file that you have attached is not an image, the Attachment field is updated with the number
of files in the comment.

2 Optionally, to view multiple images attached to a comment, click an image and use the arrow buttons
on your keyboard.

3 Optionally, to view nonimage attachments to a comment, click the Attachment field and select the
file that you want to view.

Note:  You can edit attachments to a comment and save your changes in Infor Fashion PLM. Before
editing attachments, click Refresh in the Comments pane.

4 Optionally, to delete an image, right-click the thumbnail and select Delete.
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5 Optionally, to delete nonimage attachments, double-click the Attachment field. Select the check
box of the file and click the Delete icon.

Reply to a comment
1 Select a comment and click Reply.

2 Provide your comment in the given field.

3 Click Post Reply.

Search for a comment
1 Click the Search icon in the Comments pane.

Optionally, you can also select a comment and press Crtl+F on your keyboard.

2 Specify a keyword to display comments containing that keyword.

View the comment hierarchy
1 In the Color/Comments pane, click the Hierarchy tab.

2 To view comments and replies to comments on a particular tab, expand the hierarchy view by clicking
the drop-down arrow.

Color/Where Used
The Color/Where Used function enables you to track products that use a specific color. To view where
a color has been used, select a color record and click the Color/Where Used icon or right-click a color
record and select Color/Where Used.

To update the color information in the component type where the color is used, right-click the color and
select Sync Color Details.

Color palette
Color palettes are preselected groups of colors that are meant to be viewed as a whole set. A color
palette can be composed of single and combination colors. By creating color palettes in Infor Fashion
PLM, you can organize the colors that you use in styles, materials, and trims for a certain collection
folder, theme, or classification.
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Creating color palettes
1 Select Basics > Color Palette.

2 Click the New icon.

3 Specify the color palette details:

Code

Specify a color palette code.

The code must be unique. Two or more items cannot have the same code.

Name
Specify a color palette name.

Status
Select Active, Inactive, or any user-defined status.

Season

Select a season from the list.

You can define seasons in Generic Lookup.

Brand

Select a brand from the list.

You can define brands in Generic Lookup.

Collection
Select a collection folder where the color palette should be mapped.

You can define collection folders in Generic Lookup.

Validity From - To
Specify a date using the date picker.

The color palette you create is valid according to the dates that you specify.

Add colors to a color palette
A color palette is composed of colors you created in Color. A color palette can have single colors and
combination colors.

1 Select Basics > Color and dock the Color panel to any side of the main window.

2 From the Color Overview panel, drag and drop a color to the Color Palette section.

3 Optionally, to add multiple colors simultaneously, multiselect color records while pressing Ctrl on
your keyboard.
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Add color palette attributes
Color palette attributes serve as filters for color palettes. Adding attributes enables you to classify color
palettes based on your business needs.

For example, you can use an event (Autumn Wedding), a mood (Dramatic), and a theme (Vintage) as
color palette attributes.

1 In the Color Palette Attributes section of the color details page, select Click here to add new row.

2 Specify the attribute code and attribute value.

3 Click Save.

Note:  You can also create combination colors on the Color Overview panel by dragging and dropping
single colors to one another.

Viewing color palettes
You have several options to view color palettes:

DescriptionOption

Represents colors in branches or nodes, which can have several
subitems.

Each branch can be expanded to reveal subitems.

Tree view

Represents colors in cards, which display fields vertically in a single
column.

This view enables you to identify your data through handles and
graphic displays.

Card view

Represents colors in a series, which emphasizes the string of colors
as a single set, and displays the total number of colors included in
the palette.

Color palette view

Report for a color palette
The Color Card report is available for each color palette. This report contains information that is specific
to a color palette.

See Generating reports on page 126.
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Costing
In Infor Fashion PLM, you can monitor and manage the amount of money spent on style items by
defining cost elements and cost models.

Cost elements in fashion can include expenditures on raw materials, human resources, activities, and
processes.

Cost models pertain to a fixed structure of cost elements that can be applied to multiple style items.

Defining cost elements and cost models in Infor Fashion PLM helps you to:

• Determine the overall expenditure for a style item
• Monitor spending and budget allocation

Defining cost elements
1 Select Basics > Cost Element.
2 Click the New icon.

3 Specify cost element attributes:

Code

Specify the cost element code.

The code must be unique. Two or more items cannot have the same code.

Name
Specify a cost element name.

Description
Provide a brief description.

Level

Select a cost level.

You can define cost levels in Generic Lookup.

Type
Select one of these types:
• Input

Enables you to specify any numeric value for the cost element.

• Calculated

Enables you to create a formula that computes the cost element value together with other cost
element values.

• Constant

Enables you to specify a fixed value for the cost element. By selecting this type, only you can
modify the value of the cost element.

• User Exit
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Enables you to compute the value of the cost element from different sources using plug-ins,
which can interface with other systems that return a cost value.

4 Click Save or Save and Close.

Creating cost models
1 Select Basics > Cost Model.
2 Specify cost model attributes:

Code

Specify the cost model code.

The code must be unique. Two or more items cannot have the same code.

Name
Specify a cost model name.

Status
Select Active, Inactive, or any user-defined status.

Currency
Select a currency from the list.

Description
Specify a brief description.

3 Click Save or Save and Close.

Add cost elements
1 In the Cost Elements section, select Click here to add a new row.

2 Specify cost element details:

Seq
Displays the sequence number of the cost element.
Note:  Drag and drop cost elements to rearrange the sequence.

Cost Level
Select a cost level. You can define cost levels in Generic Lookup.

Code

Specify the cost element code. The code must be unique.

Two or more items cannot have the same code.

Name
Specify a cost element name.
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Description
Specify a brief description.

Value
Specify a cost value.

3 Click Save or Save and Close.

Add existing cost elements
1 Select Basics > Cost Element.
2 Float the Cost Element panel and dock it to any side of the main window.

3 From the Cost Element panel, drag and drop cost elements to the Cost Model panel.

4 Click Save or Save and Close.

Defining cost element properties
You can define the values to cost elements that you include in a cost model, as well as the mapping
and display properties of each cost element.

To enable mapping of cost elements, ensure that the Map values from the Costing check box is selected
in the Main Sourcing Information of a style. The supplier that you specified in the Costing and Overview
tabs in a style must match to enable mapping of values.

1 On the cost model details page, double-click a cost element.

Optionally, you can also select a cost element and click the Cost Element Properties icon on the
sidebar.

2 Specify this information:

Type

Select a cost element type from the list.

For cost elements that are created on the Costing tab, Input is the default setting for this field.

Note:  For cost elements that do not have Input as the cost element type, an additional field is
displayed after you select an item from the list.

You must specify a value depending on the cost element type that you selected.

BOM/BOO Mapping

Select an item from the list.

This field enables you to map values from BOM or BOO tabs in a style to the cost element. The
version that you are using in BOM or BOO must match with the version used in Costing to show
the exact values.

Note:  This field is available for Input type only. For Style, Material, and Trim, the values for Total
Purchase Price of all BOM items are displayed in the Costing tab. To enable this mapping, select
the Cost Indicator check box for the item in the BOM tab of a style.
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For Bill of Operations, the Price per piece value in BOO tab is displayed in the Costing tab.

Price
Select one of these options:
• Cost Price
• Purchase Price
• Total Gross Cost Price

Detailed Mapping

To specify detailed mapping calculations for the cost element, select Main Category, Category, or
Category Group.

This field is displayed only when the specified BOM/BOO Mapping item is a material or trim.

Field

Select a value.

This field displays options from the Generic Lookup, based on what you specified in the Detailed
Mapping field.

For example, if you selected Main Category as the basis for detailed mapping calculations, defined
main categories will be displayed as options in this field.

Note:  This field is displayed only when the specified BOM/BOO Mapping item is a material or trim.

Cost Mapping to/from Overview

Select a price field.

Mapping the cost element to a price field enables you to use the cost element and its values for
that field. Values are automatically calculated depending on the specified currency in the Costing
tab of a style.

Note:  You can only map one cost element for a style, material, or trim. For detailed mapping of a
material or trim, field values can only be mapped to one cost element. Here is an example:

Category Fields = Fabric Woven, Non-Woven, Leather

Cost Element 1 = Fabric Woven + Leather

Cost Element 2 = Non-Woven

If an element is mapped to BOM/BOO, Retail Price Margin and Retail Price are not available in the
Cost Mapping field. If the element is mapped to the Cost Mapping field first, the BOM/BOO Mapping
field is disabled.

3 To customize the display of the cost element, select Bold Text and Highlight Background.

4 Click Close.

Define the value of input cost elements
1 On the cost model details page, double-click the Value cell of the cost element.

2 Type a value.

3 Click Save.
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Define the value of constant cost elements
1 On the cost model details page, double-click a cost element.

Optionally, you can also select a cost element and click the Cost Element Properties icon on the
sidebar.

2 Type a value on the given field.

3 Click Save.

Define the value of calculated cost elements
1 On the cost model details page, double-click a cost element.

Optionally, you can also select a cost element and click the Cost Element Properties icon on the
sidebar.

2 Specify your arithmetic expression in the given field.

Calculated cost elements enable you to refer to other elements' values by using the code as the
variable holder.

3 To use available functions in your arithmetic expression, select one of the these options:

• Abs

Returns the absolute value of a specified number

• Ceiling

Returns the smallest integer greater than or equal to the specified number

• Floor

Returns the largest integer less than or equal to the specified number

• In

Returns whether an element is in a set of values

• If

Returns a value based on a condition

• Max

Returns the larger of two specified numbers

• Min

Returns the smaller of two numbers

• Round

Rounds a value to the nearest integer or specified number of decimal places

• Truncate

Calculates the integral part of a number

4 Click Use Function.

5 To view the cost element value based on your arithmetic expression, click Evaluate Expression.

6 Click Save.
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Define the value of user exit cost elements
1 On the cost model details page, double-click a cost element.

Optionally, you can also select a cost element and click the Cost Element Properties icon on the
sidebar.

2 Select a user exit from the list.

You can connect a user exit plug-in to Infor Fashion PLM through a dynamic link library (DLL),
wherein you can refer your user exit and then override and implement your own computations.

See Working with user exits on page 284.

3 Click Save.

Dictionary
The dictionary serves as a generic library of texts or phrases for specific information on style features.
You can reuse these texts or phrases on different styles, and translate them into different languages.
You can use dictionary items to differentiate styles on the market.

For example, phrases such as “shake dry surface,” “exceptionally waterproof and windproof,” or “minimal
pack volume” can define outdoor clothing or sportswear.

Defining dictionary items
1 Select Basics > Dictionary.

2 Click the New icon.

3 Specify this information:

Code

Specify a code for the dictionary item.

This code serves as the unique internal reference for the dictionary item.

Name
Specify the dictionary item.

Description
Optionally, provide a additional information about the dictionary item.

Feature Type

Select the feature type to group the dictionary item.

You can define feature types in Generic Lookup.

Product Type
Specify is the dictionary item is applicable to a style, material, or trim.
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Status

Select Active or Inactive.

You can only use a dictionary item on a style if the status is Active.

4 To add a translation for the dictionary item, click a row.

5 Specify this information:

Language
Select a language.

You can define languages in Generic Lookup.

Details
Specify the translated text for the dictionary item.

6 Click Save.

Grade rule
A grade rule designates the amount that makes a pattern larger or smaller at one given point to fit a
range of sizes. Grade rules also serve as predefined templates that are used to define the points of
measure, graded increments, and tolerances in measurement variation for the product.

To create a grade rule, you must first define these product attributes:

• Product categories
• Sizes
• Size ranges
• Size categories

Defining grade rule settings
You can define settings for creating grade rules. Grade rule settings determine the default format and
view of the Grade Rule panel.

1 Select Basics > Grade Rule.

2 Click the Grade Rule Settings icon on the sidebar.

3 Specify this information:

Rule Format
Select a grade rule format from the list.

Tolerance Format
Select + & - Columns or ± Columns.
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Measurement View
Select Metric, Imperial Decimal, or Imperial Fraction.

Decimal Places
Select between 2 to 5 decimal places.

Fraction Denominator
Select a fraction denominator from the list.

4 Click Save or Save and Close.

Creating grade rules
Note:  A grade rule can be associated to multiple product categories.

1 Select Basics > Grade Rule.

2 Click the New icon.

3 Specify grade rule details:

Name
Specify a grade rule name.

Tolerance Format
Select + & - Columns or ± Columns.

Rule Format
Select a grade rule format from the list.

Measurement View
Select a measurement view from the list.

Fraction Denominator
Select a fraction denominator from the list.

Product Category
Select a product category or product categories from the list.

Size Category
Select a size category from the list.

Size Range
Select a size range from the list.

Sample Size

Select a sample size.

Available options depend on the size range that you selected.

Status
Select a user-defined status.
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4 Optionally, to assign images to your grade rule, drag and drop an image from your local computer
to the image holder on the New Grade Rule panel.

5 Click Save or Save and Close.

Note:  You have the flexibility to reset grade rule details, such as size range and sample size. After
resetting details, click the Reload icon on the toolbar to ensure that the Grade Rule table is up to
date.

Assigning POMs to a grade rule
You can assign points of measure (POMs) to a grade rule by doing one of these options:

• Adding POMs from the Point of Measure panel
• Creating POMs on the Grade Rule panel

Note:  You cannot add POMs to a grade rule without specifying grade rule details.

Adding POMs to a grade rule
1 Select Basics > Point of Measure.

2 Float the Point of Measure panel and dock it to any side of the main window for side-by-side viewing.

3 Drag and drop a POM from the POM panel into the Grade Rule table.

To add multiple POMs simultaneously, select two or more POMs while pressing Ctrl on your
keyboard.

Note:  If you drag a POM that has a different product category from the product category of the
grade rule, a message will appear in the workbench to confirm the action.

4 Specify POM details:

Seq #
Rearrange the POMs by these options:
• Selecting a sequence number from the list
• Providing a sequence number in the Seq # field
• Dragging and dropping POMs
Note:  You can rearrange the POMs in descending or ascending order by clicking the arrow in the
Seq# column.

Priority
Select Default, Mandatory, or Optional.
• Default POMs are initially included on the measurement tab with the mandatory POM when the

grade rule is added to a product, but they can be edited and removed.
• Mandatory POMs must be on every product using the grade rule and will be locked on the

measurement tab. They cannot be removed from the grade rule.
• Optional POMs are editable and can be removed from the grade rule.
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Note:  You can mass update the priority status of POMs by multiselecting records while holding
Ctrl on your keyboard.

Tol+ & Tol - / Tol ±

Specify a numeric value to indicate the tolerance level of the grade rule.

The number of tolerance columns depends on the tolerance format you select for the grade rule.

Size

Provide size values.

The number of size columns displayed in the Grade Rule table depends on the size range that you
specify in the grade rule details.

5 Click Save or Save and Close.

Creating POMs in a grade rule
1 In the Grade Rule table, select the POM line Click here to add a new row.

2 Specify POM details:

Priority
Select Default, Mandatory, or Optional.

POM Code
Specify a code.

The code must be unique. Two or more items cannot have the same code.

POM Name
Specify a name for the point of measure.

Description
Provide a brief description for the point of measure.

Part
Select a part from the list. You can define parts in Generic Lookup.

Image
Drag and drop images from your local computer to the image holder to graphically represent your
point of measure.

Tol+ & Tol - / Tol ±
Specify a numeric value to indicate the tolerance level of the grade rule.

The number of tolerance columns depends on the tolerance format you select for the grade rule.

Size
Provide size values.

The number of size columns displayed in the Grade Rule table depends on the size range that you
specify in the grade rule details.
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3 Click Save or Save and Close.

Item type
Item types are templates that help you increase the speed of creating styles. Item types are used in
an integrated setup between Infor Fashion PLM and M3 Business Engine (M3 BE). Typically created
in M3 BE and imported to Infor Fashion PLM, item types can be created within the application and
exported and used in M3 BE.

Creating item types
1 Select Basics > Item Type.

2 Click the New icon.

3 Specify this information:

Code

Specify a code.

The code must be unique. Two or more items cannot have the same code.

Name
Specify a name.

Description
Specify a brief description of the item type.

4 Click Save or Save and Close.

Operation
In Infor Fashion PLM, operations are high-level activities that a supplier must do to manufacture a
product. By defining operations in the application, you can calculate the operational costs of
manufacturing the product as part of the overall cost of product development, as well as estimate the
overall margins of a product.

Defining operations
You can define operations by specifying the details and requirements in the application.
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1 Select Basics > Operation.

2 Click the New icon.

3 In the General Overview Operation section, specify this information:

Code
Specify a unique code.

Name
Specify a name for the operation.

Description
Specify a brief description.

Placement

Select a placement from the list.

You can define placements in Generic Lookup.

Operation Type

Select an operation type.

You can define operation types in Generic Lookup.

Operation Group

Select an operation group.

You can define operation groups in Generic Lookup.

Currency
Select a currency.

See Creating currencies on page 108.

Hourly Rate
Specify an hourly rate.

Efficiency
Specify an efficiency rating.

Status
Select a workflow status.

4 In the Operation Details section, specify this information:

Stitches Per Inch
Specify the number of stitches for every inch.

Seam Allowance
Specify the seam allowance.

Free Field 1
Specify a value that does not fall under any defined field.
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User Defined 1

Select a user-defined field value.

You can define user-defined fields in Generic Lookup.

Skills
Select a skill.

You can define skills in Generic Lookup.

5 In the Operation Times section, specify this information:

Standard Allowable Minutes (SAM)
Specify the standard allowable minutes.

Setup Time (minutes)
Specify the setup time.

Man / Machine
Select Man, Machine, or Man and Machine.

6 In the Operation Instructions section, specify this information:

Language

Select a language from the list.

If left blank, this will default to English - United States.

Text
Specify an instruction text.

7 Optionally, drag and drop an image from your local computer to the image holder to graphically
represent your operation.

8 Click Save or Save and Close.

Operation list
An operation list is a sequence of manufacturing tasks that are necessary to create a product. By
creating operation lists in Infor Fashion PLM, you can estimate productions costs in relation to your
different suppliers, as well as the overall margins of a product.

Creating operation lists
You can create operation lists for every product category that is defined in the application by adding
operations.

1 Select Basics > Operation List.
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2 Click the New icon.

3 Specify this information:

Code
Specify a code.

Name
Specify a name for the operation list.

Description
Provide a brief description.

Product Categories

Select a product category.

You can define product categories in Generic Lookup.

Status
Select a status from the list.

4 From the main menu, select Basics > Operation and dock the Operation panel to any side of the
main window.

5 Drag and drop operations from the Operation panel to the Operation List panel.

Note:  You can directly edit the information of the operations on the Operation List table.

6 Optionally, create an operation directly on the Operation List table by specifying these information:

Seq #

Displays the sequence number of the operation.

Click and set the sequence number of the operation to your desired value to reorder the sequence
of the operations.

Placement
Select a placement from the list.

Operation Code
Specify a unique operation code.

Operation Name
Specify an operation name.

Description
Specify a description for the operation.

Operation Type
Select an operation type from the list.

Operation Group
Select an operation group from the list.

Number
Specify a number. By default, the value is set to 1.
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SAM
Specify a value for the Standard Allowable Minutes.

Hourly Rate
Specify a value for the hourly rate.

Currency
Select a currency from the list.

SAM Cost
Displays the SAM cost.

SAM Cost = Number * ((SAM / 60) * Hourly Rate)

Cost Currency
Displays the same currency set in the Hr Currency field.

Efficiency %
Specify a value for the efficiency %.

Status
Select a status from the list.

SPI
Specify a value for the SPI.

Seam Allowance
Specify a value for the Seam Allowance.

Free Field 1
Specify any other related details pertaining to the operation.

User Defined Field 1

Specify a value for this field.

You can create user-defined fields in Generic Lookup.

Skills
Select skills from the list.

Setup Time (min.)
Specify a value for the setup time in minutes.

Man/Machine
Select the applicable option from the list.

7 Optionally, to reorder the sequence of the operations, click and set the sequence number of the
operations to your desired value.

8 Click Save or Save and Close.
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Pattern
A pattern is a predefined collection of pattern pieces that includes a detailed pattern information and
cutting instructions. The pattern pieces are grouped by product categories.

Creating a pattern
1 Select Basics > Pattern.

2 Click the New icon.

3 Specify this information:

Name
Specify a name for the pattern.

Category

Select a category from the list.

You can define product categories in Generic Lookup.

Sub Category

Select a subcategory from the list.

You can define product subcategories in Generic Lookup.

Status

Select a status from the list.

You can define status in Generic Lookup.

Images
Drag and drop images from your local folder to the Images field.

Cutting Instructions
Specify the cutting instructions for the pattern.

4 Specify the pattern pieces details:

Seq #
The sequence number is automatically assigned after a priority is selected.
Note:  If multiple patterns are available, you can select a sequence number from the list to arrange
the order of the pattern items.

Priority
Select a priority from the list.

Code
Specify a code.

Name
Specify a name.

Infor Fashion PLM User Guide | 75

 

Understanding the basics



Description
Specify a brief description for the pattern piece.

Images
Drag and drop images from your local computer to the image holder.

Refer to
Specify a value.

Grain
Specify a value.

Service
Specify a value.

Quantity
Specify a quantity.

5 Optionally, attach files to the pattern. Drag and drop the files from your local computer to the
Attachments field.

6 Click Save or Save and Close.

Point of measure
A point of measure (POM) is a location on a product where the measurement should be taken. It is
usually combined with a short description on how to take the measurements and images for illustration.
The same POM can be used in one or more styles or in one or more grade rules, which can each be
associated to one or more product types.

Defining POMs
1 Select Basics > Point of Measure.

2 Click the New icon.

3 Specify this information:

Code

Specify a code.

The code must be unique. Two or more items cannot have the same code.

Name

Specify a code.

The code must be unique. Two or more items cannot have the same code.
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Description
Specify a brief description for the point of measure you are creating.

Images

Drag and drop an image from your local computer to the image holder to graphically represent your
point of measure.

4 After defining a point of measure, you may associate the point of measure to a product category.
Select any of the available product categories and click >> to move them to the associated product
category.

Note:  You can define product categories in Generic Lookup. To remove a product category, select
a record from the associated product category and click <<.

5 Optionally, attach files to a point of measure. Drag and drop files from your local computer to the
attachment field.

You can also click Attachments.

6 Click Save or Save and Close.

Importing POMs
You can import points of measure from your local computer to Infor Fashion PLM, enabling you to
reuse existing POMs built from your company. Before importing POMs, ensure that you meet these
prerequisites:

• Specify all necessary information such as product category, name, code, and description.
• Save the file in Microsoft Excel (*.csv) format.

Note:  If a POMs file contains fractions as values, change the file’s encoding format to Unicode (UTF-8)
before importing the file to Infor Fashion PLM.

In Microsoft Excel, click Save As > Tools > Web Options and select Unicode (UTF-8) from the list.

1 On your computer, browse for the location of the POMs file that you want to import to the Infor
Fashion PLM.

Note:  If your local folder is maximized, click Restore Down to float the window.

2 Drag and drop the POMs file from your local folder to the POM panel.

Purchase Order
In Infor Fashion PLM, you can create and send purchase orders to your suppliers for existing sample
requests.

A purchase order is a document that contains sourcing requirements such as product specification,
order quantity, procurement costs, and shipping information.
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Creating a purchase order
Note:  You can also create purchase orders from the Request panel. Right-click a record and select
Create Purchase Order. To create a purchase order for multiple requests, select two or more requests
while pressing Ctrl on your keyboard.

1 Select Basics > Purchase Order.
2 Click the New icon.

3 Specify this information:

Purchase Order Number

Specify a purchase order number.

The purchase order number serves as the identifying code for your purchase order within the
application.

To generate an ID, click Generate ID.

To configure the ID Generator, see Configuring ID Generator on page 46.

Supplier
Select a supplier from the list.
Note:  If you create a purchase order from the Request panel or add an item mix to the purchase
order, and a supplier is available on the request, a default value from the supplier record will be
set in this field.

Facility
Specify a facility.

Warehouse
Specify a warehouse.

Buyer
Displays the name of the currently logged-on account.

Request By
Displays the name of the currently logged-on account.

Reference PO Number
Specify a reference purchase order number.

Currency
Select a Currency from the list. You can define currency in Setup.
Note:  If you create a purchase order from the Request panel or add an item mix to the purchase
order, and a supplier is available on the request, a default value from the supplier record will be
set in this field.

Order Type

Select an order type from the list.

You can define purchase order types in Generic Lookup.

Payment Terms

Select payment terms from the list. You can define payment terms in Generic Lookup.
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Note:  If you create a purchase order from the Request panel or add an item mix to the purchase
order, and a supplier is available on the request, a default value from the supplier record will be
set in this field.

Payment Method

Select a payment method from the list.

You can define payment methods in Generic Lookup.

Delivery Method

Select a delivery method from the list.

You can define delivery methods in Generic Lookup.

Note:  If you create a purchase order from the Request panel or add an item mix to the purchase
order, and a supplier is available on the request, a default value from the supplier record will be
set in this field unless a delivery method is specified on the request.

Delivery Terms

Select a delivery term from the list.

You can define delivery terms in Generic Lookup.

Note:  If you create a purchase order from the Request panel or add an item mix to the purchase
order, and a supplier is available on the request, a default value from the supplier record will be
set in this field.

Due Date
Specify a due date.

Status

Select a status from the list.

You can define status in Generic Lookup.

Add item mix to a purchase order
Note:  If you create a purchase order from the Request panel, the item mix on the sample request is
automatically added to the purchase order.

If the purchase order is for a Style, the item mix that is included in the request for Style will refer to the
main colors and main size range of the selected style.

1 Select Basics > Request.
2 Float the Request panel and dock it to any side of the main window for side-by-side viewing.

3 Drag and drop a request from the Request panel into the Request table.

To add multiple requests simultaneously, select two or more requests while pressing Ctrl on your
keyboard.

Note:  Adding multiple requests is available only for requests with the same supplier.

4 Specify this information:
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Request #
Displays the request number of the request.

Request ID
Displays the request ID of the request.

Style Number
Displays the style number that is associated to the request's item mix.

Style Name
Displays the name of the style.

Color Code
Displays the color code of the request's item mix.

Color Name
Displays the color name of the request's item mix.

Size Range
Displays the size range of the request's item mix.

Size
Displays the size of the request's item mix.

Qty
Specify a quantity.

UOM
Select a unit of measurement from the list.

Price
Specify a price for the item mix.

Currency

Specify the amount and select a currency.

You can define currencies on the Setup menu.

Delivery Method

Select a delivery method.

You can define delivery methods in Generic Lookup.

Delivery Terms

Select a delivery term.

You can define delivery terms in Generic Lookup.

Due Date

Displays the due date that is specified on the request.

Optionally, update the due date.

5 Click Save.
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6 To send the purchase order to the selected supplier, click Send.

Request
In Infor Fashion PLM, you can request for samples, tests, lab dips, and requests for quotation (RFQs)
from your supplier. A supplier can be an agent, factory, or internal sourcing company.

By creating and sending requests to suppliers through Infor Fashion PLM, you can monitor continuously
the quality and costing of your products.

Creating requests
Before you start creating requests, you must first define request types and request subtypes.

Note:  You can also create requests from the Style, Material, and Trim panel. Right-click a record and
select Create Request.
1 Select Basics > Request.
2 Click the New icon.

3 Specify request attributes:

Request ID
Specify a request ID.

To generate an ID, click Generate ID.

To configure the ID Generator, see Configuring ID Generator on page 46.

Request #
Displays the number of the request.

Request For
Select Style, Material, or Trim.
Note:  When you add an existing style, material, or trim item, this field gets updated automatically
to reflect the type of the requested item.

In creating requests for Style, each request can only include the sizes available from one size range.
The item mix will also refer to the main colors and main size range of the style.

Type

Select a request type from the list.

You can define types in Generic Lookup.

Note:  Costing requests are available for style items only.

Sub Type
Select a request subtype.

You can define subtypes in Generic Lookup.
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Request By
Displays the name of user that created the request

Iteration
Displays the number of requests created per subtype of the record

Request Date
Specify a request date.

Due Date
Specify a due date.

Received Date
Specify a received date.

Status
Select a status from the list.
Note:  To resend requests that have already been processed and allow your supplier to reenter
details in Partner Collaboration, select Resent as the status. Alternatively, click Send Request.

Notes
Specify notes for the request.

Free Field 1
Specify any other related details pertaining to the request.

4 Click Save.

Specify the requested item
1 Open the module of the requested item.

For example, if you want to create a request for a style item, open the Style panel. Dock the panel
to any side of the main window for side-by-side viewing.

2 Drag and drop the item record to the request details page.

Item Number, Item Name, Supplier, Main Contact, Brand, and Season fields are updated.

The UOM field is also updated for sample and test requests.

Note:  By default, the main supplier is selected on the Supplier field.

3 Optionally, select suppliers from the list.

The list contains all associated suppliers for the requested item.

Note:  If you select multiple suppliers, individual requests will be created for each supplier after you
save or send the request.

The Main Contact field is updated based on the selected supplier. For costing requests, the Currency
field is also updated based on the selected supplier.

4 Specify this information:
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Supplier Contact

Optionally, click the ellipsis button to specify the supplier contact.

Available options depend on contacts that are connected to the requested item and to the selected
supplier.

You can still specify the supplier contact manually by typing the supplier name.

Internal Contact

Optionally, specify the internal contact.

The internal contact serves as the supplier's point person from your company.

Size Range

Select a size range from the list.

Available options depend on the size range in the measurement details of the style item.

Note:  This field is available only if the requested item is a style record or a trim record.

Provide shipping details for sample, sample with cost, and lab dip
requests
1 Go to Shipping Details section.

2 Specify this information:

Ship to

Click the ellipsis button to specify the shipping address.

Available locations depend on what you defined in your organization settings.

Ship Date
Select a shipping date.

Delivery Method

Select a delivery method.

You can define delivery methods in Generic Lookup.

Tracking #
Specify a tracking number.

Specify reports
1 Select available reports and click >> to move them to the Selected Reports box.

To remove selected reports, click <<.

2 Optionally, to specify report attachments, specify this information:
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BOM Version
Select a BOM version.

Sample Page
Select a sample measurement page.

Sample Page Status
The sample page status from measurements is displayed in this field.

3 Click Save.

Define the item mix for sample, lab dip, and compliance test requests
In creating requests for Style, each request can only include the sizes available from one size range.
The item mix will also refer to the main colors and main size range of the style.

1 Go to Item Mix section.

2 Specify this information:

Qty
Specify a number in the Quantity cell.

UOM
Select a unit of measure from the list.

Color

Click the Color cell and select a color from the list.

Available options depend on the colorways that you have assigned to the item.

Color Name

This field is updated automatically with the name of your selected color.

Size

Click the Size cell and select a size from the list.

Available options depend on the size range that you have assigned to the item.

Note:  This field is available only if the requested item is a style record or a trim record.

Received Qty
Specify the received quantity.
Note:  This field is available only for lab dip, sample, and test requests.

Submit #
Specify a submit number.
Note:  This field is available only for lab dip requests.

# of Lab dips submitted
Specify the number of lab dips submitted.
Note:  This field is available only for lab dip requests.
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Lab dip Reference #
Specify a lab dip reference #.
Note:  This field is available only for lab dip requests.

Received Date
Specify a received date.

Ship To

Click the ellipsis button to specify the shipping address.

Available locations depend on what you defined in your organization settings.

Ship Date
Specify a ship date.

Status

Select a status from the list.

You can define statuses in Generic Lookup.

Notes
Provide remarks or comments about the item mix.

User Defined Field 1
Specify a value for this field.

User Defined Field 2
Specify a value for this field.
Note:  Alternatively, you can define the item mix of a request on the Request panel. From the
Request panel, select a request item and click the Item Mix icon on the sidebar.

Specify delivery details for costing requests
1 Go to Quotation section.

2 Specify this information:

Lead Time
Specify a number.

Lead Time UOM
Select Hours, Days, or Weeks.

Min Qty
Specify a number.

Qty UOM

This field is auto-populated based on the selected supplier.

Optionally, select a quantity unit of measure.

You can define quantity UOMs in Generic Lookup.
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Delivery Method

This field is auto-populated based on the selected supplier.

Optionally, select a delivery method.

You can define delivery methods in Generic Lookup.

Terms

This field is auto-populated based on the selected supplier.

Optionally, select the terms.

You can define terms in Generic Lookup.

Country of Origin

This field is auto-populated based on the selected supplier.

Optionally, select a country of origin.

BOM Version
Select a BOM version.

Status
Select a status.

Define cost elements and BOM lines for costing requests
1 To identify a cost element as a quotation indicator, select the QI check box of a cost element.

Note:  Cost elements that are displayed in the Costing Elements section depend on cost elements
that you tagged as quotation indicators in the style's cost model.

2 To identify a BOM line as a cost indicator, select the CI check box of a BOM line.

Note:  BOM lines that are displayed in the BOM Lines section depend on the BOM version that you
specify as cost indicators in the style's main BOM version.

Define tests for test requests
1 On the Test section, specify this information:

Country of Origin
Select a country of origin.

Status
Select a status.

2 Select the check box of the applicable tests.

Note:  Mandatory and default tests are automatically selected.

The tests displayed in the Test section is based on the tests added in the style's compliance tab.
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Define mail details
1 Specify the email recipients in the To, CC, and BCC fields.

Note:  The supplier that you selected for the requested item is the default email recipient. You must
specify the supplier's email address in the Sourcing setup.

See Defining sourcing locations on page 95.

2 Type the email message.

3 Click Save or Save and Close.

Define request owner
1 On the Request panel, select the request that you want to update.

Note:  Requests can be automatically assigned to an action owner based on a role if you configure
the request ownership settings.

See Configuring request ownership settings on page 26.

2 Locate Role and Action Owner columns and select the corresponding role and action owners for
the request.

Note:  The Action Owner field is automatically updated based on the selected role. If there are
multiple action owners with the same role, the Action Owner field is left blank. Select an action owner
from the list.

If you select an action owner first, the Role field is automatically updated based on the selected
action owner. If the selected action owner has multiple roles, the field Role field is left blank. Select
a role from the list.

Mass creating requests
In Infor Fashion PLM, you can create requests for multiple styles, materials, or trims simultaneously
by using info clusters. Info clusters are sets of data from existing records that you can reuse to mass
create requests.

Note:  You can also mass create requests from the Style, Material, and Trim panel.

1 Select Basics > Request.
2 On the Request panel, click the Mass Create icon.

3 Open the Style, Material, or Trim panel.

The Request - Mass Create pane and the panel of the requested item are displayed side by side.

4 To create requests for multiple records, drag and drop records from the Style, Material, or Trim
panel to the Item Basket in the Request - Mass Create pane.

5 Optionally, select suppliers for each style in the Item Basket.

To select suppliers for a style, click the Supplier cell and select suppliers from the list. Available
options depend on the suppliers that you have associated to the style or material record.
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6 Specify this information:

Request ID
Specify the Request ID.

Request For
This field is updated automatically with the type of the requested items.

Type

Select a request type.

You can define types in Generic Lookup.

Sub Type

Select a request subtype.

You can define request subtypes in Generic Lookup.

Due Date
Select a due date.

Ship to
Specify the delivery address.

Optionally, you may click the ellipsis button and select from the Available Locations list. Click Add,
then click Ok.

Delivery Method

Select a delivery method.

You can define delivery methods in Generic Lookup.

7 Select available reports and click >> to move them to the Selected Reports box.

To remove selected reports, click <<.

Note:  To clear all information on the Mass Create pane, click Clear.

8 Optionally, set request settings as favorites.

Setting favorites enables you to save your custom settings and use them repeatedly.

To save request settings, click Set as Favorite.

9 Click Execute to display the Task Configuration window.

10 Select Run Now to execute the action immediately.

Optionally, you can also select Schedule for Later and specify a date.

11 Click OK.

12 To verify if the action is successful, select Action > Task Monitor on the main menu.

See “Monitoring Tasks” in PAH Online Help.
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Filtering requests
You can configure the display of requests by specifying filter options in the Request panel.

Create a new request filter
1 On the Request panel, select the Request Filter icon.

2 Click the New icon.

3 On the Request Filter dialog window, specify this information:

Default
Select this check box to make this the default request filter.

Filter Name
Specify a name for the request filter

Private
Select this check box to restrict this filter for your use only.

Public
Select this check box to make this filter available to all users.

4 Filter requests by specifying values for any of these options:

• Due Date
• Request Date
• Ship Date
• Action Owner
• Request By
• Request For
• Request ID
• Status
• Supplier
• Supplier Contact
• Type
• Sub Type
• Brand
• Item Number
• Category
• Season

5 Click Save.

6 Optionally, click Apply to activate the request filter.

Infor Fashion PLM User Guide | 89

 

Understanding the basics



Activate a request filter
1 On the Request panel, select the Request Filter icon.

2 Select a filter from the Filter Name list.

3 Click Apply.

Sending requests
In Infor Fashion PLM, you have the flexibility to create requests and send them to recipients immediately
or at a later date.

Before you start sending requests, you must configure your email settings in Infor Fashion PLM to send
requests successfully.

See Configuring email messages on page 24.

1 Select Basics > Request.
2 On the Request panel, select a request and click Send Request to display the Task Configuration

window.

3 Select Run Now to execute the action immediately.

Optionally, you can also select Schedule for Later and specify a date.

4 Click OK.

5 To verify if the action is successful, select Actions > Task Monitor on the main menu.

See “Monitoring Tasks” in PAH Online Help.

Note:  To view requests that you have made for an item, open the item details page of the requested
item and click the Request tab.

To resend requests that have already been processed and allow your supplier to reenter details in
Partner Collaboration, select the request and click Send Request. Alternatively, open the request
and set the status to Resent.

Adding comments to a request
Note:  If you have enabled Partner Collaboration settings in Infor Fashion PLM, and if you have identified
Partner Collaboration users in the Sourcing library, your suppliers and other partners for the requested
item can view comments that you post in the request. Additionally, you can view comments that your
suppliers and other partners post for the requested item in Partner Collaboration in Infor Fashion PLM.

See the Infor Fashion PLM Partner Collaboration User Guide.

You can post comments to requests, and reply to comments from other users, within Infor Fashion
PLM. Depending on authorities included in your user role, you can also edit and delete comments. The
most recent comments posted across the application will be displayed in the Latest Comments widget
on the home dashboard.
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The display of the Request/Comments pane depends on the visible request tags that you specify in
request tag settings.

See Configuring request tags on page 26.

1 On the Request panel, select a record and click the Request/Comments icon found on the sidebar.

2 Type your comment on the given field and click Post.
Note:  You can edit, delete, and organize comments after posting. To organize comments, categories
are available on the Context tab.

3 Optionally, to mark comments for public viewing, select the Show In Public check box.

4 To update the comments, click the Refresh icon.

Note:  You can add comments in every line in the item mix of a request. To add comments that are
specific to a request item, open the request details page. On the Item Mix section, select an item
and click the Request/Comments icon.

Attach files to a comment
1 From your local computer, drag and drop a file to the Attachment field of a comment.

If the file that you have attached is an image, a thumbnail of that image is displayed.

If the file that you have attached is not an image, the Attachment field is updated with the number
of files in the comment.

2 Optionally, to view multiple images attached to a comment, click an image and use the arrow buttons
on your keyboard.

3 Optionally, to view nonimage attachments to a comment, click the Attachment field and select the
file that you want to view.

Note:  You can edit attachments to a comment and save your changes in Infor Fashion PLM. Before
editing attachments, click Refresh in the Comments pane.

4 Optionally, to delete an image, right-click a thumbnail and select Delete.

5 Optionally, to delete nonimage attachments, double-click the Attachment field.

Select the check box of the file and click the Delete icon.

Search for a comment
1 Click the Search icon in the Comments pane.

Optionally, you can also select a comment and press Ctrl+F on your keyboard.

2 Specify a keyword to display comments containing that keyword.

View the comment hierarchy
1 In the Request/Comments pane, click the Hierarchy tab.
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2 To view comments and replies to comments on a particular tab, expand the hierarchy view by clicking
the drop-down arrow.

Reports for a request
You can create a Comments Report for a specific request. This report contains the request information
and the comments that you specified for the request.Reports for a request on page 92

See Generating reports on page 126.

You can generate a Request Tech Pack that contains a combination of the reports selected in the
reports details section of the request.

See Generating tech packs on page 132.

Size
Sizes pertain to a fashion product’s graduated measurements, such as small (S), medium (M), large
(L), and extra-large (XL).

Size ranges pertain to groups of sizes that are related to each other. For example, you can create a
size range called "Big Sizes" for the sizes large (L), extra large (XL), and extra extra large (XXL). You
create size ranges in the application to organize sizes for a certain theme or classification.

Size categories, on the other hand, are generated to suit different portions of the population, and these
provide some variation in proportions in the size sets. Examples of size categories are "Misses,"
"Juniors," "Petites," "Plus Size," and "Big and Tall."

To develop products in the application, you must define sizes and size ranges and then assign them
to the item that you are creating.

Creating sizes
1 Select Basics > Size.

2 Click the New icon.

3 Specify this information:

Code

Specify a size code.

The code must be unique. Two or more items cannot have the same code.

Name
Specify a size name.
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Description
Specify a brief description.

Status

Select Active or Inactive.

Select Active to mark the size available for use. A size will not be available for use if you select
Inactive.

4 Click Save or Save and Close.

Add characteristics to a size
1 Select Basics > Characteristics.

2 Float the Characteristics panel and dock it to any side of the main window for side-by-side viewing.

3 On the Size panel, select a size.

4 Click the Size/Characteristics icon on the side bar.

5 Drag and drop characteristics from the Characteristics panel into the Size/Characteristics pane.

Create size options for a size
Size options are sizes that have another dimension.

Note:  To create size options for a size, the size must contain characteristics with the type sizes.

1 On the Size panel, select a size.

2 Right-click the size and select Generate Size Option.

Creating size ranges
Size ranges pertain to groups of sizes that relate to each other. For example, you can create a size
range called “Big Sizes” for sizes Large and Extra-Large. By creating size ranges in Infor Fashion PLM,
you can organize sizes for a certain theme or classification.

1 Select Basics > Size Range.

2 Click the New icon.

3 Specify this information:

Code

Specify a code for your size range.

The code must be unique. Two or more items cannot have the same code.

Name
Specify a unique size range name.
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Description
Specify a brief description.

Status

Select Active or Inactive.

Select Active to mark the size range available for use. A size range will not be available for use if
you select Inactive.

4 To add sizes to the size range, open and dock the Size panel to any side of the main window to
drag and drop sizes to the Selected Sizes section.

Note:  You can only add one type of size dimension in the Selected Sizes section.

For example, if you added a multidimensional size, you can no longer add a single dimension size.

5 To modify the sequence of sizes within a size range, drag and drop sizes beside one another.

The sequence of sizes determines the order by which sizes within a size range are displayed in the
Size Range panel.

6 Click Save or Save and Close.

Creating size charts
The size chart enables the user to create a size conversion reference in a size range.

1 Select Basics > Size Range.

2 Right-click a size range and select Size Chart.
3 In the Size Chart dialog box, select the applicable size range types from the list.

You can define size range types in Generic Lookup.

4 Specify a size for the size range type.

5 Click Save.

Creating a size category
Size categories are generated to suit different portions of the population, and these provide some
variation in proportions in the size sets.

Examples of size categories are Misses, Juniors, Petites, Plus Size, and Big and Tall.

Note:  Size categories are used in creating grade rules.

1 Select Basics > Size Category.

2 Click the New icon.

3 Specify this information:

Code

Specify a size category code.
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The code must be unique. Two or more items cannot have the same code.

Name
Specify a size category name.

Description
Specify a brief description.

Status

Select Active, Inactive or any user-defined status.

Select Active or any user-defined status with a base status of Active to mark the size available for
use. A size category will not be available for use if you select Inactive.

4 Click Save or Save and Close.

Sourcing
Sourcing pertains to suppliers that provide finished goods, as well as the necessary fabrics and trims
in creating your product. Identifying your sources is critical in fashion planning. You can define sourcing
locations and assign them to your styles, materials, and trims in Infor Fashion PLM.

Defining sourcing locations
1 Select Basics > Sourcing.

2 Click the New icon.

3 Specify this information:

Code

Specify a code.

The code must be unique. Two or more items cannot have the same code.

Name
Specify a name.

Address 1
Specify the address.

Address 2
Specify additional address details.

Country
Select a country.
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Region
Specify the region.

City
Specify the city.

Phone
Specify the supplier's phone number.

Fax
Specify the supplier's fax number.

Homepage
Specify the supplier's Web site.

Email
Specify the supplier's email.

Main Contact
Specify your main contact in the supplier company.

Main Contact Email
Specify the email of your main contact.

Supplier Type

Select a supplier type from the list.

You can define supplier types in Generic Lookup.

Internal/External
Select Internal or External.

Status

Select Active, Inactive, or any user-defined status.

Select Active to mark that this sourcing is available for use. A source will not be available for use
if you select the Inactive status or a user-defined status that has Inactive as base status.

Vendor Status

Select a vendor status.

You can define vendor statuses in Generic Lookup.

Last Inspection Date
Specify the last inspection date.

Currency
Select a currency from the list.

Delivery Method

Select a delivery method.

You can define delivery methods in Generic Lookup.
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Delivery Terms

Select a delivery term.

You can define delivery terms in Generic Lookup.

Payment Terms

Select payment terms from the list.

You can define payment terms in Generic Lookup.

Free Field 1
Specify any other related details pertaining to your supplier.

Free Field 2
Specify any other related details pertaining to your supplier.

Free Field 3
Specify any other related details pertaining to your supplier.

Free Field 4
Specify any other related details pertaining to your supplier.

Set to Parent
Select this check box to make this supplier a parent to subsuppliers.

Parent

This field is automatically selected if the sourcing company has related subsuppliers. If the sourcing
company is added as a subsupplier to another sourcing company, this field displays the name of
the parent company.

To see related subsuppliers, click the Supplier Relations tab. You can also see related subsuppliers
by clicking Supplier Relations on the sidebar while on the Sourcing Panel.

Note:  If you delete a parent sourcing company, all related subsuppliers will be set as independent
suppliers

User Defined Field 1

Select a user-defined field from the list.

You can define user-defined field types by using the Supplier User Defined Field 1 type in Generic
Lookup.

User Defined Field 2

Select a user-defined field from the list.

You can define user-defined field types by using the Supplier User Defined Field 2 type in Generic
Lookup.

From
Specify a valid start date.

To
Specify a valid end date.
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4 Drag and drop files to the Attachments section to upload files related to your supplier.

All files that you attach are displayed in the Attachments Information tab.

5 Specify notes about your supplier in the Notes section.

6 To add other addresses and information pertaining to your supplier, specify details in the Other
Address tab.

7 To identify Partner Collaboration users for this sourcing, click the Partner Collaboration Users tab
and specify this information:

First Name
Specify a first name.

Last Name
Specify a last name.

Email
Specify the email address.

User Access
Select the modules that users can access in Partner Collaboration.

Is Active

Select the check box to enable access.

A user must be set as active in Infor Fashion PLM to enable access to Partner Collaboration.

Password Changed

Select the check box to specify that the password has been changed by the user.

This field applies to existing Partner Collaboration users that you need to update.

8 To notify users that they have been granted access to Partner Collaboration through email, click
Send Password(s).

9 To add internal users for this sourcing, click the Internal Users tab and select a Login Name.

10 To add subsuppliers to a parent sourcing company, drag and drop sourcing records from the Sourcing
panel to the Supplier Relations tab.

Note:  You cannot add a parent company as a subsupplier to another sourcing company. You
cannot add subsuppliers to sourcing companies that have been set as a subsuppliers.

Subsuppliers can be related to only one parent company. The Supplier Relations tab is only available
for sourcing records that are set as parent or independent sourcing companies.

11 To update information about your attachments, click the Attachments Information tab.

12 Select an attachment and specify this information:

Attachment
Displays the file name of the attachment.

Notes
Specify a brief description about the attachment.

Issue Date
Select an issue date.
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Expiry Date
Select an expiry date.

Free Field 1
Specify any other related details pertaining to the attachment.

13 Click Save or Save and Close.

See the Infor Fashion PLM Partner Collaboration User Guide.

Supplier compliance
In Infor Fashion PLM, users can define internal or international standards that are recognized and
followed by their organization by creating supplier compliance templates. Supplier compliance templates
can then be used to create supplier compliance requests, which aim to monitor compliance of suppliers
and other partners to internal or international standards.

See Creating a supplier requests on page 101.

Creating a supplier compliance templates
1 Select Basics > Supplier Compliance Template.

2 Click the New icon.

3 Specify this information:

Code
Specify a supplier compliance template code.

Name
Specify a name for the supplier compliance template.

Description
Specify a brief description.

Compliance Type
Select a compliance type from the list.

Compliance Standard
Specify a compliance standard.

Version No
Specify a version number.

Status
Select a status from the list.
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Interval
Specify an interval value.

Alert
Specify an alert value.

Notes
Specify remarks or comments about the supplier compliance template.

4 On the compliance table, specify this information:

Seq#

Displays the sequence number of the compliance template item.

Click and set the sequence number of the compliance template item to your desired value to reorder
the sequence of the compliance template items.

Priority
Select a priority from the list.

Compliance Category

Select a compliance category from the list.

You can define compliance categories in Generic Lookup.

Compliance Name
Specify a compliance name.

5 Click Save.

Importing supplier compliance templates
You can import supplier compliance templates from your local computer to Infor Fashion PLM by using
a CSV file. Before importing supplier compliance templates, ensure that you meet these prerequisites:

• Specify all required information: code, name, compliance category, and compliance name.
• Specify all other information. These column headers must be on the file:

• Code
• Name
• Description
• ComplianceType
• ComplianceStandard
• VersionNo
• Interval
• Alert
• Notes
• Priority
• ComplianceCategory
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• ComplianceName

• Save the file in Microsoft Excel (*.csv) format.

1 On your computer, browse for the location of the supplier compliance template file that you want to
import to Infor Fashion PLM.

2 Drag and drop the file from your local folder to the Supplier Compliance Template panel.

3 On the Import CSV File window, select a list separator and click OK.

Supplier request
In Infor Fashion PLM, you can send compliance requests to your suppliers. By sending supplier
compliance requests, your company can ensure that the suppliers and its products adhere to various
applicable regulations.

Creating a supplier requests
Note:  You can also create a supplier request from the Sourcing library.

To create a supplier request from the Sourcing library, right-click a sourcing record and click Create
Supplier Request. Requests created for a supplier are added in the Request tab of the sourcing record.

1 Select Basics > Supplier Request.
2 Click the New icon.

3 Specify this information:

Supplier Request ID
Specify a supplier request ID.

Supplier Request #

Displays the supplier request number.

Supplier Request # is an auto-incremented unique numeric value.

Type

Select a request type from the list.

You can define request types in Generic Lookup.

Sub Type

Select a request subtype from the list.

You can define request subtypes in Generic Lookup.

Request By
Displays the name of the currently logged-on account.
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Supplier

Displays the name of the supplier if the supplier request is created from the Sourcing panel.

Audit Company

Select an audit company from the list.

You can define audit companies in Generic Lookup.

Auditor
Specify the name of the auditor.

Request Date
Displays the request date.

Due Date
Specify a due date.

Expected Audit Date
Specify the expected audit date.

Actual Audit Date
Specify the actual audit date.

Next Expected Audit Date
Specify the next expected audit date.
Note:  This field is enabled only after you specify an actual audit date.

If you add a supplier compliance template that contains a defined interval, this field is automatically
updated based on the actual audit date and the interval.

Status
Select a status from the list.

Audit Result
Select an audit result from the list.

Requires Re-Inspection
Select if the request requires reinspection.
Note:  The check box is automatically selected if the audit result is set to Failed.

Optionally, clear the check box.

Re-Inspection Date
Specify the reinspection date.
Note:  This field is enabled only if the Requires Re-Inspection check box is selected.

Add supplier compliance template
1 Select Basics > Supplier Compliance Template.
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2 Float the Supplier Compliance Template panel and dock it to any side of the main window for
side-by-side viewing.

3 Drag and drop a supplier compliance template from the Supplier Compliance Template panel into
the Template table.

To delete a supplier compliance template, right-click a template and select Delete.

4 Optionally, attach files to a supplier request. Drag and drop files from your local computer to the
attachment field.

Define mail details
1 On the Mail Details section, specify the email recipients in the To, CC, and BCC fields.

Note:  The supplier that you selected for the requested item is the default email recipient. You must
specify the supplier's email address in the Sourcing setup.

See Defining sourcing locations on page 95.

For social compliance requests, the audit company and the supplier are set as the default email
recipients.

2 Type the email message.

3 To send the email, click Send.

4 Click Save or Save and Close.

Standard
A standard is a set of tests that you can associate to a style, material, or trim. Creating standards
enables you to group related tests with each other and apply them as a set to a style, material, or trim
that you intend to evaluate.

Creating standards
1 Select Basics > Standard.

2 Click the New icon.

3 Specify this information:

Name
Specify a name.

Description
Specify a brief description.

Type
Select a module for which the standard will be used, or select all. Click OK.

Infor Fashion PLM User Guide | 103

 

Understanding the basics



Main Category

Select a main category.

Available options depend on the modules that you selected.

4 Click Save or Save and Close.

Assigning tests to a standard
You can assign tests to a standard by accomplishing these tasks:

• Adding tests from the Test panel

See Creating tests on page 106.

• Creating tests from the Standard panel

Note:  You cannot add tests to a standard without specifying standard details.

Add tests to a standard
1 Select Basics > Test.
2 Float the Test panel and dock it to any side of the main window for side-by-side viewing.

3 Drag and drop a test from the Test panel into the Standard table.

To add multiple tests simultaneously, select two or more tests while pressing Ctrl on your keyboard.

4 Specify this information:

Seq #
Rearrange the tests by doing one of these tasks:
• Selecting a sequence number from the list
• Providing a sequence number in the Seq # field
• Dragging and dropping tests
Note:  You can rearrange the tests in descending or ascending order by clicking the arrow in the
Seq # column.

Priority
Select Default, Mandatory, or Optional.
• Default tests are initially included on the Compliance tab with the mandatory test when the

standard is added to a product, but they can be edited and removed.
• Mandatory tests must be on every product that uses the standard and will be locked on the

Compliance tab. Deleting mandatory tests will also delete the entire standard where the mandatory
test is included.

• Optional tests are editable and can be removed from the standard.
Note:  You can mass update the priority status of tests by multiselecting records while holding
Ctrl on your keyboard.
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Operator

Select an operator to specify the condition in determining the performance requirement.

Performance Req.
Specify the performance requirement.

Editable
Select the check box to allow editing of the test.

5 Click Save or Save and Close.

Create tests in a standard
1 In the Standard table, select the test line Click here to add a new row.

2 Specify this information:

Priority
Select Default, Mandatory, or Optional.
• Default tests are initially included on the Compliance tab with the mandatory test when the

standard is added to a product, but they can be edited and removed.
• Mandatory tests must be on every product that uses the standard and will be locked on the

Compliance tab. Deleting mandatory tests will also delete the entire standard where the mandatory
test is included.

• Optional tests are editable and can be removed from the standard.
Note:  You can mass update the priority status of tests by multiselecting records while holding
Ctrl on your keyboard.

Code
Specify a code.

Test Name
Specify a test name.

Test Method
Specify a test method.

Operator

Select an operator to specify the condition in determining the performance requirement.

Performance Req.
Specify the performance requirement.

Editable
Select the check box to allow editing of the test.

3 Click Save or Save and Close.
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Test
Tests are procedures that enable you to evaluate the quality of products, as well as ensure that various
regulations within the fashion industry are followed. After creating tests in the application, you can
group tests into a standard.

You can add tests in the application by accomplishing these tasks:

• Defining tests in the Test panel
• Importing tests from your local computer

Creating tests
You can create tests in the application to have your styles, materials, and trims evaluated for various
aspects.

1 Select Basics > Test.
2 Click the New icon.

3 Specify this information:

Code
Specify a code.

Name
Specify a name for the test.

Description
Specify a brief description.

Test Method
Specify the test method.

4 Click Save or Save and Close.

Importing tests
You can import tests from your local computer to Infor Fashion PLM, enabling you to reuse existing
tests built from your company.

Before importing tests, ensure that you meet these prerequisites:

• Specify all necessary information: code, name, description, and test method.
• Save the file in Microsoft Excel (*.csv) format.

1 On your computer, browse for the location of the tests file that you want to import to Infor Fashion
PLM.

2 Drag and drop the tests file from your local folder to the Test panel.
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3 Optionally, you can change the sequence of tests by dragging and dropping tests relative to each
other.
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Chapter 3: Setting up the application

To use all the features of the application, you must first set up information that is necessary and
applicable to all modules, such as currencies, exchange rates, generic field values, and units of
measurement.

Currency
Maintaining currencies in the application enables you to manage purchase transactions and set the
appropriate pricing for your records. While you can create multiple currencies in Infor Fashion PLM,
you can only set one base currency. The base currency serves as the default currency for all features
in the application and as the parent currency for exchange rates.

Creating currencies
You can create currencies to manage your pricing and purchasing transactions. You can create multiple
currencies to identify the equivalent prices for products in different currencies.

1 Select Setup > Currency.

2 Click the New icon.

3 Specify this information:

Code

Specify a currency code.

The code must be unique. Two or more items cannot have the same code.

Name
Specify a currency name.

Description
Specify a brief description.

Status

Select Active, Inactive, or any user-defined status.
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You cannot use the currency for related functions, such as calculating exchange rates, if you set
the status as Inactive.

Symbol
Specify the currency symbol.

Base currency

Select Yes or No from the list to set the currency as the base currency.

Setting a currency as base makes it the default currency across the application.

Attachments
Drag and drop files to upload attachments related to your currency.

4 Click Save or Save and Close.

Exchange rate
An exchange rate serves as the basis on which you can exchange one currency for another. You can
define and copy exchange rates for currencies you have defined in Infor Fashion PLM.

To define exchange rates, you must first define currencies and set one currency as the base currency.
A base currency is the parent currency, and exchange rates are quoted according to the unit of the
base currency.

Creating exchange rates
You can create an exchange rate using your base currency as the parent currency.

1 Select Setup > Exchange Rate.

2 Click the New icon.

3 Specify this information:

Code

Select the currency code from the list.

The values displayed are retrieved from the Currency panel.

Type
Select an exchange rate type.
• Actual is the exchange rate type that pertains to current values of an exchange rate.
• Budget is the exchange rate type that is set by organization for one entire budget period.
• Simulation is the exchange rate type that pertains to forward rates that will take place in the

future.
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• Collection / Line Plan is the exchange rate type specifically for collection plans and line plans.
Exchange rates of this type cannot be used elsewhere in the application except for collection
plans and line plans and, as such, should not be copied.

Note:  You can create only one exchange rate for a currency with this exchange rate type.

Exchange rate

Specify the exchange rate for the base currency.

The exchange rate is the rate with which the base currency is multiplied to be converted to the
actual currency.

For example, if the base currency is USD, the exchange rate for EUR is 0.78 (1 USD = 0.78 EUR).

Valid From Date

Specify a start date to set the validity period of the exchange rate.

Note:  If the exchange rate type that you selected is Collection / Line Plan, leave this field blank.

Valid To Date
Specify an end date to set the validity period of the exchange rate. This field is optional.
Note:  If the exchange rate type that you selected is Collection / Line Plan, leave this field blank.

You cannot set up overlapping exchange rates by exchange rate type.

Base Currency

By default, the currency that you define in the Currency is the base currency.

You cannot change this value.

Status

Select Active or Inactive.

Active exchange rates cannot be deleted.

Default Exchange Rate
Select Yes or No.

Comment
Provide additional comments for the exchange rate.

Attachments
Drag and drop files to upload attachments related to your exchange rate.

4 Click Save or Save and Close.

Creating generic lookup items
The Generic Lookup feature serves as the venue and repository for setting up field values in all modules.
It is where users define values in lists, for example, Brand, Material Type, and Supplier Type.

1 Select Setup > Generic Lookup.
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2 Click the New icon.

3 Specify this information:

Type
Select a generic lookup type from the list.

Code

Specify a code.

The code must be unique. Two or more items cannot have the same code.

Name
Provide a name for your generic lookup.

Description
Specify a description.

Status
Select Active or Inactive from the list.
Note:  You can change the status of a generic lookup item that is currently in use in a record.
Inactive items are disabled for selection in the Style Overview window but are still displayed in the
list.

Sequence

Specify a sequence number.

The sequence number determines the order of importance of the generic lookup.

System Defined
The check box is selected if the generic lookup item is system defined.
Note:  Updating a system defined lookup item that is currently in use may affect the modules or
processes that uses the generic lookup item.

4 Click Save or Save and Close.

Generic lookup items
This table shows generic lookup items available in Infor Fashion PLM:

Used inItem

ActivityActivity Type

Basic Care Modifier

Style > Overview

Collection Plan

Line Plan

Trim > Overview

Brand

Material > Construction > Yarn > SpunCarded/Combed
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Used inItem

CareCare Group

Collection Plan

Line Plan

Style > Overview

Channel

Style > Overview

Color Palette

Collection Plan

Line Plan

Collection

Color

Color Palette

Style > Colorways

Material > Colorways

Trim > Colorways

Color Family

Color

Style > Colorways

Color Shade

Color

Color Palette

Style > Colorways

Material > Colorways

Trim > Colorways

Color Sub Type

Style > Colorways

Material > Colorways

Trim > Colorways

Color User Defined Field 1

Style > Colorways

Material > Colorways

Trim > Colorways

Color User Defined Field 2

Style > Colorways

Material > Colorways

Trim > Colorways

Color User Defined Field 3

Supplier Compliance TemplateCompliance Category

Material > Overview > Composition

Trim > Overview

Component Type

Material > Overview

Trim > Overview > Additional Information / Details

Construction
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Used inItem

Cost Element

Cost Model > Cost Elements

Style > Costing > Cost Elements

Cost Level

Style > Care & Content

Style > Overview

Material > Overview > Main Sourcing Information

Trim > Overview > Main Sourcing Information Sourcing

Collection Plan

Line Plan

Country

Style > Overview

Style > Colorways

Material > Overview

Trim > Overview

Collection Plan

Line Plan

Deliveries

Sample Request > Shipping Details

Sourcing

Cost Request

Delivery Method

Sourcing

Cost Request

Delivery Terms

Material > Overview

Trim > Overview

Style > Overview

Division

Trim > Extra Details > EmbroideryEmbroidery Backing

Dictionary

Style > Overview 2

Feature Type

Material > Overview > Additional Information / Details

Trim > Overview > Additional Information / Details

Finish

Style > Overview

Collection Plan

Line Plan

Gender

Style > Overview

Material > Overview

Trim > Overview

HTS

Style > Care & ContentLabel Name
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Used inItem

Style > Care & Content

Dictionary

Language

Style > Care & Content

Material

Layer

Style > Overview

Collection Plan

Line Plan

Market Field 1

Style > Overview

Collection Plan

Line Plan

Market Field 2

Style > Overview

Collection Plan

Line Plan

Market Field 3

Style > Overview

Collection Plan

Line Plan

Market Field 4

Style > Overview

Collection Plan

Line Plan

Market Field 5

Material > Overview

Style > BOM

Material Category

Style > BOM

Material > Overview

Material > Construction > Attributes

Material Category Group

Material > Overview

Style > BOM

Standard

Material Main Category

Material > Overview

Trim > Overview

Material Type

Material > OverviewMaterial User Defined Field 1

Material > OverviewMaterial User Defined Field 2

Material > OverviewMaterial User Defined Field 3

Material > OverviewMaterial User Defined Field 4

Material > OverviewMaterial User Defined Field 5
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Used inItem

Material > OverviewMaterial User Defined Field 6

Material > OverviewMaterial User Defined Field 7

Operation

Operation List

Style > BOM > BOO

Operation Group

Operation

Operation List

Style > BOM > BOO

Operation Type

Style > OverviewPacking

Style > BOM

Style > Care & Content

Style > Measurement

Grade Rule

Part

Purchase OrderPayment Method

SourcingPayment Terms

Operation

Operation List

Style > BOM > BOO

Placement

TrimPrint Method

TrimPrint Type

Style > Overview

Grade Rule

Point of Measure

Collection Plan

Line Plan

Standard

Product Category

Style > Overview

Collection Plan

Line Plan

Product Subcategory

Style > Overview

Collection Plan

Line Plan

Product Subsubcategory

Purchase OrderPurchase Order Type
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Used inItem

Sourcing

Style

Collection Plan

Line Plan

Region

Trim > Extra Details > Art DetailsRepeat Type

RequestRequest Status

Style> Request

Report

Request

Request Subtype

Style > Request

Report

Request Type

Style > Measurement > SampleSample Evaluation Status

Style> Overview

Material > Overview

Trim > Overview

Color Palette

Collection Plan

Line Plan

Season

MaterialShrinkage Length

MaterialShrinkage Width

Operation

Operation List

Style > BOM > BOO

Skills

Trim > Extra Details > EmbroideryStitch Type

Organizational structureStructure Field 1

Organizational structureStructure Field 2

Organizational structureStructure Field 3

Organizational structureStructure Field 4

Organizational structureStructure Field 5

SourcingSupplier Type

SourcingSupplier User Defined Field 1

SourcingSupplier User Defined Field 2
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Used inItem

Style > Overview

Collection Plan

Line Plan

Theme

Trim > Overview

Style > BOM

Trim Category

Trim > OverviewTrim Category Group

Trim > Overview

Style > BOM

Standard

Trim Main Category

TrimTrim Size Category

Trim > OverviewTrim User Defined Field 1

Trim > OverviewTrim User Defined Field 2

Trim > OverviewTrim User Defined Field 3

Trim > OverviewTrim User Defined Field 4

Trim > OverviewTrim User Defined Field 5

Trim > OverviewTrim User Defined Field 6

Trim > OverviewTrim User Defined Field 7

Style > Overview

Style > Colorways

Style > BOM

Style > Colorways

Style > Care & Content

Request

Style > Request

Material Request

Material > Overview > Material Information

Material > Overview > Additional Information / Details

Material > Overview > Additional Sourcing Information

Material > Construction > Attributes > Construction
Details

Material > Construction > Attributes > Finish

Material > Care & Content

Trim > Overview >Trim Information

Trim > Overview > Additional Information / Details

Trim > Overview > Additional Sourcing Information

Unit of Measurement
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Used inItem

Style > Overview

Style > BOM

Style > BOM > BOO

Operation

Operation List

Collection Plan

Line Plan

User Defined Field 1

Style > Overview

Style > BOM

Style > BOM > BOO

Operation

Operation List

Collection Plan

Line Plan

User Defined Field 2

Style > Overview

Style > BOM

Style > BOM > BOO

Operation

Operation List

Collection Plan

Line Plan

User Defined Field 3

Style > Overview

Style > BOM

Style > BOM > BOO

Material > Overview

Operation

Operation List

Collection Plan

Line Plan

User Defined Field 4

Material > OverviewUser Defined Field 5

Material > OverviewUser Defined Field 6

Material > OverviewUser Defined Field 7

SourcingVendor Status
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Used inItem

Style

Material

Trim

Style > Measurement > Sample

Workflow Status

Material > Construction > Yarn > Yarn Table

Material > Construction > Yarn > Spun & Filament

Yarn Dyeing Method

Material > Construction > Yarn > Yarn Table

Material > Construction > Yarn > Spun

Material > Construction > Yarn > Filament

Material > Construction > Yarn > Spun & Filament

Yarn Type

Importing generic lookup items
You can import generic lookup items from your local computer to Infor Fashion PLM, enabling you to
reuse existing generic lookup items built from your company.

Before you start importing generic lookup items, ensure that you meet these prerequisites:

• Specify all necessary information such as type, code, name, status, and sequence.
• Save the file in Microsoft Excel (*.csv) format.

1 On your computer, browse for the location of the generic lookup items file that you want to import
to the Infor Fashion PLM.

Note:  If your local folder is maximized, click Restore Down to float the window.

2 Drag and drop the generic lookup items file from your local folder to the Generic Lookup panel.

Generic lookup field dependencies
You can set up the generic lookup field dependencies to filter the available categories and its
corresponding sub-items in the Style, Material, and Trim overview panels. You can also set up field
dependencies for request types.

Note:  On the Generic Lookup Field Dependencies panel, ensure that you select the module or the
item that you will add a sub-item to before you drag and drop items from the Generic Lookup panel.

If a brand is set as main node on a field dependency hierarchy, that brand cannot be set as a secondary
node for a division.

If a division is set as a main node on a field dependency hierarchy, that division cannot be set as a
secondary node for a brand.

This table shows the hierarchy of generic lookup items per module:
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HierarchyModule

• Brand
• Division

• Product Category
• Product Sub Category

• Product Sub Sub Category

• Brand
• Product Category

• Product Sub Category
• Product Sub Sub Category

• Division
• Brand

• Product Category
• Product Sub Category

• Product Sub Sub Category

• Division
• Product Category

• Product Sub Category
• Product Sub Sub Category

Style

• Brand
• Division

• Material Main Category
• Material Category

• Material Group

• Brand
• Material Main Category

• Material Category
• Material Group

• Division
• Brand

• Material Main Category
• Material Category

• Material Group

• Division
• Material Main Category

• Material Category
• Material Group

Material
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HierarchyModule

• Brand
• Division

• Trim Main Category
• Trim Category

• Trim Group

• Brand
• Trim Main Category

• Trim Category
• Trim Group

• Division
• Brand

• Trim Main Category
• Trim Category

• Trim Group

• Division
• Trim Main Category

• Trim Category
• Trim Group

Trim

• Request Type
• Request Sub Type

Request

Setting up generic lookup field dependencies
1 Select Setup > Generic Lookup Field Dependencies.

2 Click the Generic Lookup icon on the right-side of the Generic Lookup Field Dependencies panel.

3 On the Generic Lookup Field Dependencies panel, select a module or an item that you will add a
sub-item to.

4 On the Generic Lookup panel, click a generic lookup type to display the available items and then
drag and drop an item to the Generic Lookup Field Dependency panel.

• To add multiple items simultaneously, multiselect items while pressing Ctrl on your keyboard.
• If the Generic Lookup Field Dependencies dialog box is displayed, click Yes to proceed.
• To delete an item, right-click the item and click Delete.

5 Optionally, drag and drop the product sub subcategories to arrange their sequence.
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Organizational structure
When creating products, a company tends to plan and develop for more than one division, business
line, and brand. For example, a company may have a division that creates products that carry its own
brand, and another division that manufactures products for its customers. Different users within the
company may also have different roles depending on the division, business line, season, or brand.

To plan and manage the development of your products efficiently, Infor Fashion PLM has been designed
to enable you to set up your own organizational structure. An organizational structure enables you to:

• Access, view, and group data.
• Define and specify the types of data that you enter in the system.
• Set up default data and access to certain features, such as styles.

This diagram shows an example of how you can set up an organizational structure in Infor Fashion
PLM:

In Infor Fashion PLM, you set up your organizational structure by using the Structure Basket. The
Structure Basket is where you build the hierarchy of your organizational structure by adding and sorting
levels from Generic Lookup.

See Setting up your organizational structure on page 122.

Setting up your organizational structure
Use these procedures to set up your organizational structure.

Define data types
Follow these steps to define and specify the types of data that you enter in the system.

1 Select Setup > Organizational Structure.

2 Right-click Top and select Structure Basket.
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The Structure Basket is where you select the types of data from Generic Lookup that define the
hierarchy of your organization.

3 From the main menu, open Generic Lookup and dock the panel to any side of the main window.

The Structure Basket and Generic Lookup panels are displayed side by side.

4 Drag and drop generic lookup types to the Structure Basket.

Note:  Adding a generic lookup type to the Structure Basket includes all defined values classified
under that type.

For example, the generic lookup type “Season” may have Summer, Winter, Autumn, and Spring as
defined values.

Define the data hierarchy
Follow these steps to define your data hierarchy. The order by which you organize data types from the
Structure Basket determines the hierarchy of your organizational structure.

1 Dock the Structure Basket to any side of the main window.

The Organizational Structure and Structure Basket panels are displayed side by side.

2 Drag and drop generic lookup values from types that you added in the Structure Basket to the
Organization Structure panel.

Adding items from the Structure Basket to the Organizational Structure dictates the hierarchy of
your organization.

Associating modules to your organizational structure
Before you start associating modules to your organization, you must set up your organizational structure.

See Setting up your organizational structure on page 122.

Infor Fashion PLM enables you to associate certain modules to each level of your organizational
structure. Items under associated modules are automatically available under that organizational level.

For example, by associating the materials “Spandex,” “Nylon,” and “Cotton” in the organizational level
Swimming Essentials (Brand) > Winter 2013 (Season) > New York Fashion Week (Collection), any
style record that you create under that data hierarchy will have these materials as default options.

You can associate these modules to your organizational structure:

• Color palettes
• Materials
• Trims
• Suppliers
• Size ranges

1 On the Organizational Structure panel, right-click an organizational level and select Data Holder.
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2 From the main menu, open the panel of the module that you want to associate to your organizational
structure.

Dock it to any side of the main window for side-by-side viewing.

3 On the module panel, drag and drop an item to the Data Holder panel.

Note:  You can rename the group name of each feature. To specify a new group name, double-click
the group name cell.

4 To associate a specific record under a module, expand the module group.

5 Drag and drop a record to a level on the Organizational Structure panel.

6 To verify that the action was successful, right-click the organizational level and select Structure
Data.

The Structure Data displays all associated color palettes, materials, trims, suppliers, and size ranges
to an organization level.

Identifying user access to levels of your organizational
structure
Note:  You can use this feature only if you are using a published application in multi-user mode.

See Infor Fashion PLM Planning Application Host Installation Guide.

You can select users that can access levels in your organizational structure. Specifying users that can
access organizational levels enables you to filter users that can view, add, or modify items that fall
under that organizational level.

1 Select Setup > Organizational Structure.

2 On the Organizational Structure panel, select an organizational level and click the Users icon on
the sidebar.

3 On the Users pane, click Add User.
4 Select the check box of users that you want to grant access to the organizational level, and then

click Add User.
5 Close the pane.

Using the structure lookup box
You can customize and specify the records that you can create and view in Infor Fashion PLM according
to your organization structure by using the structure lookup box. The structure lookup box, found on
the status bar of the Infor Fashion PLM window, contains all levels of your organizational structure. To
filter your use and view of Infor Fashion PLM, select an organization level in the structure lookup box.

Note:  The structure lookup box is visible only if you have set up an organizational structure.

Filters based on levels in your organizational structure can also be defined and viewed in the My Folders
widget on the home dashboard.
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If you selected a different level in the structure lookup box, you must refresh the style to update the
list.

See Setting up your organizational structure on page 122.

See Managing the home dashboard on page 18.

Reports
In Infor Fashion PLM, you can create reports that focus on specific information about your style, material,
trim, request, or color.

These report types are readily available in the application:

DescriptionReport

Contains style information and style imagesStyle Images

Contains style information and sketchesStyle Sketches

Contains style information and artworksStyle Artwork

Contains the images from the Other section of the Style Images
tab

Style Other Images

Contains style information, images, and sample measurementsSample Measurement

Contains style information, image, measurements, bill of materials
(BOM), and care labels

Style Card

Contains style information, points of measure, construction im-
ages, and measurements

Measurements

Contains style information and the BOM main versionBill of Materials

Contains style information, image, colorways, sales colors, and
a list of materials and trims

Style Colorways

Contains style information and technical drawingsTechnical Drawings

Contains style information, labels & hangtags, and care & content
information

Care & Content

Contains style overview information and statusStyle Status Overview

Contains style information and construction imagesConstructions

Contains style information and measurement imagesMeasurement Images

Contains style information, pattern information, and pattern piecesPattern Sheet

Contains style information, image, main material information,
size information, ownership information, and notes

Style Card (External)
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DescriptionReport

Contains style information, main material information, color infor-
mation, size information, sourcing and price information, owner-
ship information, and notes

Style Card (Internal)

Contains style information and bill of operationsOperation

Contains material information, colors, and commentsLab Dip Request

Contains material information, images, and construction imagesMaterial Card

Contains material overview informationMaterial Overview

Contains trim information and care detailsTrim Card

Contains trim overview informationTrim Overview

Contains request information and comments about the request.Comments Report

Contains color palette informationColor Card

Contains information on line plan items, including images, cate-
gory, collection, price point, size range, and colorways

Line Plan Card View

Contains information on style mappings of line plan items, includ-
ing the main style's image, main style name, retail price, and
colorways

Line Plan Mapped View

The default file format of generated reports in Infor Fashion PLM is *.prnx (Native Format). You can
save the report in these file formats:

• .pdf
• .mht
• .rtf
• .xls
• .xlsx
• .csv
• .txt
• .img
• .xps

Generating reports
You can generate reports of your created records in Style, Material or Trim.

Generating reports for Style, Material, and Trim
1 On the Style, Material, or Trim panel, right-click a record and select Reports > Generate Reports.
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Alternatively, if the style, material, or trim record is open, click the Generate Reports icon.

Note:  You can generate reports using tagged favorites. To generate reports for your tagged report
favorites, right-click a record and select Reports. Select a report favorite from the context menu.

To combine reports for multiple records into a single file, multiselect records while pressing Ctrl on
your keyboard, then right-click any of the selected records and select Reports > Generate Reports
or the report favorite name.

2 Select a report from the applicable reports in the Reports section.

Note:  Each report type focuses on a specific set of item details. Available report types depend on
the module that you selected.

To combine multiple report types into a single file, multiselect report types while pressing Ctrl on
your keyboard, then click OK.

A preview of the report is displayed. You can now save, export, print, or send the report through
email.

3 In the File Properties section, select the path location where the report should be saved.

Global Path
Select this option to use the global file location that is shared with all users of Infor Fashion PLM.

Favorite's Path
This path displayed here is predefined in a report favorite. Select this option to specify a file location
for a report favorite.

Own Path

Select this option to specify your own file location for saving reports.

This section is only visible when generating reports for styles.

4 Optionally, select the Print Preview check box.

5 Click Generate.

Generating reports for Request and Color Palette
1 On the Request or Color Palette panel, right-click a record and select Reports > Generate Reports.

Note:  You can also generate tech pack reports for requests. To generate a tech pack report,
right-click a request and select Generate Request Tech Pack. Click Save.

To combine reports for multiple records into a single file, multiselect records while pressing Ctrl on
your keyboard, then right-click any of the selected records and select Reports > Generate Reports
or Generate Tech Pack.

Request Tech Pack reports are based on the selected reports in the request.

2 Select a report type and click OK.

Note:  Each report type focuses on a specific set of item details. Available report types depend on
the module that you selected.

To combine multiple report types into a single file, multiselect report types while pressing Ctrl on
your keyboard, then click OK.
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A preview of the report is displayed. You can now save, export, print, or send the report through
email.

Generating reports for Line Plan
1 On the Line Plan panel, right-click a record and select Generate Line Plan Report.
2 On the File Properties section, click the ellipsis button to specify a path location to store line plan

reports.

3 Select a report type.

4 Click Generate.

Creating custom report types
You can create and customize report types in Infor Fashion PLM by using Report Designer. Customizing
report types enables you to select information that will be included in the generated report.

1 Select Setup > Reports.

2 Click the New icon.

3 Specify this information:

Modules

Select a module from the list.

The selected module will be associated with the report.

Request Type

Select a request type from the list.

You can define request types in Generic Lookup.

Sub Type

Select a request subtype from the list.

You can define request subtypes in Generic Lookup.

Code

Specify a code.

The code must be unique. Two or more items cannot have the same code.

Name
Specify a name for the report.

Description
specify a brief description.

Sequence
Specify a sequence number.
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Status
Select active or inactive.

Is Private
Select the check box to restrict the availability of the report to other users.

Is Sub Report
Select the check box to make the report available as an embedded report for other reports.

Custom Datasource
Select the check box to specify a data source for the report.
Note:  To view user defined reports that uses custom datasource and are not mapped to a style,
material, or trim, on the Reports panel, right-click any report and select User Defined Reports.

4 Click Launch Report Designer.
5 Customize the new report by using the Reports Designer.

6 Select File > Save to display the Save Report dialog window.

7 Click OK.

8 To return to Infor Fashion PLM, close Report Designer.

Generating custom report types
1 On the Style, Material, or Trim panel, right-click a record and select Reports > Generate Reports.

Note:  To combine reports for multiple records into a single file, multiselect records while pressing
Ctrl on your keyboard, then right-click any of the selected records and select Reports > Generate
Reports.

2 Select a report from the applicable reports in the Reports section.

Note:  Each report type focuses on a specific set of item details. Available report types depend on
the module that you selected.

To combine multiple report types into a single file, multiselect report types while pressing Ctrl on
your keyboard, then click OK.

A preview of the report is displayed. You can now save, export, print, or send the report through
email.

3 Optionally, select the Print Preview check box.

4 Click Generate.

Configuring report settings
In Infor Fashion PLM, you can configure the report generation settings of the application.
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Configure report file settings
1 Select Setup > Reports.

2 Click the Report Generation Settings icon.

3 In the File Properties section, specify the global file location.

In a multi-user setup, the global file location that you specified must be a shared location where all
users of Infor Fashion PLM have read/write access.

Note:  You can specify a different file location for each report favorite that you create. To use a
different file location than the specified location in the Set Global File Location field, clear the Use
Global Path check box. Specify a path location for the report favorite.

4 Verify that PDF is displayed as the default file extension from the list.

5 Click Save.

Set a report favorite
1 In the Report Generation Settings dialog box, click Refresh Reports List.
2 In the Manage Favorites section, specify a favorite name.

3 Select the check box of applicable reports for the report favorite in the Reports List section.

4 Click Set Favorite.

Note:  To tag the report favorite, select the second column corresponding to the Favorite Name.
Tagged report favorites are displayed in the right-click context menu of Reports for report generation.

Techpack Favorite is initially available in Manage Favorites. You can modify or update this favorite
depending on your preferences.

See Generating reports on page 126.

Edit a report favorite
1 In the Report Generation Settings dialog box, select a favorite name in the Manage Favorites section.

2 Select the Edit Mode check box.

3 Select the check box of applicable reports for the report favorite.

4 Click Save.

Delete a report favorite
1 Select a report favorite from the Manage Favorites section of the Report Generation Settings dialog

box.

2 Click Delete.
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Set a report favorite file location
You can use a global path file location or specify a different file location for each report favorite that
you create.

1 In the Report Generation Settings dialog box, specify a global path location in the File Properties
section.

2 Select the Use Global Path check box to store all generated reports in the global path file that you
specified.

To use a different file location for each report favorite, clear the check box and specify a location in
the Set Favorite Path location field.

Tagging reports
You can filter reports that can be used and displayed in creating requests by tagging reports by module,
request type, and subtype.

Note:  You cannot tag and filter system-defined reports. Tagging and filtering reports can only be done
with user-defined reports.

See Creating custom report types on page 128.

1 Select Setup > Reports.

2 To tag a report by module, select a report and click the Modules column.

Select a module from the list.

3 To tag a report by request type, select a report and click the Request Type column.

Select a request type from the list.

You can define request types in Generic Lookup.

4 To tag a report by request subtype, select a report and click the Request Sub Type column.

Select a request subtype from the list.

You can define request types in Generic Lookup.

Exporting a report
1 Select Setup > Reports.

2 Right click a report and select Export.
3 Click the ellipsis button to specify the output path.

4 Optionally, specify a name for the report.

By default, the name is set to ReportCode_ReportName.

5 Click OK.
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Importing a report
1 Select Setup > Reports.

2 Right click a report and select Import.

3 Click the ellipsis button and browse for the report.

4 Select the report and click Open.

5 Click OK.

Generating tech packs
A tech pack is a summary document that contains detailed reports. You can create your own tech
packs for style using a report favorite.

See Generating reports on page 126.

A Request Tech Pack contains a combination of the reports selected in the reports details section of
the request.

To generate a Request Tech Pack, ensure that at least one report in the report details section of a
request is selected.

1 On the Request Panel, right-click a request and select Reports.

2 Select Generate Request Tech Pack.

The tech pack is saved in your local storage.

Note:  The tech packs that you generate are saved in the central file path that you defined for storing
attachments and images in Infor Fashion PLM.

See Configuring attachments and images on page 19.

You can now print or send the tech pack through email.

Status
A status identifies the current standing that a business component has in Infor Fashion PLM.

For example, a business component can have a system-defined status such as “Active” or “Inactive.”

In Infor Fashion PLM, you have the flexibility to define your own statuses.

For example, the status of the business component Trim can be “Active” or “Inactive” by default. You
can then define other statuses for this business component, such as “Pending Approval” and
“Temporary.” You can also define statuses for other business components.

Note:  Some statuses for specific features are defined in Generic Lookup, such as:
• Colorway
• Request
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• Sample Evaluation
• Workflow

You can change the status of a generic lookup item that is currently in use in a record. Inactive items
are disabled for selection in the Style Overview window but are still displayed in the list.

Creating statuses
You can create any user-defined status for a business component.

1 Select Setup > Status.

2 Click the New icon.

3 Specify this information:

Business Component
Select the business component where you want to define the status.

Name
Specify the status name.

Sequence
Specify the sequence number for organizing the status.

Description
Specify a brief description.

Base Status
Specify the base status.

4 Click Save or Save and Close.

Unit of measure
Infor Fashion PLM has the capability to set conversion formulas from one unit of measure (UOM) to
another. This function enables you to specify values in different UOMs in fields across the application
and get the exact converted value for each UOM.

Setting up UOM conversion
1 Click Click here to add a new row.

2 Specify this information:

From UOM
Select a UOM from the list.
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You can define UOMs in Generic Lookup.

Value

Specify the value of the UOM in relation to the new UOM.

For example, if your From UOM is centimeters and your intended To UOM is inches, you may enter
2.54 as the value.

To UOM
Select a UOM from the list.

Equivalent Value

Specify the value of the UOM.

For example, if the UOM that you intend to convert is 2.54 centimeters and the new UOM is inches,
you may enter 1 as the value.

3 Click anywhere on the UOM Conversion panel to save the formula.

4 Click Save and Close.
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Chapter 4: Tracking and planning

When many styles are planned and produced rapidly for a collection or season, losing track of the
status of these products in the process of development. Infor Fashion PLM helps you monitor the
progress of styles, trims, and materials by enabling you to set up a list of tasks and milestones.

Activity
You can create activities in Infor Fashion PLM to specify tasks that must be done to make progress in
developing items.

Creating activities
In Infor Fashion PLM, you can create activities for specific users and roles. Activities can be defined
as parallel, which means that they can all be accomplished at the same time, or sequenced, which
indicates that one activity can be completed before proceeding to work on another.

1 Select Tracking and Planning > Activity.

2 Click the New icon.

3 Specify this information:

Name
Specify an activity name.

Description
Specify a brief description.

Status
Select Active, Inactive, or any user-defined status.

Activity Type

Select an activity type from the list.

You can define activity types in Generic Lookup.

Lead Time
Specify the lead time for the activity.
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Note:  You may set the Lead Time up to four digits.

Work Load
Specify the work load for the activity.

Note:  You may set the Work Load up to four digits.

Buffer
Specify the buffer for the activity.

Role

Select a role from the list.

Default roles in the application include Designer, Technical Designer, Product Specialist, Material
Coordinator, Trim Specialist, and Merchandiser/Buyer.

Available options are based on the roles that you define in the application.

For information on managing roles, see the Planning Application Host Administration Guide.

User

Select a user from the list.

Available options are based on users that are mapped to the selected role.

4 Click Save or Save and Close.

Activity list
You can group activities that are related to each other into activity lists. Creating activity lists enables
you to further organize tasks that must be done into categories.

Activities must be connected to an activity list. Because activities can be classified as parallel or
sequenced, you can further define the sequence by which activities must be accomplished within an
activity list.

Creating activity lists
Before you start creating activity lists, you must create activities.

See Creating activities on page 135.

1 Select Tracking and Planning > Activity List.
2 Click the New icon.

3 Specify this information:

Name
Specify an activity list name.
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Description
Specify a brief description.

Status
Select Active, Inactive, or any user-defined status.

Total Work Load
Displays the total time duration of all activities that you associate to the activity list.

Max Lead Time

Displays the lead time by adding the activity that requires the most number of hours and the offset
(Activity + Buffer).

4 From the Tracking and Planning menu, open the Activity panel and dock it to any side of the main
window.

5 Drag and drop activities from the Activity panel to the Selected Activities section.

6 Click Save or Save and Close.

Milestone
You can identify milestones in developing styles. In Infor Fashion PLM, a milestone is a point in time
in which a particular series of activities and activity lists should be completed.

Creating milestones
Before you start creating milestones, you must create activities and activity lists.

See Creating activities on page 135.

See Creating activity lists on page 136.

1 Select Tracking and Planning > Milestone.

2 Click the New icon.

3 Specify milestone attributes:

Name
Specify a milestone name.

Description
Specify a brief description.

Status
Select Active, Inactive, or any user-defined status.
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4 From the Tracking and Planning menu, open the Activity List panel and dock it to any side of the
main window.

5 Drag and drop activity lists from the Activity List panel to the Selected Activity List section.

6 Click Save or Save and Close.

Critical path
You can monitor the progress in developing styles by setting up critical paths. In Infor Fashion PLM,
a critical path is a series of tasks and milestones for a particular item. A critical path helps you to:

• Set a timeline for tasks
• Review ongoing developments
• Meet goals and deadlines

A critical path is composed of activities, activity lists, and milestones. You can use a critical path to
follow up on styles.

See Following up on styles on page 175.

Creating a critical path
Before you start setting the critical path, you must create activities, activity lists, and milestones.

See these topics for reference:

• Creating activities on page 135
• Creating activity lists on page 136
• Creating milestones on page 137

1 Select Tracking and Planning > Critical Path.

2 Click the New icon.

3 Specify critical path attributes:

Name
Specify a critical path name.

Description
Specify a brief description.

Status
Select Active, Inactive, or any user-defined status.

4 From the Tracking and Planning menu, open the Milestone panel and dock it to any side of the main
window.

5 Drag and drop milestones from the Milestone panel to the Selected Milestones section.
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6 On the Critical path panel, click a milestone and set the due date by selecting a date from the
calendar.

Note:  You must define work days, as well as work capacity and start time for each work day, to
specify the due dates for milestones.

See Configuring critical path settings on page 22.

The start date and end date for activity lists and activities in each milestone are displayed.

Enable the calendar view
A calendar view of your critical path, together with its corresponding milestones, provides you a view
of dates on which activity and milestones must be completed.

1 Select a critical path from the list.

2 Click the Calendar icon on the sidebar.

You can also right-click a critical path and select View Calendar.

Enable the graphical view
A graphical view of the milestones in a critical path provides a glimpse of your progress, as well as the
status of each activity and activity list.

1 Select a critical path from the list.

2 Click the Calendar icon on the sidebar.

You can also right-click the critical path and select View Calendar.

3 On the Calendar panel, double-click a milestone.

The graphical view of the milestone's status appears on the workbench.

Collection plan
Considering budget allocation and quantity requirements is necessary in planning for products effectively.
In Infor Fashion PLM, you can break down budgets and quantities by creating collection plans, which
enable you to monitor the number of products and the cost of creating these products in a given
timeframe. Collection plans also serve as the basis for generating line plans.

Creating collection plans
In Infor Fashion PLM, you can create collection plans to monitor the number and cost of creating
products based on your budget and quantity requirements.
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1 Select Tracking and Planning > Collection Plan.

2 Click the New icon.

3 Specify main information:

Structure
Select an organization level from the list.
Note:  This field is displayed only if you have set up an organizational structure in Infor Fashion
PLM. If you set up an organizational structure, various fields may retrieve and be limited by data
from the organizational structure's data hierarchy.

See Setting up your organizational structure on page 122.

Brand

Select a brand from the list.

You can define brands in Generic Lookup.

Division

Select a division from the list.

You can define divisions in the Generic Lookup.

Season

Select a season from the list.

You can define seasons in Generic Lookup.

Collection

Select a collection from the list.

You can define collections in Generic Lookup.

Collection Plan Name
Specify a name for your collection plan.

Line Plan Name
Specify a name for your line plan.

Description
Specify a brief description.

Status
Select In Concept, For Approval, Operational, or any user-defined status.

Category

Select a category from the list.

You can define product categories in Generic Lookup.

Sub Category

Select a subcategory from the list.

You can define product subcategories in Generic Lookup.
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Sub Sub Category

Select a sub subcategory from the list.

You can define product sub subcategories in Generic Lookup.

Gender

Select a gender from the list.

You can define gender in Generic Lookup.

Theme

Select a theme from the list.

You can define style themes in Generic Lookup.

For example, you can create Formal, Casual, Romantic, or Bohemian as collection themes.

Deliveries

Select a delivery type from the list.

You can define delivery types in Generic Lookup.

User Defined Field 1

Select a user-defined field from the list.

You can define user-defined field types in Generic Lookup.

User Defined Field 2

Select a user-defined field from the list.

You can define user-defined field types in Generic Lookup.

User Defined Field 3

Select a user-defined field from the list.

You can define user-defined field types in Generic Lookup.

User Defined Field 4

Select a user-defined field from the list.

You can define user-defined field types in Generic Lookup.

Country
Select a country or countries from the list.

Region
Select a region or regions from the list. You can define regions in Generic Lookup.

Channel

Select a channel or channels from the list.

You can define channels in Generic Lookup.

Market Field 1

Select a market field or market fields from the list.

You can define market fields in Generic Lookup.
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Market Field 2

Select a market field or market fields from the list.

You can define market fields in Generic Lookup.

Market Field 3

Select a market field or market fields from the list.

You can define market fields in Generic Lookup.

Market Field 4

Select a market field or market fields from the list.

You can define market fields in Generic Lookup.

Market Field 5

Select a market field or market fields from the list.

You can define market fields in Generic Lookup.

4 Specify target/budget information:

Note:  Calculated values are based on Base amounts.

Retail Value
Specify the amount and select a currency.

Retail Value (Base)
Displays the retail value in your base currency.

Whole Sale Value
Specify the amount and select a currency.

Whole Sale Value (Base)
Displays the wholesale value in your base currency.

Cost Value
Specify the amount and select a currency.

Cost Value (Base)
Displays the cost value in your base currency.

Purchase Value

Specify the amount and select a currency.

You can define currencies on the Setup menu.

Purchase Value (Base)
Displays the purchase value in your base currency.

Purchase Unit Price
Specify purchase unit price and select a currency.

Purchase Unit Price (Base)
Displays the purchase unit price in base currency.

Infor Fashion PLM User Guide | 142

 

Tracking and planning



Calculated Purchase Unit Price
Displays the calculated purchase unit price.

Calculated Purchase Unit Price = Purchase Value / Planned Quantity

Retail Margin %
Displays the retail margin percentage.

Retail Margin % = SUM(100*(Retail Value - Wholesale Value) / Retail Value)

Retail Margin Value (Base)
Displays the retail margin value in your base currency.

Retail Margin Value (Base) = SUM(*Retail Value - *Wholesale Value)

Wholesale Margin %
Displays wholesale margin percentage.

Wholesale Margin % = SUM(100*(Wholesale Value - Cost Value) / Wholesale
Value)

Wholesale Margin Value (Base)
Displays wholesale margin value in your base currency.

Wholesale Margin Value (Base) = SUM(Wholesale Value - Cost Value)

Cost Margin %
Displays a cost margin percentage.

Cost Margin Value (Base)
Displays a cost margin value in your base currency.

# of Styles
Specify the number of styles in your collection plan.

# of Styles = # of Carry Overs + # of New Developed Styles

# of Carry Overs
Displays the number of carryover style items in your collection plan.

# of Carry Overs = # of New Styles - # of New Developed Styles

# of New Developed Styles
Specify the number of newly developed styles in your collection plan.

# of Options
Specify the number of options (style/colors) in your collection plan.

Target Quantity
Specify the planned quantity in the collection plan.

5 Specify this information:

Retail Value (Base)
Displays the retail value in your base currency.

Retail Value (Base) = sum of the Retail Value (Base) of all line plan
items mapped to collection plan
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Wholesale Value (Base)
Displays the wholesale value in your base currency.

Wholesale Value (Base) = sum of Wholesale Value (Base) of all line plan
items mapped to collection plan

Cost Value (Base)
Displays the cost value in your base currency.

Cost Value (Base) = sum of Cost Value (Base) of all line plan items mapped
to collection plan

Purchase Value (Base)
Displays the purchase value in your base currency.

Purchase Value (Base) = sum of Purchase Value (Base) of all line plan
items mapped to collection plan

Average Retail Margin %
Displays the average retail margin percentage.

Average Retail Margin % = sum of Margin (Base) / # of line plan items
associated to the collection plan

Average Retail Margin (Base)
Displays the average retail margin in your base currency.

Average Retail Margin (Base) = sum of Margin (Base) / # of line plan items
associated to the collection plan

Average Wholesale Margin %
Displays the average wholesale margin percentage.

Average Wholesale Margin % = sum of Margin (Base) / # of line plan items
associated to the collection plan

Average Wholesale Margin (Base)
Displays the average whole margin in your base currency.

Average Wholesale Margin (Base) = sum of Margin (Base) / # of line plan
items associated to the collection plan

Average Cost Margin %
Displays the average cost margin percentage.

Average Cost Margin % = sum of Margin (Base) / # of line plan items asso
ciated to the collection plan

Average Cost Margin (Base)
Displays the average cost margin in your base currency.

Average Cost Margin (Base) = sum of Margin (Base) / # of line plan items
associated to the collection plan

# of Styles
Displays the actual number of styles that are mapped to associated line plan items.
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Planned # of Options
Displays the number of options associated to the collection plan.

Planned Quantity

Displays the total quantity of line plan items associated to the collection plan.

6 Click Save or Save and Close.

To modify the details of your collection plan, select the Edit icon on the toolbar.

Copying a collection plan
1 Select a collection plan and click Copy.

You can also right-click a collection plan and then select Copy.

2 On the Collection Plan Copy dialog box, specify this information:

Set as Main Line Item
Select to set the collection plan as main line item.
Note:  You can only set a line plan as a main line item if the collection plan that the line plan is
associated to is set as a main line.

Collection Plan Name
Specify a name for the collection plan.

Line Plan Name
Specify a name for the line plan.

Season
Select a season from the list.

3 Select the attributes that will be included in the copied collection plan.

4 Click OK.

Modifying collection plan details on the Collection Plan panel
1 Click the corresponding cell under the field column of the collection plan record that you will update.

2 Specify the information or select a value from the list.

Note:  Cells under field columns with italicized headers on the Collection Plan panel are not editable.

You cannot modify fields with values that are automatically computed.
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Display the delivery period on the Collection Plan panel or Line Plan
panel
1 On the Collection Plan panel or Line Plan panel, click the Plan Settings icon on the sidebar.

2 Specify this information:

Show Delivery Period
Select to display the delivery period columns on the Collection Plan panel or Line Plan panel.
Note:  If this is selected, the Planned Quantity column on the Collection Plan panel or Line Plan
panel cannot be edited.

Deliveries
Select the deliveries that will be displayed on the Collection Plan panel or Line Plan panel. Each
delivery corresponds to a column.
Note:  The value in the Actual Quantity field will change depending on the deliveries that are
selected.

3 Click Save.

4 To see the delivery period columns on the Collection Plan panel or Line Plan panel, close and then
reopen the Collection Plan panel or Line Plan panel.

5 To specify a quantity per delivery period, click the corresponding cell under the delivery period and
specify a quantity.

Note:  The Planned Quantity field is updated to the sum of the values specified under the delivery
period columns.

6 To tag a collection plan or line plan as a main line, select the Main Line check box that corresponds
to the item.

Importing budget
You can import budget from an external source to Infor Fashion PLM to create line plan records. When
a budget is imported to PLM, corresponding line plans are created containing the values taken from
the external source. If the imported budget contains non-unique values for mandatory fields or for fields
that require unique values, an error message is logged on the Messages module.

Before importing budget, ensure that you meet these prerequisites:

• Specify all necessary information:
• Structure
• Collection Plan
• Description
• Brand
• Season
• Collection
• Status
• Category
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• Sub Category
• Sub Sub Category
• Gender
• Theme
• Deliveries
• User Defined Fields
• Country
• Region
• Channel
• Market Fields
• # of Styles
• # of New Developed Styles
• Planned Quantity
• Purchase Value
• Cost Value
• Cost Currency
• Wholesale Value
• Wholesale Currency
• Retail Value
• Retail Currency

• Save the file in Microsoft Excel (*.csv) format.

1 On your computer, browse for the location of the budget file that you want to import to Infor Fashion
PLM.

2 Drag and drop the budget file from your local folder to the Collection Plan panel.

3 To verify if the budget is successfully imported, go to Actions > Messages.

4 On the Messages panel, select Infor Fashion PLM as Licensed Module and click Refresh.

Generating line plan items
Line plans serve as detailed roadmaps for a particular season, giving designers a clear framework
within which to create a new line. A line plan item is generated from collection plan entries. It serves
as the basis for what styles need to be developed and for what markets, product categories, and delivery
windows. A line plan item also serves as the beginning of assortment planning.

1 On the Collection Plan panel, right-click a collection plan and select Generate Line Plan.

2 To generate line plan items immediately, select Run Now to execute the action.

Optionally, you can also select Schedule for Later and specify a date.

3 Click OK.

4 To verify if the action is successful, select Action > Task Monitor on the main menu.

See “Monitoring Tasks” in the PAH Online Help.
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Creating a line plan item
1 Select Tracking and Planning > Line Plan.

2 Click the New icon.

3 Specify main information:

Collection Plan Name
Displays the collection plan name that is associated to the line plan name that you will select.

Line Plan Name
Select a line plan name.

Structure
Select an organization level from the list.

Brand

Select a brand from the list.

You can define brands in Generic Lookup.

This field is automatically updated based on the selected line plan name and structure.

Division

Select a division from the list.

You can define divisions in Generic Lookup.

This field is automatically updated based on the selected line plan that is generated from a collection
plan.

Season

Select a season from the list.

You can define seasons in Generic Lookup.

This field is automatically updated based on the selected line plan name.

Collection

Select a collection from the list.

You can define collections in Generic Lookup.

This field is automatically updated based on the selected line plan name.

Line Plan item
Specify a line plan item.

Status
Select In Concept, For Approval, Operational, or any user-defined status.

Category

Select a category from the list.

You can define product categories in Generic Lookup.

This field is automatically updated based on the selected line plan name and structure.
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Sub Category

Select a subcategory from the list.

You can define product subcategories in Generic Lookup.

This field is automatically updated based on the selected line plan name and structure.

Sub Sub Category

Select a sub subcategory from the list.

You can define product sub subcategories in Generic Lookup.

This field is automatically updated based on the selected line plan name and structure.

Gender

Select a gender from the list.

You can define gender in Generic Lookup.

This field is automatically updated based on the selected line plan name.

Theme

Select a theme from the list.

You can define style themes in Generic Lookup.

For example, you can create Formal, Casual, Romantic, or Bohemian as collection themes.

Deliveries

Select a delivery type from the list.

You can define delivery types in Generic Lookup.

User Defined Field 1

Select a user-defined field from the list.

You can define user-defined field types in Generic Lookup.

User Defined Field 2

Select a user-defined field from the list.

You can define user-defined field types in Generic Lookup.

User Defined Field 3

Select a user-defined field from the list.

You can define user-defined field types in Generic Lookup.

User Defined Field 4

Select a user-defined field from the list.

You can define user-defined field types in Generic Lookup.

Country
Select a country or countries from the list.

Region
Select a region or regions from the list.

Infor Fashion PLM User Guide | 149

 

Tracking and planning



You can define regions in Generic Lookup.

Channel

Select a channel or channels from the list.

You can define channels in Generic Lookup.

Market Field 1

Select a market field or market fields from the list.

You can define market fields in Generic Lookup.

Market Field 2

Select a market field or market fields from the list.

You can define market fields in Generic Lookup.

Market Field 3

Select a market field or market fields from the list.

You can define market fields in Generic Lookup.

Market Field 4

Select a market field or market fields from the list.

You can define market fields in Generic Lookup.

Market Field 5

Select a market field or market fields from the list.

You can define market fields in Generic Lookup.

4 Specify target/budget information:

Price Point
Specify the amount and select a currency.

Retail Value (Base)
Displays the retail value in your base currency.

Whole Sale Value (Base)
Displays the wholesale value in your base currency.

Wholesale Value (Base) = Retail Value (Base) * (1 - Retail Margin % /
100)

Cost Value (Base)
Displays the cost value in your base currency.

Cost Value (Base) = Wholesale Value (Base) * (1- Retail Margin % / 100)

Purchase Value (Base)
Displays the purchase value in your base currency.

Purchase Value (Base) = Cost Value (Base) * (1- Cost Margin % / 100)
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Purchase Unit Price
Specify purchase unit price and select a currency.

Purchase Unit Price (Base)
Displays the purchase unit price in base currency.

Calculated Purchase Unit Price
Displays the calculated purchase unit price.

Calculated Purchase Unit Price = Purchase Value / Planned Quantity

Retail Margin %
Specify a retail margin percentage.

Retail Margin Value (Base)
Displays the retail margin value in your base currency.

Retail Margin Value (Base) = (Retail Margin % / 100) * Retail (Base)

Wholesale Margin %
Specify a wholesale margin percentage.

Wholesale Margin Value (Base)
Displays wholesale margin value in your base currency.

Wholesale Margin Value (Base) = (Wholesale Margin % / 100) * Wholesale
Value (Base)

Cost Margin %
Specify a cost margin percentage.

Cost Margin Value (Base)
Displays a cost margin value in your base currency.

Cost Margin Value (Base) = (Cost Margin % / 100) * Cost Value (Base)

# of Mapped Styles
Displays the actual number of styles that are mapped to the line plan item.

# of Options
Specify the number of options (style/colors) in your collection plan.

Quantity
Specify the planned quantity in the collection plan.

Notes
Provide remarks or comments about the line plan item.

5 Click Save or Save and Close.
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Editing line plan items
1 On the Collection Plan panel, right-click a collection plan and select View Line Plan.

2 Select a line plan item and click the Edit icon.

Note:  You can also modify line plan details on the Line Plan panel. Cells under field columns with
italicized headers on the Line Plan panel are not editable.

3 Specify main information:

Note:  If the line plan item is created by using the generate line plan function in the Collection Plan
panel, the line plan item fields with selected values from the collection plan becomes uneditable.

For multiselect fields, if the line plan item is created by using the generate line plan function in the
Collection Plan panel and values for the fields are already selected on the collection plan, the
available options on the lists are only those that are selected on the collection plan. If no values are
selected for the fields on the collection plan, all available options are displayed on the lists.

Collection Plan Name
Displays the collection plan name that is associated to the line plan name that you will select.

Line Plan Name
Select a line plan name.

Structure
Select an organization level from the list.

Brand

Select a brand from the list.

You can define brands in Generic Lookup.

Division

Select a division from the list.

Season

Select a season from the list.

You can define seasons in Generic Lookup.

Collection

Select a collection from the list.

You can define collections in Generic Lookup.

Line Plan Item
Specify a line plan item.

Status
Select In Concept, For Approval, Operational, or any user-defined status.

Category

Select a category from the list.

You can define product categories in Generic Lookup.
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Sub Category

Select a subcategory from the list.

You can define product subcategories in Generic Lookup.

Sub Sub Category

Select a sub subcategory from the list.

You can define product sub subcategories in Generic Lookup.

Gender

Select a gender from the list.

You can define gender in Generic Lookup.

Theme

Select a theme from the list.

You can define style themes in Generic Lookup.

For example, you can create Formal, Casual, Romantic, or Bohemian as collection themes.

Deliveries

Select a delivery type from the list.

You can define delivery types in Generic Lookup.

User Defined Field 1

Select a user-defined field from the list.

You can define user-defined field types in Generic Lookup.

User Defined Field 2

Select a user-defined field from the list.

You can define user-defined field types in Generic Lookup.

User Defined Field 3

Select a user-defined field from the list.

You can define user-defined field types in Generic Lookup.

User Defined Field 4

Select a user-defined field from the list.

You can define user-defined field types in Generic Lookup.

Country
Select a country or countries from the list.

Region
Select a region or regions from the list.

You can define regions in Generic Lookup.

Channel

Select a channel or channels from the list.
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You can define channels in Generic Lookup.

Market Field 1

Select a market field or market fields from the list.

You can define market fields in Generic Lookup.

Market Field 2

Select a market field or market fields from the list.

You can define market fields in Generic Lookup.

Market Field 3

Select a market field or market fields from the list.

You can define market fields in Generic Lookup.

Market Field 4

Select a market field or market fields from the list.

You can define market fields in Generic Lookup.

Market Field 5

Select a market field or market fields from the list.

You can define market fields in Generic Lookup.

4 Specify target/budget information:

Price Point
Specify the amount and select a currency.

Retail Value (Base)
Displays the retail value in your base currency.

Whole Sale Value (Base)
Displays the wholesale value in your base currency.

Cost Value (Base)
Displays the cost value in your base currency.

Purchase Value (Base)
Displays the purchase value in your base currency.

Purchase Unit Price
Specify purchase unit price and select a currency.

Purchase Unit Price (Base)
Displays the purchase unit price in base currency.

Calculated Purchase Unit Price
Displays the calculated purchase unit price.

Calculated Purchase Unit Price = Purchase Value / Planned Quantity
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Retail Margin %
Specify a retail margin percentage.

Retail Margin Value (Base)
Displays the retail margin value in your base currency.

Retail Margin Value (Base) = (Retail Margin % / 100) * Retail (Base)

Wholesale Margin %
Specify a wholesale margin percentage.

Wholesale Margin Value (Base)
Displays wholesale margin value in your base currency.

Wholesale Margin Value (Base) = (Wholesale Margin % / 100) * Wholesale
Value (Base)

Cost Margin %
Specify a cost margin percentage.

Cost Margin Value (Base)
Displays a cost margin value in your base currency.

# of Mapped Styles
Displays the actual number of styles that are mapped to the line plan item.

# of Options
Specify the number of options (style/colors) in your collection plan.

Quantity
Specify the planned quantity in the collection plan.

Notes
Provide remarks or comments about the line plan item.

5 Click Save or Save and Close.

Filtering line plans
1 On the Collection Plan panel, right-click a collection plan and select View Line Plan.

2 Click the Line Plan View Filter icon on the toolbar.

3 Specify this information:

Brand
Select a brand from the list.

Season
Select a season from the list.

Collection
Select a collection from the list.
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Status
Select a status from the list.

Category
Select a category from the list.

Sub Category
Select a subcategory from the list.

Sub Sub Category
Select a sub subcategory from the list.

Gender
Select a gender from the list.

Theme
Select a theme from the list.

4 Optionally, set your filter as favorites and click Set as Favorite.

Setting favorites enables you to save your custom filter and use them repeatedly.

5 Click Execute.

To tag a line plan as a main line, on the Line Plan View panel, select the Main Line check box that
corresponds to the line plan item.

Associating styles to a line plan item
Line plans serve as frameworks from which you can develop and monitor styles. They also serve as
the start of continuous initial assortment. To map styles to your line plan, you can:

• Create new styles
• Map existing styles

Create styles from a line plan
Note:  When creating styles from a line plan, the line plan item's field values and attributes such as
colors, sizes, images, and supplier are copied to the newly created style.

1 On the Line Plan View panel, right-click a line plan and select Style > Create New Styles.

2 Specify style information.

See Creating styles on page 160.

Note:  The first style that you created or added in a line plan is automatically set as the default main
style. If you dragged multiple styles to a line plan, then the first style on the list is set as the default
main style. To set a different style as the main style, right-click the style and select Set as Main
Style or select the corresponding column before the Code column. A green dot is displayed to identify
the main style.
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Map existing styles to a line plan
Note:  When mapping existing styles to a line plan, only the line plan item's attributes such as colors,
sizes, images, and supplier are copied to the mapped styles.

1 From the main menu, open the Style panel and dock it to any side of the main window.

2 From the Style panel, drag and drop styles to a line plan.

3 To view mapped styles to a line plan, right-click a line plan and select Style > View Mapped Styles.

Note:  The first style that you created or added in a line plan is automatically set as the default main
style. If you dragged multiple styles to a line plan, then the first style on the list is set as the default
main style. To set a different style as the main style, right-click the style and select Set as Main
Style or select the corresponding column before the Code column. A green dot is displayed to identify
the main style.

Assigning sizes to a line plan
1 Select Basics > Size Range and dock the Size Range panel to any side of the main window.

2 From the Size Range panel, drag and drop sizes to a line plan.

3 To view sizes assigned to a line plan, select a line plan and click the Line Plan/Size Range icon
on the sidebar.

Assigning colorways to a line plan
1 Select Basics > Color and dock the Color panel to any side of the main window..

You can also open the Color Palette panel.

2 From the Color panel, drag and drop colorways to a line plan.

3 To view colorways assigned to a line plan, select a line plan and click the Line Plan/Colorways
icon on the sidebar.

Assigning images to a line plan
1 On your computer, browse for the location of the image that you want to assign to the line plan.

2 Drag and drop the image from your local folder to the line plan.

3 To view images assigned to a line plan, select a line plan and click the Line Plan/Images icon on
the sidebar.
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Comparing line plans
You can compare financial values among line plans by viewing line plan details in a chart.

Compare line plans
1 On the Collection Plan panel, right-click a collection plan and select Line Plan Comparison.

2 On the Line Plan Comparison panel, select one of these views:

• To Line Plan
• To Style
• To Line Plan and Style

Filter group types
1 Click Group Type.

2 Select Show All or select specific group types that you want to display.

Filter columns
1 Hover on Data Headers.

2 To remove columns, drag and drop data filters to the Filter Fields section.

3 To add columns, drag and drop data filters to Column Fields section.
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Chapter 5: Style

A style describes a product based on key features, such as color, size, and characteristic. In Infor
Fashion PLM, you can create a style using various colors, sizes, and characteristics that you defined
at the version level. Using the Style feature, you can also define the costing and ownership information,
as well as add related files, associated to your style.

Know how to use the Style feature in Infor Fashion PLM and learn other related topics.

Managing styles
Styles are the core of product development. You can create a new style by assigning various attributes,
such as colors, sizes, and characteristics, which you define at the version level. In Infor Fashion PLM,
you can create new styles or create styles from existing styles.

Viewing style records
By default, style records in Infor Fashion PLM are displayed in discrete pages. To display the records
in a single list, clear the Enable Paging check box on the display bar.

Enable style records paging
1 Select Basics > Style.

2 On the display bar at the bottom of the screen, select Enable paging.

Note:  Enabling style records paging applies per profile.

By default, the Grid Paging Settings is set to display 25 records per page that are sorted by changed
date in descending order.

Configure grid paging settings
1 On the display bar, click Grid Paging Settings.
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2 Specify this information:

Records per page
Specify the number of records to display per page.

Sort by
Select the default sorting criteria from the list.

Sort direction
Select ascending or descending from the list.

3 Click Save.

Note:  The settings defined on the Grid Paging Settings applies to all users.

Navigate through style record pages
On the display bar, perform these actions:

1 On the page number box, specify a page number.

2 Press Enter.
3 Alternatively, click |<, <, >, and >| to display the first, previous, next, and last page respectively.

Creating styles
1 Select Basics > Style.

2 Click the New icon.

3 Specify main product information:

Structure
Select an organization level from the list.
Note:  This field is displayed only if you have set up an organizational structure in Infor Fashion
PLM. If you have set up an organizational structure and enable it in creating a style, various fields
may retrieve and be limited by data from the organizational structure's data hierarchy.

See Setting up your organizational structure on page 122.

Brand
Select a brand from the list.

You can define brands in Generic Lookup.

Division
Select a division from the list.

You can define divisions in Generic Lookup.

Season
Select a season from the list.

You can define seasons in Generic Lookup.
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Collection
Select a collection from the list.

You can define collections in Generic Lookup.

Style Number

Specify a style number.

The style number serves as the identifying code for your style within the application.

The number should be unique. Two or more items cannot have the same style number.

To generate an ID, click Generate ID on the Style Overview panel.

To configure the ID Generator, see Configuring ID Generator on page 46.

Note:  If the “Style number already exists.” message is displayed when creating a style, it means
that two styles with the same ID exists in the database. The other style may be deleted temporarily
and is stored in the system. When you encounter this message, you can use a different style ID or
permanently delete the other style.

Style Name
Specify a name for your style.

Status
Select In Concept, For Approval, Operational, or any user-defined status.

Category
Select a category from the list.

You can define product categories in Generic Lookup.

Sub Category
Select a subcategory from the list.

You can define product subcategories in Generic Lookup.

Sub Sub Category
Select a sub subcategory from the list.

You can define product sub subcategories in Generic Lookup.

Gender
Select a gender from the list.

You can define gender in Generic Lookup.

Theme

Select a theme from the list.

You can define style themes in Generic Lookup.

For example, you can create “Formal,” “Casual,” “Romantic,” or “Bohemian” as style themes.

Deliveries
Select a delivery type from the list.

You can define delivery types in Generic Lookup.
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Packing
Select a packaging method from the list.

You can define packaging methods in Generic Lookup.

UOM
Select a unit of measure from the list.

Line Plan Name
If this style is mapped to a line plan, this field will display the line plan name.

Country of Origin
Select a country of origin.

4 Specify this information:

Description
Specify a brief description.

HTS Code
Specify the harmonized tariff schedule (HTS) code.

Alt Product Code
Specify an alternate product code.

Item Type
Select an item type.

Template Item
Select Yes or No.
Note:  A template item only serves as a basis for creating styles. It cannot be used and treated as
an actual style.

Discrete Item

Select the check box to mark the style as a discrete item.

You cannot associate style attributes, such as colors, sizes, and images, to a discrete item.

Carryover Item
Select the check box to mark the style as a carryover item.
Note:  To create carryovers for existing styles, right-click a style and select Create Carryover.

Variant Item
Select the check box to make the style as a variant item.
Note:  For existing styles, right-click a style and select Create Variant.

Seasoned Managed
Select the check box to make the style seasoned managed.

Country
Select a country from the list.

Region
Select a region from the list.
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You can define regions in Generic Lookup.

Channel
Select a channel from the list.

You can define channels in Generic Lookup.

Market Field 1
Select a market field from the list.

You can define market fields in Generic Lookup.

Market Field 2
Select a market field from the list.

You can define market fields in Generic Lookup.

Market Field 3
Select a market field from the list.

You can define market fields in Generic Lookup.

Market Field 4
Select a market field from the list.

You can define market fields in Generic Lookup.

Market Field 5
Select a market field from the list.

You can define market fields in Generic Lookup.

Attachments

Drag and drop files from your local computer to this field.

The files attached to this field is displayed as a read-only link in the Attachments section of the
Images tab.

5 To add an image to the style, drag and drop an image from your local folder to the Images section
of the Overview tab.

You can add multiple images to the Overview tab.

Note:  You can add various images to the Images tab of a style.

See Assigning images to a style on page 178.

6 Specify main sourcing information:

Map Values from Costing
Select the check box to map the price values to the costing of the style.

Preferred / Main Supplier

Select a supplier from the list.

The available options are suppliers that you have assigned to the style.

See Assigning sourcing to a style on page 180.

Preferred / Main Supplier Name
Displays the name of your preferred main supplier.
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Agent

Select an agent from the list.

If the preferred/main supplier that you selected has supplier relations with specific agents, you can
only select those specific agents.

Purchase Price

Specify the amount and select a currency.

You can define currencies on the Setup menu.

Note:  You can map a cost element to the purchase price.

See Defining cost element properties on page 62.

Cost Price

Specify the amount and select a currency.

You can define currencies on the Setup menu.

Note:  You can map a cost element to the cost price.

See Defining cost element properties on page 62.

Wholesale Price Margin %
Specify the margin.

Wholesale Price
Specify the amount and select a currency.

Retail Price Margin %
Specify the margin.
Note:  You can map a cost element to the retail price margin.

See Defining cost element properties on page 62.

Retail Price
Specify the retail price and select a currency.
Note:  You can map a cost element to the retail price.

See Defining cost element properties on page 62.

Country of Origin
Select the country of origin.

7 Specify pattern and marker information:

Pattern number
Specify the pattern number.

Pattern Spec #
Specify the pattern specification number.

Marker Spec #
Specify the marker specification number.

8 Specify material information:
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Main Material
Displays the main material that you will use for your style.

Main Material Description
Displays the description of the main material.

Product Material Status
Displays the product status of the material.

Composition
Displays the composition of the material.

Main Material Supplier
Displays the supplier of the main material.
Note:  The Main Material Information section will display details only if you have identified the main
material of the main BOM version for your style on the Bill of Materials tab.

See Managing BOM versions on page 192.

9 Specify ownership information:

Note:  If a user is assigned as an owner and the same user is set to inactive status on the Manage
Users module, the name of the user will still be displayed on the style record unless the ownership
fields of the record is edited. You can edit the ownership information either on the style details page
or on the style panel. If you edit the ownership information on the Style panel, changes are
automatically saved unless you press Esc on your keyboard.

See the PAH Online Help.

Designer
Select a designer from the list.

Technical Designer
Select a technical designer from the list.

Product Specialist
Select a product specialist from the list.

Material Coordinator
Select a material coordinator.

Trim Specialist
Select a trim specialist from the list.

Merchandiser / Buyer
Select a merchandiser/buyer from the list.

10 Specify attribute information:

Colorways
Displays colorways that you have assigned to the style.

See Assigning colorways to a style on page 177.
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Size Range
Displays the range of sizes that you have assigned to the style.

See Assigning sizes to a style on page 176.

Notes
Specify remarks or comments about the style.

11 Specify other information:

User Defined Field 1

Select a user-defined value from the list.

You can define user-defined fields in Generic Lookup

User Defined Field 2

Select a user-defined value from the list.

You can define user-defined fields in Generic Lookup

User Defined Field 3

Select a user-defined value from the list.

You can define user-defined fields in Generic Lookup

User Defined Field 4

Select a user-defined value from the list.

You can define user-defined fields in Generic Lookup

User Defined Field 5

Select a user-defined value from the list.

You can define user-defined fields in Generic Lookup

User Defined Field 6

Select a user-defined value from the list.

You can define user-defined fields in Generic Lookup

User Defined Field 7

Select a user-defined value from the list.

You can define user-defined fields in Generic Lookup

Free Field 1
Specify information that do not fall under any defined field.

Free Field 2
Specify information that do not fall under any defined field.

Free Field 3
Specify information that do not fall under any defined field.

Free Field 4
Specify information that do not fall under any defined field.
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Numeric Value 1
Specify numeric values that are relevant to the style.

Numeric Value 2
Specify numeric values that are relevant to the style.

Date Field 1
Select a date from the calendar.

Date Field 2
Select a date from the calendar.

12 Specify main responsibilities information:

Responsible
Select a user profile from the list.

Creation Date
Displays the date and time when the style was created.

Changed Date
Displays the date and time when the style was last modified.

Changed By
Displays the user profile that last modified the style.

13 Click Save or Save and Close.

Modifying Style Overview layout
For existing style records, you can reorder, regroup, or hide selected fields or groups of fields in the
Style Overview panel by using the Module Designer.

1 Select Basics > Style.

2 Select a style record and click Edit.
3 Click the Module Designer icon found on the sidebar.

4 To create a new layout, click New and specify a layout name.

To edit an existing layout, select a layout on the Available Layouts list.

5 To apply the layout to specific record types, specify this information:

Brand
Select a brand from the list.

Category
Select applicable categories from the list.

6 To apply the layout to specific roles, click Roles and select the roles on the dialog box.

Note:  You must first save the layout to enable the Roles button. To save the layout, click Update.
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7 To enable editing of the selected layout, select Open Edit Mode.

8 Pause on the New items icon on the upper leftmost corner of the Style Overview panel.

9 Drag and drop items to add them to the layout and use the editing tool bar to adjust the position,
height, width, alignment, naming, and spacing of added grouping options in the layout.

10 To edit existing items on the layout, select a field or group and then apply the necessary changes
by using the editing tool bar.

You can also drag and drop fields or groups.

Note:  Do not remove mandatory fields.

11 To save the changes, click Update on the Module Designer pane.

12 To activate the layout, select Active.

Note:  You can activate multiple layouts. Active multiple layouts are unique for each brand and
category combination.

If a user-defined layout is created with the same settings as the default layout, the user-defined
layout will be applied. The default layout cannot be set as Inactive. For each Brand and Category
combination, you can set up duplicate layouts but only one layout can be activated.

13 To stop editing, clear the Open Edit Mode check box.

Editing styles
In Infor Fashion PLM, you have two ways to edit styles: normal mode and locked mode. To edit a style
in normal mode, click the Edit icon on the toolbar or right-click a record and select Edit.

Another way to edit a style is in locked mode. To edit a style in locked mode, open the Style panel.
Right-click a style record and select Edit in Locked Mode.

Editing a record in locked mode opens the details page of a style and enables a search-and-scan field
on the toolbar. By locking styles, you can:

• Browse records seamlessly

Click Previous Record and Next Record to view styles without closing the current style details
page that you are viewing.

• Search for and open records instantly

In the Search field, type the style number of the record that you want to edit and press Enter on
your keyboard. This takes you directly to the details page of the style.

• Maintain a consistent view of tabs and panes

Click any tab on the current style details page and open any pane in the sidebar. When you open
the previous or next record, the style is displayed with the same active tab as the previous style
details page.

Note:  If a user opens a style record that is used by another user, a message is displayed to indicate
that the record is locked and can be viewed in read-only mode.

A read-only mode in a style record disables the user to edit the style information. Editing the Status
column in the style grid is also disabled.
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If a user opens a style that is recently edited by another user, then the record is automatically refreshed
to ensure that the latest updates are included.

If the application closes unexpectedly, the record is locked to the user editing the style. Only the user
that last edited the record can re-open the record by clicking Edit or Lock and Edit to continue editing
the record. The record is then locked from other users.

See Configuring locked record settings on page 32.

Creating a style carryover
You can create carryovers of existing styles and use it for a new season.

1 Select Basics > Style.

2 Right-click the style and select Create Carryover.
3 Specify this information:

Create a new Style with the same Style Number

Select to use the same style number.

If this option is not selected, you must specify a style number on the style details page of the style
carryover or use the ID Generator to generate a style number.

Note:  The last state of this option is remembered. If the check box has been selected from a
previous carryover, this check box is also selected in the next style you intend to carryover. You
may clear this check box if you don't want to create a new style with the same Style number.

New Season

Select a season from the list.

If you use the same style number for the carryover, you must select a season that is different from
the previous styles.

4 On the Style Colorways table, select colors from the list and click OK.

The selected colors will be used on the style carryover.

5 In the details page of the carryover, verify or update the style details.

6 Click Save.

To view the hierarchy of the style carryover, click the Style/Variation icon on the side bar.

Copying styles
1 Select Basics > Style.

2 Open a style and click the Copy icon or right-click a style from the Style grid and select Copy from
the context menu.

3 In the Style Copy dialog box, specify this information:
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Style Number
Specify the style number for the style.
Note:  If this field is disabled for editing, configure your ID generation settings.

See Configuring ID Generator on page 46.

Style Name
Specify a name for the style.

4 Select the attributes to be copied into the style.

5 Click OK.

Deleting styles
The Delete option enables you to remove a style. You can also use the Delete option if you have not
generated SKUs for the style or if you have not used the style for other operations such as purchase
orders or requests.

The Delete Cascade option, on the other hand, enables you to remove a style along with all other
related operations such as the assigned SKU drivers and attributes that you created for the style,
purchase orders, and requests.

Deleted records are temporarily stored in the system. If you create a new record using the temporarily
deleted style ID, the “Style number already exists.” message will be displayed. When you encounter
this message, you can use a different style ID or delete the record permanently.

You can restore or permanently delete records by using the Manage Deleted Records module of Infor
Fashion PLM.

See Managing deleted records on page 36.

1 Right-click a style and select Delete or Delete Cascade.

You can also delete a style by clicking the Delete icon on the toolbar or pressing Delete on your
keyboard.

2 To remove multiple styles simultaneously, multiselect styles while pressing Ctrl on your keyboard.

Creating a size ratio for a style
You can define the target quantity for each size of your style by creating a size ratio. To create a size
ratio for a style, the style record must have at least one color and one size attribute.

1 In the Style panel, right-click a style record and select Size Ratio.

2 Specify this information:

Size Range
Select a size range from the list.

Infor Fashion PLM User Guide | 170

 

Style



Notes
Provide any notes about the size ratio.

3 On the size ratio table, specify a percentage value for the colors that you want to have a size ratio.

Note:  The total percentage of the sizes for each row that you want to have a size ratio must be
equal to 100%.

4 Click Save.

Creating SKUs for a style
A stock-keeping unit (SKU) is a unique identifier for each of the distinct products that can be ordered
from a supplier. An SKU is used to identify a specific product among a list of products. You can create
a style, attach SKU drivers, such as colors, sizes, and characteristics, and generate SKUs.

Note:  To attach characteristics as an SKU driver to a style, you must open the Style/Characteristics
pane and select Yes in the SKU Driver column.

1 In the Style panel, right-click a style record and select Launch SKU.

The Launch SKU dialog window is displayed, showing the details and the number of SKUs that will
be generated based on the SKU drivers attached to the style.

2 To include all SKUs, click Include All.
3 To exclude all SKUs, click Exclude All.
4 To include an SKU, right-click the SKU and select Include.

5 To exclude an SKU, right-click the SKU and select Exclude.

6 Click Save and Close.

Generating multiple SKUs for styles
Before you start generating multiple SKUs for styles, configure style SKU settings to enable scheduled
generation of multiple SKUs for styles.

See Configuring style SKU settings on page 29.

1 In the Style panel, click Generate SKUs.

2 Select Run Now to execute the action immediately.

You can also select Schedule for Later and specify a date.

3 Click OK.
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Creating packs and pre-packs for a style
In Infor Fashion PLM, you can create packs and pre-packs for a style. A pack is a group of products
of one style, in one size. Each pack is sold as one unit. A pre-pack is a group of products of one style,
but in different sizes. Items in a pre-pack can be sold individually. A pre-pack is used as a logistic unit.

Create packs and pre-packs for a style
1 In the Style panel, right-click a style record and select Create Packs & Pre-packs.

2 Specify this information:

Type
Select Pack or Pre-Pack from the list.

Packaging
Specify a packaging.

UOM

Select a unit of measurement from the list.

By default, the UOM defined for the style record is selected.

Notes
Specify any notes about the pack or pre-pack item.

3 On the table, specify the pack or pre-pack details.

Note:  Each row on the table represents one pack or pre-pack.

Specify pack details
1 On the table, specify this information:

Size Range/Size/Characteristic
Displays all size range, size, and characteristic combinations that are available for the style.
Note:  The characteristic is included only if it is set as an SKU driver.

Id
Specify an ID for the pack.

Name
Specify a name for the pack.

Color

Specify the number of items per applicable color that is available for the style.

Items with values are included in the pack for the selected record.

Available colors depend on the colorways of the style record.
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Total
Displays the total number of items in a pack.

2 Click Save.

Specify pre-pack details
1 On the table, specify this information:

Color/Characteristic

Displays all color and characteristic combinations that are available for the style.

Available colors are based on the colorways that are assigned to the style.

See Assigning colorways to a style on page 177.

Note:  The characteristic is included only if it is set as an SKU driver.

Id
Specify an ID for the pre-pack.

Name
Specify a name for the pre-pack.

Size range/Size combination columns

Specify the number of items per applicable size range, size, and characteristic combination that is
available for the style.

Items with values are included in the pre-pack for the selected record.

Total
Displays the total number of items in a pre-pack.

2 Click Save.

View the packs and pre-packs for a style
1 Select the style record.

2 On the sidebar, select the Pack icon.

Note:  You can update the pack or pre-pack information, including item numbers, on the Packs &
Pre-packs pane.

After editing an information, press Enter to save the update. To delete a pack or pre-pack, right-click
the pack or pre-pack and then select Delete.
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Adding comments to a style
You can post comments to existing style records, and reply to comments from other users, within Infor
Fashion PLM. Depending on authorities included in your user role, you can also edit and delete
comments. The most recent comments posted across the application will be displayed in the Latest
Comments widget on the home dashboard.

Comments can also be displayed through the List Comment view. This view opens as a new window
and shows all comments in a list format, with the most recent comments on top. The content of this
list depends on the current tab. The List Comment view can show the Context and Hierarchy tabs.

1 On the Style panel, select a record and click the Style/Comments icon found on the sidebar.

2 Specify your comment in the given field.

3 Click Post.
4 Optionally, to update the comments, click the Refresh icon.

Note:  You can add comments on every tab of a style details page.

To add comments that are specific to a tab, open the style details page. Select a tab and click the
Style/Comments icon.

Attach files to a comment
1 From your local computer, drag and drop a file to the Attachment field of a comment.

• If the file that you have attached is an image, a thumbnail of that image is displayed.
• If the file that you have attached is not an image, the Attachment field is updated with the number

of files in the comment.

2 Optionally, to view multiple images attached to a comment, click an image and use the arrow buttons
on your keyboard.

3 Optionally, to view nonimage attachments to a comment, click the Attachment field and select the
file that you want to view.

Note:  You can edit attachments to a comment and save your changes in Infor Fashion PLM. Before
editing attachments, click Refresh in the Comments pane.

4 Optionally, to delete an image, right-click a thumbnail and select Delete.

5 Optionally, to delete nonimage attachments, double-click the Attachment field.

Select the check box of the file and click the Delete icon.

Reply to a comment
1 Select a comment and click Reply.

2 Specify your comment in the given field.

3 Click Post Reply.
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Search for a comment
1 Click the Search icon in the Comments pane.

You can also select a comment and press Ctrl+F on your keyboard.

2 Specify a keyword to display comments containing that keyword.

View the comment hierarchy
1 In the Style/Comments pane, click the Hierarchy tab.

2 To view comments and replies to comments on a particular tab, expand the hierarchy view by clicking
the drop-down arrow.

Viewing style history
The History tab on the style details page displays all modifications that users make to the style record.
The specific change, the user who made the change, and the date of the change are displayed in
chronological order.

To configure history settings, see Configuring history settings on page 25.

Following up on styles
You can follow up on the progress in developing styles by using critical paths. Identifying the critical
path for a style enables you to monitor the status of activities related to its development and track
deadlines.

1 From the main menu, open the Style and Critical Path panels.

Dock one panel to any side of the main window.

2 Drag and drop critical paths to a style record.

3 To verify that the critical path has been associated to the style, select the style record and click the
Style/Follow Up icon on the sidebar.

In the Style/Follow Up pane, you can view the critical paths, together with their associated milestones,
activity lists, and activities.

You can also scroll into the Style panel, to view the Critical Path column for a style record.

To remove a critical path from a style, right-click the critical path on the Style/Follow Up pane and
select Delete or press Delete on your keyboard.
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Setting the progress of activities
You can specify the progress status for each activity in a critical path by clicking one of these statuses
in the Style/Follow Up pane:

• Not Started
• In Progress
• Completed

When you specify the progress status of each activity, the activity lists and corresponding milestones
are also updated.

Defining style attributes
Style attributes pertain to properties or features that define a style. In Infor Fashion PLM, style attributes
include:

• Sizes
• Colorways
• Images
• Characteristics
• Sourcing

Note:  You cannot define attributes if the style is already set to Operational.

Assigning sizes to a style
You can retrieve your defined sizes and assign them to a style. You can define various sizes using the
Size feature.

Before you start assigning sizes to a style, you must first define sizes and styles.

See Creating sizes on page 92.

See Creating styles on page 160.

1 From the main menu, open the Size Range panel and dock it to any side of the main window.

2 On the Style panel, open a style details page and click the Sizes tab.

3 From the Size Range panel, drag and drop a size range to the Sizes tab of the style record.

The size ranges are displayed on the Sizes tab.

Note:  You can also drag and drop size ranges to a style in the Style Overview panel, and in the
Style/Sizes pane of a style.

4 Click Save.

Note:  For new sizes and size range that are added, you must first save your settings before it can
be reflected in the Measurements tab.
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To view sizes assigned to a style, select a style record from the Style panel and click the Style/Sizes
icon on the sidebar.

To change the status of a size to active or inactive, right-click a size on the Style/Size pane and
select Change Status. Change Status applies per style record. To change the status of multiple
sizes simultaneously, multiselect sizes while pressing Ctrl on your keyboard.

You cannot set a size to inactive if the size is used in other modules such as SKUs, size ratio, packs,
measurement, and request.

To remove a size assigned to a style, go to the Size tab of the style record. Select a size and click
the Delete icon. Alternatively, you can remove sizes through the Style/Sizes pane.

If a multidimensional size has measurements, deleting the size from a style is disabled to avoid
errors in calculation of measurements.

Assigning colorways to a style
Colorways pertain to colors or color palettes used to create a style, material, or trim. Colorways are
necessary in creating a style’s bill of materials (BOM) and computing costs. In Infor Fashion PLM, you
can define colorways in three ways:

• Color

Used for styles, materials, and trims that use a single color.

• Combination color

Used for styles, materials, and trims that use two or more colors. Combination colors can be used
when the sales colors of a style consist of more than one color.

• Print

Used for styles, materials, and trims that use single or combination color. The image is displayed
in the Color Content column.

Single color, combination colors, and prints can be added to a style from the Color and Color Palette
panels.

You can assign colorways to a style by adding colors and color palettes through:

• The Style panel
• The Bill of Materials (BOM) tab
• The Colorways tab of the style details page

Assign colorways to a style through the Style panel
Before you start assigning colorways to a style, you must first define colors, color palettes, and styles.

See these links for reference:

• Creating colors on page 52
• Creating color palettes on page 58
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• Creating styles on page 160

1 From the main menu, open the Color Overview panel and dock it to any side of the main window.

Note:  You can also open the Color Palette Overview panel.

2 On the Style panel, open a style details page and click the Colorways tab.

3 From the Color Overview panel, drag and drop a colorway to the Colorways tab of the style record.

4 To set a colorway as the main color, select a colorway and click the cell before the Color column.

A main color is used as the default color in sample requests.

A green mark appears on the cell, identifying the colorway as the main color.

Note:  You can also drag and drop colorways to a style on the Style panel and in the Style/Colorways
pane of a style. Optionally, you can add or link the colorway to the color library. Right-click a colorway
and select Add to Library to add on-the-fly colors to the color library.

To update the color information in style to sync with the color library information, right-click a colorway
and select Link to Library.

To view colorways assigned to a style, select a style record from Style and click the Style/Colorways
icon on the sidebar.

To remove a colorway assigned to a style, go to the Colorway tab of the style record. Right-click a
colorway and select Delete or remove the colorway through the Style/Colorways pane.

You can also assign color palettes to a style. Open the Color Palette panel from the Basics menu
and perform the same steps.

Assign colorways to a style through the BOM tab
1 On the BOM tab, right-click any column header and select Show Color Basket.
2 Open the Color Overview panel and dock it to any side of the main window.

Note:  Alternatively, you can open the Color Palette panel and assign color palettes to a style.

3 From the Color Overview panel, drag and drop a colorway to the new Color column on the BOM
tab.

To view colorways assigned to a style, click the Style/Colorways icon on the sidebar.

To remove a colorway assigned to a style, go to the Colorway tab of the style record. Select a
colorway and click the Delete icon. Alternatively, you can remove colorways through the
Style/Colorways pane.

Assigning images to a style
You can assign various images to styles to represent your product graphically. With this feature, you
can:

• Add one or more images to a style.
• Set one image as the default image for your style.
• Magnify the display of an image by hovering your cursor on the image.
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You can classify images that you add to a style into these categories:

• Style images
• Sketches
• Construction
• Technical drawings
• Colorways
• Artworks
• Patterns
• Others

1 On your computer, browse for the location of the image that you want to assign to the style.

Note:  If your image folder is maximized, click Restore Down to float the window.

2 Drag and drop the image from your local folder to the Images tab of the style details page.

3 Optionally, to select your view of the images, select the Thumbnail or the Details icon.

4 Optionally, specify a name for the image and add notes.

5 To include the image when generating reports for the style, select the Report Image check box.

You can assign multiple images at once to a style by selecting multiple images and dragging them
to a style. The first image you select is automatically set as the default image. To set another image
as default image, right-click another image file. You can also rearrange images by dragging and
dropping related images beside each other.

To remove an image assigned to a style, right-click the image and select Delete. You can also press
Delete on your keyboard. The deleted image is automatically removed from the Images tab of the
style record under Pattern. Alternatively, you can remove images through the Style/Images pane.

Assigning characteristics to a style
You can retrieve your defined characteristics and assign them to a style. You can define various
characteristics using the Characteristics feature and store them in a repository for later use.

Before you start assigning characteristics to a style, you must first define characteristics and styles.

See Creating characteristics on page 50.

See Creating styles on page 160.

1 From the main menu, open the Characteristic panel and dock it to any side of the main window.

2 From the Characteristic panel, drag and drop a characteristic to a style record in Style.

Note:  You can only drag and drop characteristics that have Style as the characteristic type.

3 Optionally, on the Style/Characteristics pane, select Yes to make the characteristic an SKU driver.

Note:  If the style is defined as a discrete item, you cannot make the characteristic an SKU driver.

4 Click Save or Save and Close.

To view characteristics assigned to a style, select a style record from Style and click the
Style/Characteristics icon on the sidebar.
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To remove a characteristic from a style, open the Style/Characteristic pane. Select a characteristic
and click the Delete icon. You can also right-click the characteristic and select Delete.

Assigning dictionary items to a style
You can retrieve your defined dictionary items and assign them to a style. You can define various
dictionary items by using the Dictionary feature.

Before you start assigning dictionary items to a style, you must first define dictionary items and styles.

Note:  Only dictionary items with an Active status can be assigned to a style.

1 From the main menu, open the Dictionary panel and dock it to any side of the main window.

2 On the Style panel, open a style and click the Overview 2 tab.

3 On the Overview 2 tab, select the list to view all dictionary items, or specify a search keyword to
narrow the list.

4 Select a dictionary item to assign it to the style.

5 Click Save or Save and Close.

Note:  Alternatively, you can assign dictionary items to a style by dragging and dropping items from
the Dictionary panel to the Overview 2 tab of a style.

Assigning sourcing to a style
In Infor Fashion PLM, you can identify a sourcing location or multiple sourcing locations of a style.

Before assigning sourcing to a style, you must first define sourcing locations and styles.

See Defining sourcing locations on page 95.

See Creating styles on page 160.

1 From the main menu, open the Sourcing panel and dock it to any side of the main window.

2 From the Sourcing panel, drag and drop a sourcing record to a style record in the Style panel.

To assign multiple sourcing records to a style simultaneously, select two or more sourcing records
while pressing Ctrl on your keyboard. Drag and drop the sourcing records to a style record in the
Style panel.

3 To view assigned suppliers to a style, open the style item and click the Style/Sourcing icon on the
sidebar or right click a style record on the Style panel and select Sourcing.

Note:  You can also assign sourcing to a style by dragging and dropping a sourcing record to the
Style/Sourcing pane of a style item.

4 Optionally, to set the preferred/main supplier for a style item, right-click a supplier in the Style/Sourcing
pane and select Set as Main Supplier.
Note:  You can also set the Preferred/Main Supplier on the Overview tab of the style details page
under Main Sourcing Information section.
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5 Optionally, to enable a supplier to view details of the style item in Partner Collaboration, select the
Share to Partner check box in the Style/Sourcing pane.

Defining bill of materials (BOMs)
A bill of materials (BOM) is a list of all components that you use to create a style. Defining the BOM
for your style enables you to identify all the materials you need and calculate the cost of creating your
style. BOMs are also used in creating requests for sampling.

You can define a bill of materials for your style by:

• Adding items from Material and Trim
• Creating items in the BOM tab

Adding items from Style, Material, and Trim
By default, style, material, or trim records that have been added on the style's BOM page are not
automatically updated when changes are made on the same records in the Style, Material, or Trim
panels. Configuring the BOM details update settings enables Infor Fashion PLM to synchronize records
added on a style's BOM page and the actual material and trim records.

See Configuring BOM details update settings on page 30.

1 Open the Style, Material, and Trim panels.

Float the windows and dock them to any side of the main window for side-by-side viewing.

2 Drag and drop items from Style, Material, and Trim to the BOM details panel.

Note:  To add multiple styles, materials, or trims simultaneously, select two or more items while
pressing Ctrl on your keyboard.

3 Specify this information:

CI

Select the check box to mark the BOM item as a cost indicator (CI).

A BOM item that you mark as a cost indicator will be included in the computation of the style's
costing.

Note:  This enables you to map the item to a cost element.

See Defining cost element properties on page 62.

Seq #
Optionally, modify the sequence of BOM items.

Sequencing sorts BOM items for viewing. To modify the sequence of BOM items:

• Select a sequence number from the list.
• Type a sequence number in the Seq # field.
• Drag and drop BOM items.
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Note:  You can rearrange the BOM items in descending or ascending order by clicking the arrow
in the Seq # column.

Number
Displays the item number.

Name
Displays the name of the BOM item.

Description

Displays the description of the item.

You can edit the existing description or provide a new one by clicking the description cell.

C&C
Select the check box to enable the care and content option of the item.

Notes
Specify any notes about the BOM item.

Component Type
Displays the component type of the item.

Main Category
Displays the main category of the item.

Category Group
Displays the category group of the item.

Category
Displays the category type of the item.

Image
Add an image by dragging and dropping an image from your local computer to the image cell.
Note:  Click Save before adding an image. You cannot add an image to the BOM item without
saving the item first.

Placement

Select a placement from the list.

You can define placements in Generic Lookup.

Composition

Displays the composition of the BOM item that you have defined in the material or trim details page.
If you have not yet specified this information, you can type the composition in this field.

Note:  If the material used has layers, the composition is formatted in BOM this way, for example:

Facing: 80% Nylon, 20% Lycra; Backing: 100% Cow

It will be grouped by layer where the order of the layer is based on the order of the components
from 1-7. This new display applies to the Material grid overview, Style Overview tab - Main Material
information and Style BOM tab.

Infor Fashion PLM User Guide | 182

 

Style



Certificate
Displays the certificate of the BOM item that you have defined in the material or trim details page.

Critical Material
Select Yes or No to identify whether the item is a critical material.

Chemical Warning

Select Yes or No to identify whether the item contains chemicals that require extra care in handling.

Style Size Range

Displays the size range that you assigned to the BOM item.

To assign a style size range, open the Style/Size pane. Drag and drop a size range from the Size
pane to the Style Size Range cell.

Style Size Code

Displays the size code that you assigned to the BOM item.

To assign a style size code, open the Style/Size pane. Drag and drop a size from the Size pane to
the Style Size Code cell.

Style Size Characteristic

Select a style size characteristic from the list.

The list of style size characteristic is based on the style size code that is added to the BOM item.

Note:  If you select a component size range for a BOM item, the Style Size Code field will be
cleared. If you clear the Component Size Range field, the Style Size Range and Style Size Code
fields will be cleared.

Component Size Range

Displays the component size range.

To assign the component size range, open the Style/Size pane. Drag and drop a size range from
the Size pane to the Component Size Range cell.

Note:  This field only applies to trims as BOM items.

Component Size Code
Displays the component size code.

Colors

Assign colors to a BOM item by dragging and dropping colors from the Color panel on the Basics
menu.

You can also right-click a BOM item and select Colorways to assign color to a BOM item, then
drag and drop colors from the Colorways pane.

Additionally, you can also right click a BOM item and select Add Sales Color to assign color to a
BOM item.

Alternatively, select the color cell and click the arrow down button to add a new color or to search
for an existing color.
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Note:  BOM item colorways can be restricted. If the BOM item colorway restriction is applied to a
Style, Material, or Trim, only the colors that are available in the colorway of the selected item will
apply.

See Configuring color settings on page 22.

Supplier

Displays the preferred/main supplier that you have identified in the material or trim details page.

If you have not yet identified a preferred/main supplier, open Sourcing by going to Basics >
Sourcing, and then drag and drop a supplier from the Sourcing pane to the BOM item. You can
also type a supplier name in the field.

Status

Displays the status of the BOM item.

You can update the status by selecting an option from the list.

Quantity Type
Select a quantity type from the list.

Quantity
Specify the quantity.
Note:  If Quantity Type is set to Size Dependent, the value on the Quantity field becomes clickable.
If you click the quantity link, the BOM Line Size Quantity pane is displayed. The available sizes for
the BOM item are displayed on the pane. You can set the quantity for each size.

Quantity UOM

Select a unit of measurement (UOM) for the quantity.

UOMs can be defined in Generic Lookup.

Cost Price

Displays the cost price of the BOM item.

If the cost price for the BOM item is not yet defined, you can specify a price in the BOM item line.

Waste %

Displays the waste percent of the BOM item.

If the waste percent for the BOM item is not yet defined, you can specify a waste percent in the
BOM item line.

Waste Qty

Displays the waste quantity of the BOM item.

If the waste quantity for the BOM item is not yet defined, you can specify a waste quantity in the
BOM item line.

Gross Qty

Displays the gross quantity of the BOM item.

If the gross quantity for the BOM item is not yet defined, you can specify a gross quantity in the
BOM item line.
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Cost Price (Base)

Displays the cost price of the BOM item in your base currency.

Total Gross Cost Price (Base)

Displays the total gross cost price of the BOM item in your base currency.

Total Cost Price

Displays the total cost price of the BOM item in based on the Currency.

Currency

Displays the currency for the purchase price.

If the currency for the purchase price is not yet defined, you can select a currency from the list.

Purchase Price

Displays the purchase price of the BOM item.

If the purchase price for the BOM item is not yet defined, you can specify a price in the BOM item
line.

Purchase Price (Base)
Displays the purchase price in your base currency.

Total Purchase Price

Displays the total purchase price based on the quantity and purchase price of the BOM item.

Total Purchase Price (Base)
Displays the total purchase price in your base currency.

Attachments
Displays the number of attachments associated to the BOM item.

Construction

Displays the construction of the BOM item.

Optionally, specify the construction of the BOM item.

Weight
Displays the weight of the BOM item.

Optionally, specify the weight of the BOM item.

Weight UOM

Displays the weight unit of measurement of the BOM item.

Optionally, select a weight unit of measurement from the list.

Finish

Displays the finish of the BOM item.

Optionally, specify the finish of the BOM item.

Fiber Content
Specify the fiber content of the BOM item.
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User Defined 1

Specify a value for this field.

You can create user-defined fields in Generic Lookup.

User Defined 2

Specify a value for this field.

You can create user-defined fields in Generic Lookup.

User Defined 3

Specify a value for this field.

You can create user-defined fields in Generic Lookup.

User Defined 4

Specify a value for this field.

You can create user-defined fields in Generic Lookup.

Part
Specify the part where the BOM item is applicable.

Free Field 1

Provides you the flexibility to add details to your BOM that do not fall under any defined column.

Free Field 2

Provides you the flexibility to add details to your BOM that do not fall under any defined column.

Free Field 3

Provides you the flexibility to add details to your BOM that do not fall under any defined column.

4 To add notes about the BOM, specify your comments in the Notes section.

5 Click Save or Save and Close.

To remove BOM items, right-click an item and select Delete.

To remove multiple BOM items simultaneously, select two or more items while pressing Ctrl on
your keyboard, right-click, and select Delete.

You can also click the Delete icon on the toolbar.

Creating items on the BOM tab
Creating BOM items on the BOM tab provides you the flexibility to identify items for your style that are
not in Material and Trim.

Note:  To manually create items on the BOM tab, your account must have a Style BOM (On the fly)
authority.

See “Managing roles” in the PAH Online Help.

1 On the style details page, click the BOM tab to display the BOM Details panel.
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2 Specify this information:

CI

Select the check box to mark the BOM item as a cost indicator (CI).

A BOM item that you mark as a cost indicator will be included in the computation of the style's
costing.

This will also include the BOM item's costs in the computation of totals.

Note:  This enables you to map the item to a cost element.

See Defining cost element properties on page 62.

Seq #
Optionally, modify the sequence of BOM items.

Sequencing sorts BOM items for viewing. To modify the sequence of BOM items:

• Select a sequence number from the list.
• Type a sequence number in the Seq # field.
• Drag and drop BOM items.

Note:  You can rearrange the BOM items only when the BOM version has been saved.

You can rearrange the BOM items in descending or ascending order by clicking the arrow in the
Seq # column.

Number

Select a style, material, or trim item from the list.

All information about the selected record will be added to the BOM line.

Name
Specify a name for your item.

Description

Specify a description.

C&C
Select the check box to enable the care and content option of the item.

Notes
Specify any notes about the item.

Component Type
Select a component type from the list.

Main Category

Select a main category from the list.

Available main categories depend on the component type of the BOM item.

Category Group

Select a category group from the list.

Available category groups depend on the component type of the BOM item.
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Category

Select an item category from the list.

Available categories depend on the component type of the BOM item.

Image
Add an image by dragging and dropping an image from your local computer to the image cell.
Note:  Click Save before adding an image. You cannot add an image to the BOM item without
saving the item first.

Placement

Select a placement from the list.

Composition
Specify the composition of the BOM item.

Certificate
Specify the certificate of the BOM item.

Critical Material
Select Yes or No to identify whether the item is a critical material.

Chemical Warning

Select Yes or No to identify whether the item contains chemicals that require extra care in handling.

Style Size Range

Displays the size range that you assigned to the BOM item.

To assign a style size range, open the Style/Size pane. Drag and drop a size range from the Size
pane to the Style Size Range cell.

Style Size Code

Displays the size code that you assigned to the BOM item.

Style Size Characteristic

Select a style size characteristic from the list.

The list of style size characteristic is based on the style size code that is added to the BOM item.

Note:  If you select a component size range for a BOM item, the Style Size Code field will be
cleared. If you clear the Component Size Range field, the Style Size Range and Style Size Code
fields will be cleared.

Component Size Range

Displays the component size range.

To assign the component size range, open the Style/Size pane. Drag and drop a size range from
the Size pane to the Component Size Range cell.

Note:  This field only applies to trims as BOM items.

Component Size Code
Displays the component size code.
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Colors

Assign colors to a BOM item by dragging and dropping colors from the Color panel on the Basics
menu.

You can also right-click a BOM item and select Colorways to assign color to a BOM item, then
drag and drop colors from the Colorways pane.

Additionally, you can also right click a BOM item and select Add Sales Color to assign color to a
BOM item.

Alternatively, select the color cell and click the arrow down button to add a new color or to search
for an existing color.

Note:  BOM item colorways can be restricted. If the BOM item colorway restriction is applied to a
Style, Material, or Trim, only the colors that are available in the colorway of the selected item will
apply.

See Configuring color settings on page 22.

Supplier

To assign a supplier to a BOM item, open Sourcing by going to Basics > Sourcing, and then drag
and drop a supplier from the Sourcing pane to the BOM item. You can also type a supplier name
in the field.

Status
Select a status from the list.

Quantity
Specify the quantity.

Quantity UOM

Select a unit of measurement (UOM) for the quantity.

UOMs can be defined in Generic Lookup.

Cost Price

Specify the cost price of the BOM item.

Waste %

Specify the waste percent of the BOM item.

Waste Qty

Displays the waste quantity when you save the BOM item.

If the waste quantity for the BOM item is not yet defined, you can specify a waste quantity in the
BOM item line.

Gross Qty

Displays the gross quantity when you save the BOM item.

Cost Price (Base)

Displays the cost price of the BOM item in your base currency.
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Total Gross Cost Price (Base)

Displays the total gross cost price of the BOM item in your base currency.

Total Cost Price

Displays the total cost price of the BOM item in based on the Currency.

Currency

Select a currency for the purchase price from the list.

Currencies can be defined on the Setup menu.

Purchase Price

Specify a purchase price.

Note:  You can map a cost element to the purchase price.

See Defining cost element properties on page 62.

Purchase Price (Base)
Displays the purchase price in your base currency.

Total Purchase Price

Displays the total purchase price based on the quantity and purchase price of the BOM item.

Total Purchase Price (Base)
Displays the total purchase price in your base currency.

Total Purchase Price (Base)
Displays the total purchase price in your base currency.

Attachments
Displays the number of attachments associated to the BOM item.

Construction

Specify the construction of the BOM item.

Weight
Specify the weight of the BOM item.

Weight UOM

Specify the weight unit of measurement of the BOM item.

Finish

Specify the finish of the BOM item.

Fiber Content
Specify the fiber content of the BOM item.

User Defined

Specify a value for this field.

You can create user-defined fields in Generic Lookup.
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Part
Select a part from the list.

You can define parts in Generic Lookup.

User Defined 1

Specify a value for this field.

You can create user-defined fields in Generic Lookup.

User Defined 2

Specify a value for this field.

You can create user-defined fields in Generic Lookup.

User Defined 3

Specify a value for this field.

You can create user-defined fields in Generic Lookup.

User Defined 4

Specify a value for this field.

You can create user-defined fields in Generic Lookup.

Part
Specify the part where the BOM item is applicable.

Free Field 1

Provides you the flexibility to add details to your BOM that do not fall under any defined column.

Free Field 2

Provides you the flexibility to add details to your BOM that do not fall under any defined column.

Free Field 3

Provides you the flexibility to add details to your BOM that do not fall under any defined column.

3 To add notes about the BOM, specify your comments in the Notes section.

4 Click Save or Save and Close.

Replace BOM lines
These fields are not editable when the BOM item is added by using drag and drop, but the fields can
be replaced by using the replace BOM line function:

• Number
• Name
• Main category
• Category Group
• Category
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• Composition
• Critical Material
• Chemical Warning

Note:  The Quantity field cannot be replaced by using the replace BOM line function.

If the unit of measurement (UOM) of the item that will replace the BOM line is different, quantity will be
converted based on the new UOM.

The replace BOM line function is applicable only to BOM items with component types material or trim.

1 On the style details page, click the BOM tab to display the BOM Details panel.

2 Right-click a BOM item and select Replace BOM Line.

Note:  If you right-click a material item, a list of materials from the Materials library is displayed. If
you right-click a trim item, a list of trims from the Trims library is displayed.

3 Select a value for the BOM Lines to Replace field.

This table shows the available options for the BOM Line to Replace field:

DescriptionOptions

Replaces details of selected BOM lines.Selected Lines

Replaces items in the current BOM version that have the same
code as the selected record on the Replace to BOM Line list.

Similar to Selected Lines (Cur-
rent BOM Version)

Replaces items across all BOM versions of the style that have
the same code as the selected record on the Replace to BOM
Line list.

Similar to Selected Lines (Across
BOM Version)

4 Select a BOM item from the list and click Replace.

Managing BOM versions
BOMs are often edited and managed by multiple parties. In Infor Fashion PLM, you can track and
manage changes by creating, copying, and comparing multiple BOM versions for a particular style.

You can also set the main BOM version and the material of your style in the BOM.

Create a new BOM version
1 Click the New Version icon on the toolbar.

2 Specify this information:

Main Version
Select to make BOM version the main version.

Name
Specify a name for the BOM version.
Note:  Two versions cannot have the same name.
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Status
Select a status from the list.

No. of Versions
Displays the number of available BOM versions for the style.

Locked
Select to lock the editing of BOM items.

Filter by
Select a value from the list.

This field is used to filter the list of BOM items based on the Style Size Code and Style Size
Characteristic. BOM items with blank Style Size Code and blank Style Size Characteristic are also
displayed.

Note:  This field is displayed only if the size range applied contains multidimensional sizes.

Exchange Rate Type
Select an exchange rate type.
• Actual is the exchange rate type that pertains to current values of an exchange rate.

• Budget is the exchange rate type that is set by the organization for one entire budget period.

• Simulated is the exchange rate type that pertains to forward rates that will take place in the
future.

Note:  You can create only one exchange rate for a currency with this exchange rate type.

Exchange Rate Date
Specify the date of the exchange rate.

Exchange Rate Category
Specify the category of the exchange rate.
• Default Exchange Rate is the category that sets the exchange rate to the default value set per

each currency.
• Latest is the category that sets the exchange rate based on the latest exchange rate setup.
• By Date is the category that enables you to set an exchange rate based on the selected Exchange

Rate Date.

3 To add BOM items, open Material and Trim.

Dock them to any side of the main window for side-by-side viewing.

4 Drag and drop items from Material and Trim to the new BOM version.

You can also create items inline in the BOM version.

5 Specify BOM details:

CI

Select the check box to mark the BOM item as a cost indicator (CI).

A BOM item that you mark as a cost indicator will be included in the computation of the style's
costing.

Note:  This enables you to map the item to a cost element.
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See Defining cost element properties on page 62.

Seq #
Optionally, modify the sequence of BOM items.

Sequencing sorts BOM items for viewing. To modify the sequence of BOM items:

• Select a sequence number from the list.
• Type a sequence number in the Seq # field.
• Drag and drop BOM items.

Note:  You can rearrange the BOM items in descending or ascending order by clicking the arrow
in the Seq # column.

Number

Displays the item number of the trim or material record.

If you create a BOM item inline, specify the number.

Name

Displays the name of the trim or material record.

If you create a BOM item inline, specify the name.

Description

Specify a description.

C&C

Select the check box to tag this BOM item as an item used in Care & Content to import composition
information from.

Notes
Displays notes about the item.

Component Type
Displays the component type of the item.

If you create a BOM item inline, select a component type.

Main Category

Displays the main category of the item.

If you create a BOM item inline, select a main category.

Category Group

Displays the category group of the item.

If you create a BOM item inline, select a category group.

Category

Displays the category type of the item.

If you create a BOM item inline, select a category type.

Image

Displays the image of the item.
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If you create a BOM item inline, drag and drop an image from your local computer to the image
cell.

Placement

Displays the placement of the item.

If you create a BOM item inline, specify the placement

Composition

Displays the composition of the BOM item.

If you create a BOM item inline, specify the composition.

Certificate

Displays the certificate of the BOM item.

If you create a BOM item inline, specify the certificate.

Critical Material

Displays whether or not the BOM item is a critical material to the style.

If you create a BOM item inline, select Yes or No to specify if this BOM item is a critical material.

Chemical Warning

Displays whether or not the BOM item contains chemicals that require extra care in handling.

If you create a BOM item inline, select Yes or No to indicate a chemical warning.

Style Size Range

Displays the size range that you assigned to the BOM item.

To assign a style size range, open the Style/Size pane. Drag and drop a size range from the Size
pane to the Style Size Range cell.

Style Size Code

Displays the size code that you assigned to the BOM item.

Style Size Characteristic

Select a style size characteristic from the list.

The list of style size characteristic is based on the style size code that is added to the BOM item.

Note:  If you select a component size range for a BOM item, the Style Size Code field will be
cleared. If you clear the Component Size Range field, the Style Size Range and Style Size Code
fields will be cleared.

Component Size Range

Displays the component size range.

To assign the component size range, open the Style/Size pane. Drag and drop a size range from
the Size pane to the Component Size Range cell.

Note:  This field only applies to trims as BOM items.

Component Size Code
Displays the component size code.
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Colors

Assign colors to a BOM item by dragging and dropping colors from the Color panel on the Basics
menu.

You can also right-click a BOM item and select Colorways to assign color to a BOM item, then
drag and drop colors from the Colorways pane.

Additionally, you can also right click a BOM item and select Add Sales Color to assign color to a
BOM item.

Alternatively, select the color cell and click the arrow down button to add a new color or to search
for an existing color.

Note:  BOM item colorways can be restricted. If the BOM item colorway restriction is applied to a
Style, Material, or Trim, only the colors that are available in the colorway of the selected item will
apply.

See Configuring color settings on page 22.

Supplier

Displays the preferred/main supplier.

If you create a BOM item inline, select a supplier.

Status
Select a status from the list.

Quantity Type
Select a quantity type from the list.

Quantity
Specify the quantity.
Note:  If Quantity Type is set to Size Dependent, the value on the Quantity field becomes clickable.
If you click the quantity link, the BOM Line Size Quantity pane is displayed. The available sizes for
the BOM item are displayed on the pane. You can set the quantity for each size.

Quantity UOM

Select a unit of measurement (UOM) for the quantity.

UOMs can be defined in Generic Lookup.

Cost Price

Displays the cost price of the BOM item.

If you create a BOM item inline, specify the cost price.

Waste %

Specify the percentage of waste in a BOM item when producing a style.

Waste Qty

Displays the waste quantity by multiplying Quantity and Waste %.

You can also manually specify the waste quantity value. If you specify the waste quantity, Waste
% will be calculated by dividing Waste Quantity over Quantity.
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Gross Qty

Displays the gross quantity, which is the sum of the quantity and the waste quantity.

Cost Price (Base)
Displays the cost price in base currency.

Total Gross Cost Price (Base)
Displays the total gross cost price in base currency.

Total Cost Price
Displays the total cost price.

Currency

Displays the currency.

If you create a BOM item inline, select a currency.

Purchase Price

Displays the purchase price of the BOM item.

If you create a BOM item inline, specify a purchase price.

Purchase Price (Base)
Displays the purchase price in base currency.

Total Purchase Price

Displays the total purchase price based on the quantity and purchase price of the BOM item.

Total Purchase Price (Base)
Displays the total purchase price in base currency.

Total Cost Price (Base)
Displays the total cost price in base currency.

Attachments

Drag and drop files from your local computer to this field.

The number of attachments associated to the BOM item is displayed.

Construction

Displays the construction of the BOM item.

If you create a BOM item inline, specify the construction.

Weight

Displays the weight of the BOM item.

If you create a BOM item inline, specify the weight.

Weight UOM

Displays the unit of measurement used for the weight.

If you create a BOM item inline, select a unit of measurement.
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Finish

Displays the finish of the BOM item.

If you create a BOM item inline, specify the finish. Finishes are defined in Generic Lookup.

Fiber Content
Specify the fiber content of the BOM item.

User Defined 1

Specify a value for this field.

You can create user-defined fields in Generic Lookup.

User Defined 2

Specify a value for this field.

You can create user-defined fields in Generic Lookup.

User Defined 2

Specify a value for this field.

You can create user-defined fields in Generic Lookup.

User Defined 2

Specify a value for this field.

You can create user-defined fields in Generic Lookup.

Part

Select the part where the BOM item is used.

Parts are defined in Generic Lookup.

Free Field 1

Provides you the flexibility to add details to your BOM that do not fall under any defined column.

Free Field 2

Provides you the flexibility to add details to your BOM that do not fall under any defined column.

Free Field 3

Provides you the flexibility to add details to your BOM that do not fall under any defined column.

6 Optionally, specify notes about the BOM version in the Notes section.

7 Click Save.

Rename a BOM version
1 Select a BOM version on the toolbar.

2 Replace the name of the BOM version on the Name field.

Note:  Two versions cannot have the same name.

Infor Fashion PLM User Guide | 198

 

Style



3 Click Save.

Copy a BOM version
1 Click the Copy Version icon on the toolbar.

2 Select the BOM version on the toolbar to view the details of the version copy.

Compare BOM versions
1 Click the Compare BOM Version icon on the toolbar.

Note:  You can only compare two versions at a given instance.

2 Specify this information:

Synchronize Scrolling
Select to enable synchronized scrolling of compared BOM versions.

Compare
Select a BOM version.

By default, the main BOM version is selected. Details of the selected BOM version are displayed
on the left panel.

With

Select a BOM version.

Details of the selected BOM version are displayed on the right panel for comparison with the details
of the BOM version that are displayed on the left panel.

The differences between the two versions are highlighted.

Set the main BOM version
1 Select a BOM version on the toolbar.

2 Select the Main Version check box.

Identify the main material in BOM
1 Select the main BOM version on the toolbar.

2 On the row of the BOM item that you want to set as the main material, click the cell between the CI
and Seq # columns.

Note:  Only BOM items that have the component type Material can be set as the main material of
the BOM.
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The details of the BOM item that you identify as the main material of the main BOM version will be
displayed on the Overview tab, under the Main Material Information section.

Defining the bill of operations (BOO)
A bill of operations (BOO) is a list of work hours for completing tasks that are required to develop a
product. Defining the BOO for your style enables you to monitor individual man hours that go into a
job. The BOO also details the cost that goes to labor expenses.

You can define a bill of operations for your style by adding operations or operation lists.

See Defining operations on page 70.

See Creating operation lists on page 72.

1 On the style details page, click the BOO tab.

2 Specify this information:

Style

This field displays the name of the style.

This field is automatically populated.

Status
Select the workflow status.

Average Hourly Rate

Specify an average hourly rate.

The specified average hourly rate will allow you to update the hourly rate when the Overwrite button
is clicked.

Quantity
Specify the quantity.

Valid for BOM Versions
Select a BOM version from the list.

Exchange Rate info from Version

Select the BOM version that contains the exchange rate to be used for the BOO.

Price per piece
Displays the calculated price per piece.

Price per piece = Total SAM Cost (Base) / Quantity

Note:  If you change any values on the given fields, click Recalculate.

3 From the main menu, open the Operation and Operation List panels.

Float the windows and dock them to any side of the main window for side-by-side viewing.

4 Drag and drop items from Operation and Operation List to the BOO panel.
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Operation field values are inherited from Operation or Operation List.

5 To add notes about the BOO, provide your comments in the Notes section.

Create operations on the BOO tab
Note:  To manually create operations on the BOO tab, your account must have a Style BOO (On the
fly) authority.

See “Managing roles” in the PAH Online Help.

1 In the BOO table, select Click here to add a new row.

2 Specify this information:

Operation List

Displays the name of operation list if operation is added using operation list.

Seq #

Displays the sequence number of the operation.

Click and set the sequence number of the operation to your desired value to reorder the sequence
of the operations.

Placement
Select a placement from the list.

Sub #
Displays the sub sequence number of the operation.

Calculate Cost
Select the check box to calculate the Standard Allowable Minutes (SAM) cost.

Operation Code
Specify a unique operation code.

Operation Name
Specify an operation name.

Description
Specify a description for the operation.

Image

Displays the image of the item.

To change or add an image, drag and drop an image from your local computer to the image cell.

Operation Type
Select an operation type from the list.

Operation Group
Select an operation group from the list.
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Number
Specify a number. By default, the value is set to 1.

SAM
Specify a value for the Standard Allowable Minutes.

Hourly Rate
Specify a value for the hourly rate.

Hr Currency
Select a currency from the list.

SAM Cost
Displays the SAM cost.

SAM Cost = Number * ((Quantity * SAM / 60) * Hourly Rate)

Cost Currency
Displays the same currency set in the Hr Currency field.

SAM Cost (Base)
Displays the SAM cost in your base currency.

Base Currency
Displays the base currency.

Efficiency %
Specify a value for the efficiency %.

Status
Select a status from the list.

SPI
Specify a value for the SPI.

Seam Allowance
Specify a value for the Seam Allowance.

Free Field 1
Specify any other related details pertaining to the operation.

User Defined Field 1

Specify a value for this field.

You can create user-defined fields in Generic Lookup.

Skills
Select skills from the list.

Setup Time (min.)
Specify a value for the setup time in minutes.

Man/Machine
Select the applicable option from the list.
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Instructions

Specify the instructions.

To specify an instruction, click the Instructions cell. On the Instructions window, select a language
from the list and enter the instructions on the Text cell. Click OK.

Note:  If you change any values on the given fields, click Recalculate.

3 Click Save or Save and Close.

Determining style measurements
Style measurements are critical in ensuring that products are the right fit, and that sampling requests
have dimensions to serve as basis for style samples. In Infor Fashion PLM, you define the measurements
of a style by using size ranges, points of measure (POMs), and grade rules.

You can determine style measurements in Infor Fashion PLM by using:

• Points of measure
• Grade rules

Define style measurements
1 On the style details page, click the Measurements tab to display the Master Page.

2 Specify measurement details:

Main
Select the check box to set the specified size range to main.

Size Range
Select an available size range from the list.
Note:  The sample page tab in Measurements depends on the size range selected for a specific
style.

Sample Size

Select a sample size.

Available sample sizes depend on the size range you selected for the measurement.

Note:  If a currently selected sample size is set to inactive in the Style/Size pane, you will be
prompted to select a new active sample size.

Tolerance Format
Select + & - Columns or ± Columns.

Status

Select In Concept, For Approval, Rejected, Operational, or any user-defined status.
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No. of Size Range
This field shows the total count of size range created for a style.

Grade Rule Format

Select a grade rule format.

The grade rule format determines how the values of a grade rule are presented on the page.

• The Relative format compares a size value with previous size values in sequence.

• The Absolute format compares a size value to the sample size value.

• The Multidimensional format compares the sample size value to sizes with the same base or
reference value. Each reference value compares to the previous size values in the sequence.
This format is available only for multidimensional sizes.

Measurement View
Select Metric, Imperial Decimal, or Imperial Fraction.

Fraction Denominator

Select a fraction denominator from the list if your measurement view is Imperial Fraction.

This field enables you to decide the accuracy level of measurement values.

Filter By
Select a value.
Note:  This field is displayed only if the selected size range contains multidimensional sizes.

3 To add an image, drag and drop an image from your local folder to the Images section of the
Measurements tab.

Note:  To have a larger view of the image, click the image in the Images section of the Measurements
tab. The Style Measurements/Images pane is displayed to enable you to view the image in detail.

By default, the sorting of the columns is disabled. To enable column sorting, right-click any of the
column and select Enable Sorting. You can enable the column sorting for each style as the column
sorting is not saved for each record.

Manually add POMs
Note:  To manually add POMs on the Summary tab, your account must have a Style Measurements
(On the fly) authority.

See “Managing roles” in PAH Online Help.

1 On the table on the Summary tab, specify this information:

Seq #

The sequence number determines the order of POMs used for a style record.

This field is automatically populated by the application, but you can modify the sequence by changing
the sequence number for each POM.

POM Code
Specify a POM Code.
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POM Name
Specify a POM name.

Grade Rule Name
Leave this field blank.

Description
Specify a brief description.

Part
Select a part from the list.

You can define parts in Generic Lookup.

Image
Drag and drop an image from your local folder to the Image cell.

2 Specify the measurement values.

See Adding measurement values on page 206.

Add POMs from a grade rule to a style measurement
1 From the main menu, open the Grade rule panel and dock it to any side of the main window.

The Master Page of the Measurements tab and the Grade Rule panel are displayed side by side.

2 From the Grade Rule panel, drag and drop a grade rule to the Summary section of the Master Page.

POMs from that grade rule are displayed in the Summary section.

Note:  To add specific POMs from a grade rule to a style measurement, open a grade rule details
page and drag and drop POMs to the Measurement tab.

To remove POMs from a style measurement, right-click a POM and select Delete.

Add POMs to a style measurement
1 From the main menu, open the Point of Measure panel and dock it to any side of the main window.

2 Drag and drop POMs to the Summary section of the Measurements tab.

Note:  You can also right-click an existing POM on the Measurements tab and select Add POM.
The Add POM option is only available on the context menu if the POM is included in a grade rule.
A window appears to display POMs that are not included in any grade rule. Drag and drop POMs
to the Measurements tab.

If you have removed POMs from a grade rule in style measurement, you can add them again by
right-clicking and selecting the POMs.
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Adding measurement values
After providing measurement details and adding points of measure, you must specify the values for
tolerance and initial measurement to determine measurements for each size.

1 In the Summary section of the Master Page, specify this information for every point of measure:

Tol +
Set the permissible value that a size can exceed the indicated measurement.

Tol -
Set the permissible value that a size can go below the indicated measurement.

Initial Measurement

Specify the initial measurement for the style.

The value you provide will be applied to the sample size that you selected.

Note:  To indicate a negative value, specify a minus sign before the value.

2 In the Graded Increment section of the Master Page, provide measurement values or gradings for
other sizes other than the sample size.

A graded increment pertains to a fixed amount that differentiates the measurements between sizes.

The number of sizes depends on the size range that you selected.

Note:  If you add POMs from a grade rule that has gradings, the Graded Increment section will
display values from that grade rule.

If you update the measurement values or gradings of multidimensional sizes, all other sizes with
the same base or reference value will also be updated.

3 Click the Graded Measurement section to view the measurements for each size.

Note:  If you delete a size in the Size tab of a style record, the size will be removed in the style,
Graded Increment tab, and Graded Measurements tab.

If you changed the status of a size to inactive, the size is grayed out in the Graded Increment and
Graded Measurements tab.

4 Click Save or Save and Close.

Creating sample measurements
In Infor Fashion PLM, you can create measurements for sampling requests. Creating sample
measurements enables you to request samples of different sizes from your supplier.

You can define sample measurements in two ways:

• Through the Measurements tab in the style details page
• Through the Request panel

See Creating requests on page 81.

Before you start creating sample measurements, you must first define the measurements of your style.
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See Determining style measurements on page 203.

1 On the Measurements tab of a style details page, click Sample.

2 Click the New icon.

The panel is populated with POMs, sizes, and measurement values from the Master Page.

3 Specify sample measurement details:

Size Range
This field shows the size range that the sample page corresponds to.
Note:  A sample page is created for each size range that is selected in the Master Page.

You can create multiple sample measurements for each size range.

Sample Code
Specify a code.

Request Sub Type

Select a request subtype from the list.

You can define request subtypes in Generic Lookup.

Sample Size

Select a sample size from the list.

The sample size enables you to revise your measurements.

Note:  If the sample size that you select for your sample measurements is not the same sample
size that you specified in the master page, the master page will be updated to display your sample
size in your sample measurements.

Status

Select In Process, Received, Rejected, Approved, Cancelled, or any user-defined status.

If the status of a sample measurement is Rejected or Approved, the measurement values and their
respective revisions are reflected back to the master page. Ensure that a sample size is selected
in the sample page before you approve or reject a sampling request.

Iteration

Displays the number of sample pages created per subtype of the style.

4 Select requested sample sizes.

Available options depend on the size range that you selected on the Master Page.

These columns are added in the measurements table:

• Sample

Indicates the measurements for the selected sample size

• Supplier

Indicates the supplier's measurements for the selected sample size

• Own

Indicates your own measurements for the selected sample size

• Deviation
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Displays the difference between your measurements and that of the sample for the selected
sample size

• Revised

Enables you to revise the initial values of sample measurements that you submitted to your
supplier and reflect those revised values back to the master page.

Note:  You can still add more sample sizes and change your initially selected sample size.

To see your sample measurements reflected on the master page, you must set the sample
measurement page to approved.

5 To assign images to your sample measurement, drag and drop an image from your local computer
to the image holder on the Sample panel.

6 Click Save or Save and Close.

Note:  The number of sample measurements created for each style is displayed in the Master Page
tab. The latest sample page created for the style record is also displayed.

Create multiple sample measurements
You can create multiple sample measurements in Infor Fashion PLM. Multiple sample measurements
enable you to create requests for various sampling processes.

1 On the Measurements tab of a style details page, click Sample.

2 Click the New icon on the toolbar.

Select a sample measurement
1 On the toolbar, click the Sample Measurement list.

2 Select a sample measurement page from the list.

Copy sample measurement values
1 To copy column or row values, right-click a sample measurement column or row on the Measurements

tab and select Copy Column Values or Copy Row Values.

2 Right-click another sample measurement column or row and select Paste Column Values or Paste
Row Values.

Note:  You can copy the sample measurement values of a style to another style. This feature is
also available on the Master page of Style.
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Defining patterns
You can define patterns that you can use in creating style records.

Defining patterns for a style
1 On the Style panel, open a style record and click the Patterns tab.

2 Specify pattern information:

Main page
Select this option to set the selected pattern as the main page.

Page Name
Specify a page name.

Number
Specify a value.

Name
Specify a name.

Total number of pieces
The total count of patterns that are added in pattern pieces table is displayed.

Spec #
Specify a specification number.

Pattern Maker
Specify a pattern maker.

Status

Select a status from the list.

You can define status in Generic Lookup.

Size Range

Select a size range from the list.

Available options depend on the size ranges that are added for the style.

Sample Size
Select a sample size from the list.

Fit
Specify a fit.

Base Size
Select a base size from the list.

CB Length on Body
Specify a center back length on body value.

Infor Fashion PLM User Guide | 209

 

Style



Sleeve Length
Specify a sleeve length value.

Inseam
Specify an inseam value.

Outseam
Specify an outseam value.

Leg Opening
Specify a leg opening value.

Approved By
Select a user from the list.

Approved Date
Select a date by using the date picker.

Cutting Instructions
Specify the cutting instructions for the style pattern.

3 Specify the pattern pieces details:

Seq #

Specify a sequence number.

If multiple patterns are available, select a sequence number from the list to arrange the order of
the pattern items.

Priority
Specify a priority value.

Piece ID
Specify a value.

Cad #
Specify a value.

Refer To
Specify a value.

Grain
Specify a value.

Service
Specify a value.

Quantity
Specify a value.

Material Pattern Piece Description
Specify a brief description for the pattern piece.
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Material ID
Specify the material ID.

Material Type

Select a material type from the list.

You can define material types in Generic Lookup.

Material Description
Specify a brief description.

Material Status
Specify the material status.

Composition
Specify a value.

Material Supplier
Displays the supplier of the material.

Note:  Alternatively, you can drag and drop patterns from the Patterns to the Pattern Pieces table.
You can also drag and drop a CSV file with the pattern pieces details to the Pattern Pieces table.

A new page is created each time you drag and drop a CSV file or a pattern from the Patterns panel.

To manually create a new page for the pattern, click New Page.

4 Drag and drop images from your local computer to the Pattern Images holder.

5 Optionally, attach files to the pattern.

Drag and drop the files from your local computer to the Attachments field.

Defining markers

Creating a new marker
1 On the Style panel, open a style record and click the Marker tab.

2 Specify marker information:

Main page
Select this option to set the selected marker as the main page.

Page Name
Specify a page name.

Marker Number
Specify a marker number.
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Marker Name
Specify a marker name.

Pattern Information
Specify a value.

Spec #
Specify a specification number.

Marker Maker
Specify a marker maker.

Average Consumption
Specify a value.

Material Type

Select a material type from the list.

You can define material types in Generic Lookup.

Material Number
Specify a material number.

Material Width / Unit
Specify a value.

Material Repeat Warp
Specify a value.

Material Repeat Weft
Specify a value.

Status

Select a status from the list.

You can define status in Generic Lookup.

Approved By
Select a user from the list.

Approved Date
Select a date by using the date picker.

Cutting Instructions
Specify the cutting instructions for the style pattern.

3 On the Marker Table section, specify this information:

Seq #

Specify a sequence number.

If multiple markers are available, select a sequence number from the list to arrange the order of
the marker items.
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Date
Specify a date by using the date picker.

Marker ID
Specify a value.

Marker Name
Specify the marker name.

Product Category
Select a product category from the list.

Width
Specify a value.

Size Included
Specify a value.

Ratio
Specify a value.

Marker Length
Specify the marker length value.

Unit of Measure
Select a unit of measure from the list.

YDS / DZ
Specify a value.

Bias
Specify a value.

% Utilization
Specify a value.

Material Number
Specify a material number.

Material Description
Provide a brief description.

4 Drag and drop images from your local computer to the Marker Images holder.

5 Optionally, attach files to the marker. Drag and drop files from your local computer to the Attachments
field.
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Defining costing of a style
You can determine the total cost of creating your styles by adding cost elements or cost models to
style records.

Adding cost elements to a style costing
You can add new cost elements on the Costing tab of a style record. In the application, cost elements
are usually defined in the Cost Element panel. Enabling you to add new cost elements on the Costing
tab gives you the option to skip that procedure and proceed with defining your style costing.

Note:  To manually add cost elements to a style costing on the Costing tab, your account must have
a Style Costing (On the fly) authority.

See “Managing roles” in the PAH Online Help.

Cost elements that you drag and drop from the libraries are saved automatically.

1 On the Style panel, open a style record and click the Costing tab.

2 In the Cost Elements section, select Click here to add new row.

3 Specify this information:

QI
Select the check box to mark the cost element as a quotation input.

Seq

Displays the sequence number of the cost element.

The sequence number is automatically generated. You can change this after you save the cost
element.

Cost Level

Select a cost level from the list.

You can define cost levels in Generic Lookup.

Code
Specify a code.

Name
Specify a name for the cost element.

Description
Specify a brief description about the cost element.

BOM Version

Select a BOM version.

Available options depend on the number of BOM versions that you created for the style.
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Note:  For cost elements that are manually added on the Costing tab, Input is the default setting
for the Type field in Cost Element Properties. To change this, double-click the Cost Element cell
and apply preferred changes.

4 Click Save.

Adding existing cost elements to a style costing
You can add existing cost elements that you have defined in the Cost Element panel.

1 On the Style panel, open a style record and click the Costing tab.

2 From the main menu, open Cost Element panel and dock it to any side of the main window.

3 From the Cost Element panel, drag and drop a cost element record to the Costing tab.

4 Optionally, specify this information:

Note:  You can change the details of the existing cost element if it hasn't been mapped to a BOM
or price field.

Cost Element Type
Specify UX (User Exit), CO (Constant), Calculated (CA), or IN (Input).

Seq
Drag and drop the cost element anywhere within the cost level to rearrange the sequence.

Level
Select a cost level.

You can define cost levels in Generic Lookup.

Code
Specify a code.

Name
Specify a name.

Description
Specify a brief description about the cost element.

BOM Version

Select a BOM version.

Available options depend on the number of BOM versions that you created for the style.

5 Click Save or Save and Close.

Using a cost model on a style
You can assign a cost model that you defined in the Cost Model panel to a style record.
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1 On the Style panel, open a style record and click the Costing tab.

2 Select a cost model.

To define cost models, see Creating cost models on page 61.

3 Optionally, specify this information:

Note:  You can change the details of the existing cost element if it hasn't been mapped to a BOM
or price field.

Cost Element Type
Specify UX (User Exit), CO (Constant), Calculated (CA), or IN (Input).

Seq

Drag and drop the cost element anywhere within the cost level to rearrange the sequence.

Level

Select a cost level.

You can define cost levels in Generic Lookup.

Code
Specify a code.

Name
Specify a name.

BOM Version

Select a BOM version.

Price

Specify a price.

The default currency is your base currency.

4 Click Save or Available options depend on the number of BOM versions that you created for the
style.Save and Close.

Comparing costing among suppliers
You can compare prices that your suppliers offer and put them side by side your cost model. Because
a supplier can offer more than one set of prices, Infor Fashion PLM enables you to add a single supplier
multiple times, with each instance reflecting different prices for each cost element.

1 On the Style panel, open a style record and click the Costing tab.

2 Click the Style/Sourcing icon on the sidebar.

3 From the Style/Sourcing pane, drag and drop a supplier to the Costing tab.

4 To provide more details about the supplier, click the drop-down arrow on the column header.

5 Optionally, specify this information:
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Active
Select the check box to indicate that the supplier is active.

Locked

Select the check box to lock the supplier's information and cost values from editing.

A locked column enables you to keep the current cost information and, if the supplier column is
associated to a BOM version, prevents updates to cost information from a BOM version.

Lead Time
Specify the lead time.

Lead Time Unit of Measurement
Select the lead time UOM.

Minimum Qty
Specify the minimum quantity.

Quantity Unit of Measurement

Select a quantity UOM.

You can define UOMs in Generic Lookup.

Delivery Method

Select a delivery method.

You can define delivery methods in Generic Lookup.

Delivery Term

Select a delivery term.

You can define delivery terms in Generic Lookup.

Country of Origin
Select a country of origin.

BOM Version
Select a BOM version.

Iteration # / Request ID
Specify the iteration number.

Free Field
Specify any information in the free field as additional information.

Costing Date
Select a costing date.

Preferred

Select or clear Preferred.

If you add the same supplier several times, this field enables you to decide which set of prices from
the supplier is reflected on the Style Overview tab. Prices are reflected on the Style Overview tab
if the cost elements are mapped to a cost field.
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Evaluation Status

Select an evaluation status from the list.

You can define evaluation statuses in Generic Lookup.

Exchange Rate Type
Select an exchange rate type.
Note:  You cannot specify an exchange rate type if this supplier column contains a BOM version,
in which case the exchange rate type of the BOM version is used.

Exchange Rate Date
Select an exchange rate date.
Note:  You cannot specify an exchange rate date if this supplier column contains a BOM version,
in which case the exchange rate date of the BOM version is used.

6 Specify the supplier price for each cost element.

7 Optionally, to filter the display of suppliers, select All Suppliers, Active Suppliers, or Inactive Supplier
on the header information.

8 Click Save or Save and Close.

Defining care instructions
You can assign labels and symbols to a style to provide care instructions. In Infor Fashion PLM, labels
come from trims. You can use trims that are categorized as “Label.”

There are alternative ways to assign labels and symbols to a style:

• Create labels on the Care & Content tab.

See Defining labels for a style on page 220.

• Use a BOM item as a label by enabling its import as a Care & Content item.

See Managing BOM versions on page 192.

To assign care instructions to a style, you must first define trims and symbols.

See Creating trims on page 262.

See Adding care symbols on page 49.

Assigning care instructions to a style
1 On the style details page, open the Care & Content tab.

2 Open the Trim and Care panels and dock them to any of the main sides of the window.

3 Drag and drop a trim with the category Label to the Care & Content tab.
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Note:  If a trim contains a care symbol with care instructions, the care instructions are automatically
added to the Care Instructions section.

4 Specify this information:

Number
Specify a number.

Name
Specify a label name.

Material
Specify the material for the label.

Ground Color
Select the ground color of the label from the list.

Text Color
Select the text color of the label from the list.

Size
Specify the size of the label.

UOM
Select a unit of measurement.

You can define UOMs in Generic Lookup.

Fold
Specify the label fold.

5 To add a care symbol, drag and drop a care symbol from the Care panel to the Care Symbols section
of the Care & Content tab.

The care symbol is displayed on the Care & Content tab of the style details page.

Note:  If a care symbol contains care instructions, the care instructions are automatically added to
the Care Instructions section.

6 To add care instructions, specify this information:

Care Group
Select a care group from the list.

Description
Specify a brief description.

Language
Select a language from the list.

Details
Specify the details of the care instruction.

7 To add an image, drag and drop an image from your local folder to the Images section of the Care
& Content tab.

8 To add a composition, select Click here to add new row and specify this information:
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Language
Select a language from the list.

Part
Select a part from the list.

Composition
Select a composition from the list.

Layer
Select a layer from the list.

%
Specify a percentage value.
Note:  The total percentage of composition items is checked in multiples of 100% for better flexibility.

Label Name
Select a label from the list. You can define labels in Generic Lookup.

Number

Specify the composition number. If the care symbol is imported from BOM, the composition number
will be the material, trim, or style number of the BOM line.

9 Specify other information:

Country of Origin
Select a country of origin.

Other Info
Provide other instructions pertaining to the care label.
Note:  You have an option to create a new label on the Care & Content tab without using a trim
and attach that label to the style.

Styles can have more than one label or may require details on both the front and back portions of
a single label. As such, a style may require multiple Care & Content pages. To add another Care
& Content page, click the Add Page icon on the toolbar.

To remove a care symbol that is assigned to a style, go to the Care & Content tab of the style record,
select a care symbol and then click the Delete icon or press Delete on your keyboard.

Defining labels for a style
You can define a label specifically for a style on the Care & Content tab.

1 On the style details page, open the Care & Content tab

2 Specify this information:

Number
Specify a number.
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Name
Specify a name for the label.

Material
Specify the material for the label.

Ground Color
Select the ground color of the label from the list.

Text Color
Select the text color of the label from the list.

Size
Specify the size of the label.

UOM

Select a unit of measure (UOM).

You can define UOMs in Generic Lookup.

3 Specify this information:

Country of Origin
Select a country of origin.

Other Info
Provide other instructions pertaining to the care label.

4 Click Save.

Importing care symbols of component items to a style
You can associate care symbols that are assigned to a style's trim components by importing the symbols.

Before you start importing care symbols, you must first finalize the bill of materials (BOM) version before
importing symbols.

See Managing BOM versions on page 192.

1 Go to the Care & Content tab of a style record.

2 Click the Import Care Information icon on the toolbar.

Note:  Any existing care symbols are replaced.

Importing care composition items from the main BOM version
You can import BOM items from the main BOM version of a style to the Care & Content tab and use
the composition information found in these BOM items.
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Before you can import care composition items from the main BOM version, you must specify BOM
items in the main BOM version that can be used as Care & Content items.

See Managing BOM versions on page 192.

1 Go to the Care & Content tab of a style record.

2 Click the Import Care Composition icon on the toolbar.

Note:  Any existing care composition are replaced.

Creating styles from existing styles
In Infor Fashion PLM, you can create multiple styles simultaneously by using info clusters. Info clusters
are sets of data from existing records that you can reuse to mass create styles.

Mass creating styles
1 On the Style Overview panel, click Mass Create.

2 Specify info cluster details:

Template Item
Select Yes or No.
Note:  A template item only serves as a basis for creating styles. It cannot be used and treated as
an actual style.

Number Prefix
Specify a prefix.

Style Name
Specify a name.

Description
Specify a brief description.

No. of Item

Specify the number of items to be created.

Optionally, you can specify a limit to the number of items that can be created.

See Configuring mass create and mass update settings on page 32 .

Single Source
Select Yes or No.
Note:  A source record supplies the data in an info cluster. A source record can pertain to an actual
style, material, or trim in Infor Fashion PLM or to a style, material, or trim template.
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3 To specify info clusters that will be updated using information from the source record, select Yes
or No in these fields:

• Overview
• Overview 2
• Colorways
• BOM

Note:  You can specify the specific item in a BOM version that should be added to the info cluster.
• BOO
• Sizes

Note:  You can specify the specific size range that should be added to the info cluster.
• Measurements

Note:  Style measurements are dependent on sizes. To update measurements, you must select
Yes in the Size field.

• Patterns
• Markers
• Images

Note:  You can specify the image types that should be added to the info cluster.
• Care & Content
• Characteristics
• Sourcing
• Costing
• Compliance
• Follow up

4 To identify the source record for each info cluster, drag and drop a style from the Style panel to the
Source column.

5 Optionally, for the BOM info cluster, click Select BOM Version to specify the specific item in a BOM
version that should be added to the info cluster.

6 Optionally, for the Images info cluster, click Select Image to select the image types that should be
added to the info cluster.

Note:  Colorways is enabled only if these conditions are met:

• Colorways info cluster is set to Yes
• Colorways source contains colors
• Colorways and Images sources are the same

Style images are copied from the Style's Images tab.

7 Optionally, set info clusters as favorites.

Setting favorites enables you to save your custom settings and use them repeatedly.

To save info cluster settings, click Set as Favorite.

8 Click Execute to create the records.

9 Select Run Now to execute the action immediately.

You can also select Schedule for Later and specify a date.

10 Click OK.

11 To verify if the action is successful, select Action > Task Monitor from the main menu.
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See “Monitoring Tasks” in PAH Online Help.

12 To view the logs of the created action, from the Task Monitor pane, click Show mass create/update
log.

The action type and action details are displayed in the Mass Create/Update Logs dialog box.

• Action Type

Name of the action type executed by the user.

• Module

Name of the module where the cluster of action type is included.

• Info Cluster

Name of the cluster or sub-module where the action type is included.

• Source

Source identification of the created action.

• Destination

Destination identification of the created action.

• Result

Result of the executed action.

• Message

Message displayed based on the result.

• Initiated By

Name of the user who executed the action.

Note:  In the event that mass create is unsuccessful, Mass Create/Update Logs shows the details
of the executed action and the sources of the errors that you may have encountered.

Mass updating styles
In Infor Fashion PLM, you can change and update information on multiple styles simultaneously to
speed up process around changes.

Note:  These info clusters are not included when mass-updating a style if the style has existing SKUs:
• Colorways
• Sizes
• Measurements
• Images
• Costing
• Compliance
• Characteristics
• Sourcing

1 On the Style panel, right-click a record and select Mass Update.

2 To specify the number of source records, select Yes or No from the Single Source list.
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Note:  A source record supplies the data in an info cluster. A source record can pertain to an actual
style, material, or trim in Infor Fashion PLM or to a style, material, or trim template. Selecting No
enables you to use multiple styles as source records.

3 To update records simultaneously, drag and drop styles from the Style panel to the Item Basket in
the Style - Mass Update pane.

Optionally, you can specify a limit to the number of items that you can drag and drop in this field.

See Configuring mass create and mass update settings on page 32 .

4 To customize your info cluster settings, specify the info clusters that will be updated by selecting
Yes or No.

• Overview
• Overview 2
• Colorways
• BOM

Note:  You can specify the specific item in a BOM version that should be added to the info cluster.
• BOO
• Sizes

Note:  You can specify the specific size range that should be added to the info cluster.
• Measurements
• Images

Note:  You can specify the image types that should be added to the info cluster.
• Care & Content
• Characteristics
• Sourcing
• Costing
• Compliance
• Follow up

5 To identify the source record for each info cluster, drag and drop a style from the Style panel to the
Source column.

Note:  To clean up the data on a specific info cluster, select Yes on the Select field and leave the
Source field blank.

6 Optionally, for the BOM info cluster, click the Select BOM Version button to specify the specific item
in a BOM version that should be added to the info cluster.

7 Optionally, for the Images info cluster, click Select Image to select the image types that should be
added to the info cluster.

Note:  Colorways is enabled only if these conditions are met:

• Colorways info cluster is set to Yes
• Colorways source contains colors
• Colorways and Images sources are the same

Style images are copied from the Style's Images tab.

8 Select Add to combine information from the source record with existing data in the style.

You can also select Replace to substitute existing data in the style with information from the source
record.
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9 Optionally, set info clusters as favorites.

Setting favorites enables you to save your custom settings and use them repeatedly.

To save info cluster settings, click Set as Favorite.

Note:  To clear all information on the Mass Update pane, click Clear.

10 Click Execute to create the records.

11 Select Run Now to execute the action immediately.

You can also select Schedule for Later and specify a date.

12 Click OK.

13 To verify if the action is successful, select Action > Task Monitor from the main menu.

See “Monitoring Tasks” in PAH Online Help.

14 To view the logs of the created action, from the Task Monitor pane, click Show mass create/update
log.

The action type and action details are displayed in the Mass Create/Update Logs dialog box.

• Action Type

Name of the action type executed by the user.

• Module

Name of the module where the cluster of action type is included.

• Info Cluster

Name of the cluster or sub-module where the action type is included.

• Source

Source identification of the created action.

• Destination

Destination identification of the created action.

• Result

Result of the executed action.

• Message

Message displayed based on the result.

• Initiated By

Name of the user who executed the action.

Note:  In the event that mass create is unsuccessful, Mass Create/Update Logs shows the details
of the executed action and the sources of the errors that you may have encountered.

Mass creating style carryovers
1 On the Style Overview panel, right-click a style and select Mass Create Carryover.
2 In the Item Basket section, drag and drop styles for which you intend to create carryovers.

Optionally, you can specify a limit to the number of items that you can drag and drop in this field.
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See Configuring mass create and mass update settings on page 32.

3 Optionally, select the Create with same Style Number check box to retain the same style number.

4 Optionally, select a season from the New Season drop-down list.

5 To specify info clusters that will be updated using information from the source record, select Yes
or No in these fields:

• Overview
• Overview 2
• Colorways
• BOM

Note:  You can specify the specific item in a BOM version that should be added to the info cluster.
• BOO
• Sizes
• Measurements

Note:  Style measurements are dependent on sizes. To update measurements, you must select
Yes in the Size field.

• Patterns
• Markers
• Images
• Care & Content
• Characteristics
• Sourcing
• Costing
• Compliance

Note:  To clear all information on the Mass Create pane, click Clear.
• Follow up

6 Click Execute to create the records.

7 Select Run Now to execute the action immediately.

You can also select Schedule for Later and specify a date.

8 Click OK.

9 To verify if the action is successful, select Action > Task Monitor from the main menu.

See “Monitoring Tasks” in PAH Online Help.

Mass creating style variants
1 On the Style Overview panel, right-click a style and select Mass Create Carryover.
2 In the Item Basket section, drag and drop styles for which you intend to create variants.

Optionally, you can specify a limit to the number of items that you can drag and drop in this field.

See Configuring mass create and mass update settings on page 32.

3 To specify info clusters that will be updated using information from the source record, select Yes
or No in these fields:

• Overview
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• Colorways
• BOM

Note:  You can specify the specific item in a BOM version that should be added to the info cluster.
• Sizes
• Measurements

Note:  Style measurements are dependent on sizes. To update measurements, you must select
Yes in the Size field.

• Images
• Care & Content
• Characteristics
• Sourcing
• Costing
• Follow up
• Compliance

Note:  To clear all information on the Mass Create pane, click Clear.

4 Click Execute to create the records.

5 Select Run Now to execute the action immediately.

You can also select Schedule for Later and specify a date.

6 Click OK.

7 To verify if the action is successful, select Action > Task Monitor from the main menu.

See “Monitoring Tasks” in PAH Online Help.

Mass creating requests for styles
You can create requests for multiple style records.

Creating requests for multiple styles
1 On the Style panel, right-click a style record and click Mass Create Request.
2 To create requests for multiple records, drag and drop records from the Style panel to the Item

Basket in the Request - Mass Create pane.

3 Optionally, select suppliers and size range for each style in the Item Basket.

To select suppliers for a style, click the Supplier cell and select suppliers from the list. Available
options depend on the suppliers that you have associated to the style record.

To select a size range, click the Size Range cell and select a size range from the list. Available
options depend on the ranges that you have associated to the style record.

4 Specify this information:

Request ID
Specify the Request ID.
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Request For
This field is updated automatically with the type of the requested items.

Type
Select a request type. You can define types in Generic Lookup.

Sub Type

Select a request subtype.

You can define request subtypes in Generic Lookup.

Due Date
Select a due date.

Ship to
Specify the delivery address.

Delivery Method

Select a delivery method.

You can define delivery methods in Generic Lookup.

5 Select available reports and click >> to move them to the Selected Reports box.

To remove selected reports, click <<.

6 Optionally, set reports as favorites.

Setting favorites enables you to save your custom settings and use them repeatedly.

To save report settings, click Set as Favorite.

Note:  To clear all information on the Mass Create pane, click Clear.

7 Click Execute.

8 Select Run Now to execute the action immediately.

You can also select Schedule for Later and specify a date.

9 Click OK.

10 To verify if the action is successful, select Action > Task Monitor from the main menu.

See “Monitoring Tasks” in PAH Online Help.

Mass sharing styles to partner suppliers
Share access to styles records with all or selected suppliers.

Sharing styles to multiple suppliers
1 On the Style panel, right-click a record and click Mass Share To Partner.
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You may select multiple styles to share with multiple suppliers.

2 On the Mass Share To Partner dialog box, click the Supplier drop-down list and select a supplier.
Click OK.

Optionally, select the (Select All) check box to share the style to all suppliers.

Note:  When you select multiple styles to share, the Supplier drop-down list displays only the common
supplier for all the selected style records.

3 Click OK.

Integrating styles with ERPs
Specific details of styles created in Infor Fashion PLM can be integrated with Infor ERP systems. In
an integrated setup between Infor Fashion PLM and an ERP, you can import and export product data,
styles, and SKUs.

Style information for importing and exporting from an ERP
This table shows style information that you can import to and export from an ERP:

Exported informationImported information

BuyerStyle Number

PlannerStyle Name

WarehouseDescription

Interface Item Number

Note:  This option generates a new GUID/inter-
face item number to re-export a style. This is op-
tion is disabled after the style is integrated suc-
cessfully with the ERP system.

Integration Status

Make / Buy Code

VAT Code

Gross Weight

Gross Weight UOM

Net Weight

Net Weight UOM

Volume

Volume UOM
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Exported informationImported information

Free Cap Units

Free Cap Units UOM

To view imported and exported style information, open a style record and click the Integration tab.

See the Infor Fashion PLM Connector Toolbox User Guide.

Compliance testing of styles
Compliance tests enable you to verify that the development of a style follows rules and standards, as
prescribed within your company or by an international body in the fashion industy. In Infor Fashion
PLM, you define compliance testing of a style by adding tests or standards that you previously defined
within the application on the Compliance tab.

After defining compliance tests for a style, you can request for compliance tests from your supplier in
Partner Collaboration.

See the Infor Fashion PLM Partner Collaboration User Guide.

Adding compliance tests
Note:  Tests and standards that you drag and drop from the libraries are saved automatically.

1 From the main menu, select Basics > Style and open a style item.

2 On the style details page, click the Compliance tab to display the Performance Testing page.

Add tests from a standard to the Compliance tab
1 From the main menu, open the Standard panel and dock it to any side of the main window.

Alternatively, you can click the Standards icon on the sidebar.

The Performance Testing page of the Compliance tab and the Standard panel are displayed side
by side.

2 Drag and drop a standard to the Performance Testing page of the Compliance tab.

Note:  If you drag a standard that has a different module type or category, a message will appear
in the workbench to confirm the action. Click Yes to continue.

Tests from that standard that are tagged as Mandatory and Default are displayed on the page.

To add specific tests from a standard to the Compliance tab, open a standard details page and drag
and drop tests to the Compliance tab.
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To remove tests from the Compliance tab, right-click a test and select Delete. Deleting mandatory
tests will also delete the entire standard where the mandatory test is included.

To remove a standard from the Compliance tab, right click a test and select Delete Standard. All
tests associated to the selected standard will be removed.

Add tests to the Compliance tab
1 From the main menu, open the Test panel and dock it to any side of the main window.

Alternatively, you can click the Tests icon on the sidebar.

2 Drag and drop tests to the Performance Testing page of the Compliance tab.

Note:  You can also right-click an existing test on the Compliance tab and select Add Test. A window
showing tests that are not included in any standard or tests with Optional priority is displayed. Drag
and drop tests to the Compliance tab.

If you removed tests from a standard in the Compliance tab, you can add them again by right-clicking
and selecting the tests.

Defining compliance tests for a style
After adding tests to the Compliance tab of a style, you must define conditions and requirements that
will serve as the criteria in evaluating test results.

1 On the style details page, click the Compliance tab to display the Performance Testing page.

2 Specify this information:

Operator
Select a condition from the list.
• = requires the test result to be the exact value as the performance requirement.

• < requires the test result to be less than the value that you specify as the performance
requirement.

• > requires the test result to be greater than the value that you specify as the performance
requirement.

• <= requires the test result to be less than or equal to the value that you specify as the performance
requirement.

• >= requires the test result to be greater than or equal to the value that you specify as the
performance requirement.

• <> requires the test result to be greater or less than the value that you specify as the performance
requirement.

• Between requires the test result to be between the value that you specify as the performance
requirement.

Performance Req.
Specify the performance requirement.
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Notes
Specify any additional comments on the compliance test.

Issue Date
Specify an issue date.

Expiry Date
Specify an expiry date.

Attachment
Drag and drop files to the Attachment column to save related files to a test method.

3 Optionally, click the Style/Sourcing icon on the sidebar to view suppliers that are assigned to the
item.

4 From the Style/Sourcing pane, drag and drop suppliers to the Performance Testing page to associate
suppliers to the compliance test.

Test Result and Notes columns are added on the table for each selected color per supplier. If no
color is added, Test Result and Notes columns for each supplier are added to the page.

Note:  The cells on the Test Result column is highlighted in red if the test result does not meet the
required value of the compliance test.

Reports for style
In Infor Fashion PLM, you can create and generate reports that provide specific information about a
style record. These are the available reports that you can create for a style:

• Style Images
• Style Sketches
• Style Artwork
• Sample Measurement
• Style Card
• Measurements
• Bill of Materials
• Style Colorways
• Technical Drawings
• Care & Content
• Style Status Overview
• Construction
• Measurement Images
• Pattern Sheet
• Style Card (External)
• Style Card (Internal)
• Operation

See Generating reports on page 126.
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Archiving style records
Archive style records to organize the Style panel items.

Archiving style records
You may archive style records even if they have dependencies from other sources.

1 On the Style panel, right-click a record and select Archive.

Note:  You may select multiple records to archive.

2 On the Style dialog-box, click Yes.

Restoring archived style records
Restore archived style records through the Manage Archived Records action.

1 Select Admin > Manage Archived Records.

2 On the Manage Archived Records dialog box, specify this information to filter the archived records:

Module
Select Style.

Changed By
Select the user who archived the records.

Date From and Date To
Specify the date or span of date where the records were archived.

3 Click Filter.
4 Right-click a record, then select Restore.

Note:  You may select multiple records to restore.
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Chapter 6: Material

Know how to use the Material feature and learn other related topics.

Managing materials
You can create materials and specify details of material construction in Infor Fashion PLM. You can
create materials using various colors and characteristics that you defined at the version level.

Using the Material feature, you can also define the financial and ownership information, as well as add
related files, associated to your material.

Viewing material records
By default, material records in Infor Fashion PLM are displayed in discrete pages.

To display the records in a single list, clear the Enable Paging check box on the display bar.

Enable material records paging
1 Select Basics > Material.
2 On the display bar at the bottom of the screen, select Enable Paging.

Note:  Enabling material records paging applies per profile.

By default, the Grid Paging Settings is set to display 25 records per page that are sorted by changed
date in descending order.

Configure grid paging settings
1 On the display bar, click Grid Paging Settings.

2 Specify this information:

Infor Fashion PLM User Guide | 235

 

Material



Records per page
Specify the number of records to display per page.

Sort by
Select the default sorting criteria from the list.

Sort direction
Select ascending or descending from the list.

3 Click Save.

Note:  The settings defined on the Grid Paging Settings applies to all users.

Navigate through material record pages
1 On the page number box, specify a page number.

2 Press Enter.
3 Alternatively, click |<, <, >, and >| to display the first, previous, next, and last page respectively.

Creating materials
1 Select Basics > Material.
2 Click the New icon.

3 Specify this information:

Material Number

Specify the material number. The number must be unique.

Two or more items cannot have the same number.

Name
Specify a name for your material.

Description
Specify a brief description.

Main Category

Select a main category from the list.

You can create main categories in Generic Lookup.

Category

Select a category.

You can define categories in Generic Lookup.

Category Group

Select a category group.
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You can define category groups in Generic Lookup.

Material Type

Select a material type from the list.

You can define material types in Generic Lookup.

Season

Select a season.

You can define seasons in Generic Lookup.

Deliveries

Select a delivery type.

You can define delivery types in Generic Lookup.

Copied From
Displays the source record if the material is a copy.

Brand

Select a brand from the list.

You can define brands in Generic Lookup.

Division

Select a division.

You can define divisions in Generic Lookup.

UOM

Select a unit of measure (UOM).

You can define UOMs in Generic Lookup.

User Defined 1

Can pertain to any information or detail.

You can define this field in Generic Lookup.

User Defined 2

Can pertain to any information or detail.

You can define this field in Generic Lookup.

User Defined 3

Can pertain to any information or detail.

You can define this field in Generic Lookup.

User Defined 4

Can pertain to any information or detail.

You can define this field in Generic Lookup.
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User Defined 5

Can pertain to any information or detail.

You can define this field in Generic Lookup.

User Defined 6

Can pertain to any information or detail.

You can define this field in Generic Lookup.

User Defined 7

Can pertain to any information or detail.

You can define this field in Generic Lookup.

Status

Select In Concept, For Approval, Operational, Rejected, or any userdefined status.

Note: 

4 Specify additional information:

Construction

Select a construction type from the list.

You can define construction types in Generic Lookup.

Note:  For knits and woven materials, this field is automatically populated based on the details
specified in the material's Construction tab.

See Defining knit construction on page 246.

See Defining woven construction on page 249.

Finish

Displays the finish.

To define a finish, see Defining knit construction on page 246.

See also Defining woven construction on page 249.

Width / Unit

Specify the width by typing a value in the field and select a unit from the list.

You can define units in Generic Lookup.

Weight / Unit

Specify the weight by typing a value in the field and select a unit from the list.

You can define units in Generic Lookup.

Repeat Height / Unit

Specify the repeat height by typing a value in the field and select a unit from the list.

You can define units in Generic Lookup.

Repeat Width / Unit

Specify the repeat width by typing a value in the field and select a unit from the list.
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You can define units in Generic Lookup.

Critical Material
After saving, all fields and tabs of a material record with anSelect the check box if the material is
critical to a style.

Chemical Warning

Select the check box if the material contains chemicals that require extra care in handling.

Item Type

Select an item type.

You can define item types in Generic Lookup.

HTS Code

Select an HTS code.

You can define HTS codes in Generic Lookup.

Waste
Specify the percentage of waste generated when producing the material.

5 To specify the composition of the material, type a value in the percentage field and select a
component type from the list.

You can define components in Generic Lookup.

Note:  You can specify a layer for the components of your material. If you specify layers for a
component, you must specify layers for all other components of your material. You can define layers
in Generic Lookup.

6 To add an image to the material, drag and drop an image from your local folder to the Images section
of the Overview tab.

7 Specify main sourcing information:

Preferred / Main Supplier

Select a supplier from the list.

The available options are sourcing locations that you have assigned to the material.

See Assigning characteristics to a trim on page 271.

Preferred / Main Supplier Name
Displays the name of the main supplier.

Mill
Select a mill from the list.

Agent
Select an agent from the list.

Country of Origin
Select a country of origin.

Certificate
Specify any certificate information that is applicable to the material.
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User Defined 3

Can pertain to any information or detail.

You can define this field in Generic Lookup.

8 Specify additional sourcing information:

Sample Min. Qty
Specify the minimum quantity.

Sample Price
Specify the sample price.

Unit of Measure
Specify the unit of measure.

Purchase Price / Curr.
Specify the purchase price and currency.
Note:  You can map a cost element to the purchase price.

See Defining cost elements on page 60.

Price Unit of Measure
Specify the unit of measure for the price.

Min. Order Qty
Specify the minimum order quantity.

Min. Order Qty / Color
Specify the minimum order quantity and color.

Lead Time
Specify the lead time.

9 Specify this information:

Colorways
Displays colors that you have associated to the material.

See Assigning colorways to a material on page 244 .

Attachments

Displays files that you have attached to the material.

To attach a file, click Attachments on the toolbar.

Placement
Specify the placement.

Notes
Provide remarks or comments about the material.

Free Field 1
Specify any information in the free fields as additional information.
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Free Field 2
Specify any information in the free fields as additional information.

Date Field 1
To add dates to the notes, select the dates from the Date fields.

Date Field 2
To add dates to the notes, select the dates from the Date fields.

10 In the Miscellaneous Information section, specify if the material is a template item by selecting Yes
or No.

Note:  A template item only serves as a basis for creating materials. It cannot be used and treated
as an actual material.

11 Specify ownership information and main responsibilities:

Note:  If a user is assigned as an owner and the same user is set to inactive status on the Manager
users module, the name of the user will still be displayed on the material record unless the ownership
fields of the record is edited. You can edit ownership information either on the material details page
or on the Material panel. If you edit the ownership information on the Material panel, changes are
automatically saved unless you press Esc on your keyboard.

See “Managing users” in PAH Online Help.

Designer
Select a designer from the list.

Colorist
Select a colorist from the list.

Raw Material Manager
Select a raw material manager from the list.

Responsible
Select a user profile from the list.

Creation Date
Displays the date and time when the material was created.

Changed Date
Displays the date and time when the material was last modified.

Changed By
Displays the user profile that last modified the material.

12 Click Save or Save and Close.

Editing materials
In Infor Fashion PLM, you have two ways to edit materials: normal mode and locked mode. To edit a
material in normal mode, click the Edit icon on the toolbar or right-click a record and select Edit.
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Another way to edit a material is in locked mode. To edit a material in locked mode, open the Material
panel. Right-click a material record and select Edit in Locked Mode.

Editing a record in locked mode opens the details page of a material and enables a search-and-scan
field on the toolbar. By locking materials, you can:

• Browse records seamlessly

Click Previous Record and Next Record to view materials without closing the current material
details page that you are viewing.

• Search for and open records instantly

In the search field, type the material number of the record that you want to edit and press Enter on
your keyboard. This takes you directly to the details page of the material.

• Maintain a consistent view of tabs and panes

Click any tab on the current material details page and open any pane on the sidebar. When you
open the previous or next record, the material is displayed with the same active tab as the previous
material details page.

Deleting materials
1 On the Material panel, select a record and click the Delete icon.

You can also right-click a material and select Delete.

2 To remove multiple materials simultaneously, multiselect materials while pressing Ctrl on your
keyboard.

You cannot delete materials that are associated to other items such as styles.

Adding comments to a material
You can post comments to existing material records, and reply to comments from other users, within
Infor Fashion PLM. Depending on authorities included in your user role, you can also edit and delete
comments. The most recent comments posted across the application will be displayed in the Latest
Comments widget on the home dashboard.

Comments can also be displayed through the List Comment view. This view opens as a new window
and shows all comments in a list format, with the most recent comments on top. The content of this
list depends on the current tab. The List Comment view can show the Context and Hierarchy tabs.

Add comments to a material
1 On the Material panel, select a record and click the Material/Comments icon found on the sidebar.

2 Specify your comment in the given field.
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3 Click Post.
4 Optionally, to update the comments, click the Refresh icon.

Note:  You can add comments on every tab of a material details page. To add comments that are
specific to a tab, open the material details page. Select a tab and click the Material/Comments
icon.

Attach files to a comment
1 From your local computer, drag and drop a file to the Attachment field of a comment.

2 Optionally, to view multiple images attached to a comment, click an image and use the arrow buttons
on your keyboard.

3 Optionally, to view nonimage attachments to a comment, click the Attachment field and select the
file that you want to view.

Note:  You can edit attachments to a comment and save your changes in Infor Fashion PLM. Before
editing attachments, click Refresh in the Comments pane.

4 Optionally, to delete an image, right-click a thumbnail and select Delete.

5 Optionally, to delete nonimage attachments, double-click the Attachment field.

Select the check box of the file and click the Delete icon.

Reply to a comment
1 Select a comment and click Reply.

2 Specify your comment in the given field.

3 Click Post Reply.

Search for a comment
1 Click the Search icon in the Comments pane.

You can also select a comment and press Ctrl+F on your keyboard.

2 Specify a keyword to display comments containing that keyword.

View the comment hierarchy
1 In the Material/Comments pane, click the Hierarchy tab.

2 To view comments on a particular tab, expand the hierarchy view by clicking the drop-down arrow.
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Defining material attributes
Material attributes pertain to properties or features that define a material. In Infor Fashion PLM, material
attributes include:

• Colorways
• Characteristics
• Images
• Sourcing

Note:  You cannot define attributes if the style is already set to Operational.

Assigning colorways to a material
Before assigning colorways to a material, you must first define colors, color palettes, and materials.

See these links for reference:

• Creating colors on page 52
• Creating color palettes on page 58
• Creating materials on page 236

1 From the main menu, open the Color Overview panel and dock it to any side of the main window.

2 From the Color Overview panel, drag and drop a colorway to the Colorway tab of a material record.

3 To set a colorway as the main color, select a colorway and click the cell before the Color column.

A main color is used as the default color in lab dip requests.

Note:  When you include a colorway in a labdip request for material, you can view the labdip request
information for that colorway by opening the Colorways tab of the material details page. Click the
arrow beside the color to view request details.

A green mark appears on the cell, identifying the colorway as the main color.

4 To see colorways assigned to a material, select a material record and click the Material/Colorways
icon on the sidebar.

Note:  You can also assign color palettes to a material. Open the Color Palette panel from the Basics
menu and perform the same steps. Optionally, you can add or link the colorway to the color library.
Right-click a colorway and select Add to Library to add on-the-fly colors to the color library. To
update the color information in material to sync with the color library information, right-click a colorway
and select Link to Library.

To remove a colorway assigned to a material, go to the Colorway tab of the material record. Right-click
a colorway and select Delete.

Assigning care symbols to a material
Before assigning care instructions to a material, you must first define care symbols.
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See Adding care symbols on page 49.

1 On the materials details page, open the Care tab.

2 From the main menu, select Basics > Care and dock the Care panel to any side of the main window.

3 Drag and drop a care symbol from the Care panel to the Care tab.

4 Click Save or Save and Close.

To remove a care symbol assigned to a material, open the Care tab of the material record. Select
a care symbol and press Delete on your keyboard.

Assigning characteristics to a material
Before assigning characteristics to a material, you must first define characteristics and materials.

See Creating characteristics on page 50.

See Creating materials on page 236.

1 From the main menu, open the Characteristic panel and dock it to any side of the main window.

2 From the Characteristic panel, drag and drop a characteristic to a record on the Material panel.

Note:  You can only drag and drop characteristics that have Material as the type.

To see characteristics assigned to a material, select a material and click the Material/Characteristics
icon on the sidebar.

You can retrieve your defined characteristics and assign them to a material. You can define various
characteristics using the Characteristics feature and store them in a repository for later use.

To remove a characteristic from the material, open the Material/Characteristic pane. Right-click a
characteristic and select Delete.

Assigning sourcing to a material
In Infor Fashion PLM, you can identify a sourcing location or multiple sourcing locations of a material.

Before assigning sourcing to a material, you must first define sourcing locations and materials.

See Defining sourcing locations on page 95.

See Creating materials on page 236.

1 From the main menu, open the Sourcing panel and dock it to any side of the main window.

2 From the Sourcing panel, drag and drop a sourcing record to a material record in the Material panel.

To assign multiple sourcing records to a material simultaneously, select two or more sourcing records
while pressing Ctrl on your keyboard. Drag and drop the sourcing records to a material record in
the Material panel.

3 To view assigned suppliers to a material, open the material item and click the Material/Sourcing
icon on the sidebar or right click a material record on the Material panel and select Sourcing.
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Note:  You can also assign sourcing to a material by dragging and dropping a sourcing record to
the Material/Sourcing pane of a material item.

4 Optionally, to set the preferred/main supplier for a material item, right-click a supplier in the
Material/Sourcing pane and select Set as Main Supplier.
Note:  You can also set the Preferred/Main Supplier on the Overview tab of the material details
page under Main Sourcing Information section.

5 Optionally, to enable a supplier to view details of the material item in Partner Collaboration, select
the Share to Partner check box in the Material/Sourcing pane.

Material/Where Used
The Material/Where Used function enables you to track products that use a specific material. To view
where a material has been used, select a material record and click the Material/Where Used icon on
the sidebar. You can also open a material record and click the Where Used tab.

Specifying material construction
In Infor Fashion PLM, you can provide detailed information on how your material is constructed.

Depending on whether you choose knit or woven as your category, the Material feature provides a
basic construction page that displays the appropriate construction details.

Note:  You must first save the material before defining construction.

In Infor Fashion PLM, material construction is available only if the category is knit or woven.

Defining knit construction
1 On the material details page, click the Construction tab.

2 Specify this information:

Category
Displays Knit as the material category.

Category Group

Select a category group.

If you have already defined the category group on the Overview tab, this field will display that value.

You can define category groups in Generic Lookup.

Courses
Specify the courses in the knit construction.
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Wales
Specify the wales in the knit construction.

Gauge
Specify the gauge in the knit construction.

Shrinkage Length
Specify a value for the shrinkage length.

Shrinkage Width
Specify a value for the shrinkage width.

Width / Unit

Specify a value in the width field and the unit used.

If you have already defined the width/unit on the Overview tab, this field will display that value.

Cuttable Width

Specify a value in the cuttable width field and the unit used.

You can define cuttable width units in Generic Lookup.

Weight / Unit

Specify a value for the weight and specify the unit used.

If you have already defined the weight/unit in the Overview tab, this field will display that value.

Before Wash Net Weight
Specify a value and specify the unit used.

After Wash Net Weight
Specify a value and specify the unit used.

Repeat Height/Unit
Specify a value and specify the unit used.

Repeat Width/Unit
Specify a value and specify the unit used.

Construction
Displays the construction type that you specified on the Overview tab.

Composition

Displays the components and their corresponding percentage in the material.

Composition is defined on the Overview tab.

Responsible
Displays the responsible user profile that you specify on the Overview tab.

Creation Date
Displays the date and time when the material was created.
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Changed Date
Displays the date and time when the material was last modified.

Changed By
Displays the user profile that last modified the material.

3 In the Finish section, select a finish type from the list.

You can define finish types in Generic Lookup.

You can also select Click here to add a new row to create a finish type.

4 Specify construction details:

Work Center
Specify a work center.

Time Estimate
Specify the time estimate to complete the finish.

UOM

Specify the unit of measure.

You can define units of measure in Generic Lookup.

Cost
Specify a value to specify the cost.

Currency
Specify the currency.

5 Click Save.

Define yarn construction
1 On the Construction tab, click the Yarn sub tab to display the Yarn Table tab.

2 Specify this information:

Yarn Size
Specify the yarn size.

Yarn Size-Fill
Specify the yarn size-fill

Yarn Type

Select a yarn type.

You can define yarn types in Generic Lookup.

Yarn Dyeing Method

Select a yarn dyeing method.

You can define yarn dyeing methods in Generic Lookup.
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3 Specify the spun yarn details in the Spun table.

4 Specify filament yarn details in the Filament table.

5 Specify spun and filament yarn details in the Spun & Filament table.

6 Click Save or Save and Close.

Defining woven construction
1 On the material details page, click the Construction tab.

2 Specify construction details:

Category
Displays Woven as the material category.

Category Group

Select a category group.

If you have already defined the category group on the Overview tab, this field displays that value.

You can define category groups in Generic Lookup.

Warp Count
Specify the warp count in the woven construction.

Yarn Type
Specify the yarn type for the warp.

Weft Count
Specify the weft count in the woven construction.

Yarn Type
Specify the yarn type for the weft.

Shrinkage Length
Specify a value for the shrinkage length.

Shrinkage Width
Specify a value for the shrinkage width.

Width / Unit

Specify a value in the width field and the unit used.

If you have already defined the width/unit in the Overview tab, this field displays that value.

Cuttable Width

Specify a value in the cuttable width field and the unit used.

You can define cuttable width units in Generic Lookup.

Weight / Unit

Specify a value for the weight and specify the unit used.
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If you have already defined the weight/unit in the Overview tab, this field displays that value.

Before Wash Net Weight
Specify a value and specify the unit used.

After Wash Net Weight
Specify a value and specify the unit used.

Repeat Height/Unit
Specify a value and specify the unit used.

Repeat Width/Unit
Specify a value and specify the unit used.

Construction

Displays the construction type that you specified on the Overview tab.

Composition

Displays the components and their corresponding percentage in the material.

Composition is defined in the Overview tab.

Responsible
Displays the responsible user profile that you specify in the Overview tab.

Creation Date
Displays the date and time when the material was created.

Changed Date
Displays the date and time when the material was last modified.

Changed By
Displays the user profile that last modified the material.

3 In the Finish section, select a finish type from the list.

You can define finish types in Generic Lookup.

You can also select Click here to add a new row to create a finish type.

4 Specify this information:

Finish Type

Select a finish type.

You can define finish types in Generic Lookup.

Work Center
Specify a work center.

Time Estimate
Specify the time estimate to complete the finish.

UOM
Specify the unit of measure.
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Cost
Type a value to specify the cost.

Currency
Specify the currency.

5 Click Save.

Define yarn construction
1 On the Construction tab, click the Yarn sub tab to display the Yarn Table tab.

2 Specify this information:

Yarn Size
Specify the yarn size.

Yarn Size-Fill
Specify the yarn size-fill.

Yarn Type

Select a yarn type.

You can define yarn types in Generic Lookup.

Yarn Dyeing Method

Select a yarn dyeing method.

You can define yarn dyeing methods in Generic Lookup.

3 Specify the spun yarn details in the Spun table.

4 Specify filament yarn details in the Filament table.

5 Specify spun and filament yarn details in the Spun & Filament table.

6 Click Save or Save and Close.

Modifying Material Overview layout
For existing material records, you can reorder, regroup, or hide selected fields or groups of fields in
the Material Overview panel by using the Module Designer.

1 Select Basics > Material.
2 Select a material record and click Edit.
3 Click the Module Designer icon found on the sidebar.

4 To create a new layout, click New and specify a layout name.

To edit an existing layout, select a layout on the Available Layouts list.

5 Specify this information:
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Brand
Select a brand from the list.

Category
Select applicable categories from the list.

6 To apply the layout to specific roles, click Roles and select the roles on the dialog box.

Note:  You must first save the layout to enable the Roles button. To save the layout, click Update.

7 To enable editing of the selected layout, select Open Edit Mode.

8 Pause on the New items icon on the upper leftmost corner of the Material Overview pane.

9 Drag and drop items to add them to the layout and use the editing tool bar to adjust the position,
height, width, alignment, naming, and spacing of added grouping options in the layout.

10 To edit existing items on the layout, select a field or group and then apply the necessary changes
by using the editing tool bar.

Note:  You can also drag and drop fields or groups.

11 To save the changes, click Update on the Module Designer pane.

12 To activate the layout, select Active.

Note:  You can activate multiple layouts. Active multiple layouts are unique for each brand and
category combination.

If a user-defined layout is created with the same settings as the default layout, the user-defined
layout will be applied. The default layout cannot be set as Inactive. For each Brand and Category
combination, you can set up duplicate layouts but only one layout can be activated.

13 To stop editing, clear Open Edit Mode.

Creating materials from existing materials
In Infor Fashion PLM, you can create multiple materials simultaneously by using info clusters. Info
clusters are sets of data from existing records that you can reuse to mass create new materials.

Mass creating materials
1 In the Material Overview panel, click Mass Create.

2 Specify info cluster details:

Template Item
Select Yes or No.
Note:  A template item only serves as a basis for creating materials. It cannot be used and treated
as an actual material.

Number Prefix

Specify a code.

Infor Fashion PLM User Guide | 252

 

Material



The code must be unique. Two or more items cannot have the same code.

Material Name
Specify a name.

Description
Specify a brief description.

No. of Item

Specify the number of items to be created.

Optionally, you can specify a limit to the number of items that can be created.

See Configuring mass create and mass update settings on page 32.

Single Source
Select Yes or No.
Note:  A source record supplies the data in an info cluster. A source record can pertain to an actual
style, material, or trim in Infor Fashion PLM or to a style, material, or trim template.

3 To specify info clusters that will be updated using information from the source record, select Yes
or No in these fields.

• Overview
• Colorways
• Construction
• Care
• Compliance
• Characteristics
• Sourcing

4 To identify the source record for each info cluster, drag and drop a material from the Material panel
to the Source column.

5 Optionally, set info clusters as favorites.

Setting favorites enables you to save your custom settings and use them repeatedly.

To save info cluster settings, click Set as Favorite.

Note:  To clear all information on the Mass Create pane, click Clear.

6 Click Execute to create the records.

7 Select Run Now to execute the action immediately.

You can also select Schedule for Later and specify a date.

8 Click OK.

9 To verify if the action is successful, select Action > Task Monitor on the main menu.

See “Monitoring Tasks” in the PAH Online Help.
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Mass updating materials
In Infor Fashion PLM, you can change and update information on multiple materials simultaneously to
speed up process around changes.

1 On the Material panel, right-click a record and select Mass Update.

2 To specify the number of source records, select Yes or No in the Single Source list.

Note:  A source record supplies the data in an info cluster. A source record can pertain to an actual
style, material, or trim in Infor Fashion PLM or to a style, material, or trim template. Selecting No
enables you to use multiple materials as source records.

3 To update records simultaneously, drag and drop styles from the Material panel to the Item Basket
in the Material - Mass Update pane.

Optionally, you can specify a limit to the number of items that you can drag and drop in this field.

See Configuring mass create and mass update settings on page 32.

4 To customize your info cluster settings, specify the info clusters that will be updated by selecting
Yes or No.

• Overview
• Colorways
• Construction
• Care
• Compliance
• Characteristics
• Sourcing

5 To identify the source record for each info cluster, drag and drop a style from the Material panel to
the Source column.

6 Select Add to combine information from the source record with existing data in the material.

You can also select Replace to substitute existing data in the material with information from the
source record.

7 Optionally, set info clusters as favorites.

Setting favorites enables you to save your custom settings and use them repeatedly.

To save info cluster settings, click Set as Favorite.

Note:  To clear all information on the Mass Update pane, click Clear.

8 Click Execute to create the records.

9 Select Run Now to execute the action immediately.

You can also select Schedule for Later and specify a date.

10 Click OK.

11 To verify if the action is successful, select Action > Task Monitor on the main menu.

See “Monitoring Tasks” in the PAH Online Help.
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Mass replacing materials in BOM
In Infor Fashion PLM, you can simultaneously replace materials in multiple BOMs to speed up process
around changes.

1 On the Material panel, right-click a material record and click the Mass Replace in BOM.

You can also multiselect material records.

2 To know in which style the selected material is used, click the Material/Where Used icon on the
side bar.

3 On the Material - Mass Replace in BOM pane, specify this information:

Style Status
Select status from the list.

Single Source
Select to replace the materials with a single source.

4 Drag and drop a material from the Material panel to the Replace with column on the Materials to
Replace table.

Note:  To set the Replace with value individually for each material, ensure that Single Source is
cleared and then select the row of the desired material before dragging and dropping a material to
the Replace with column on the Materials to Replace table.

If you drag and drop a material on any space outside the Replace with column, a new row is added
on Materials to Replace table.

5 From the Material/Where Used pane, select styles and then drag and drop the styles to the Style
column on the Materials to Replace table.

6 Optionally, under the Replace in column, select the BOM versions for each style.

7 Click Execute.

8 Select Run Now to execute the action immediately.

You can also Schedule for Later and specify a date.

9 Click OK.

10 To verify if the action is successful, select Action > Task Monitor on the main menu.

See “Monitoring Tasks” in the PAH Online Help.

Mass creating requests for materials
Note:  Mass creating requests for a material applies to lab dips only.

Creating requests for multiple materials
1 On the Material panel, right-click a material record and click the Mass Create Request.
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2 To create requests for multiple records, drag and drop records from the Material panel to the Item
Basket in the Request - Mass Create pane.

3 You can select multiple suppliers for each material in the Item Basket.

To select suppliers for a material, click the Supplier cell and select suppliers from the list.

Available options depend on the suppliers that you have associated to the material record.

4 To specify request details, specify this information:

Request ID
Specify the Request ID.

Request For
This field is updated automatically with the type of the requested items.

Type

Select a request type.

You can define types in Generic Lookup.

Sub Type

Select a request sub type.

You can define request sub types in Generic Lookup.

Due Date
Select a due date.

Ship to
Specify the delivery address.

Delivery Method

Select a delivery method.

You can define delivery methods in Generic Lookup.

5 Select available reports and click >> to move them to the Selected Reports box.

To remove selected reports, click <<.

6 Optionally, set reports as favorites.

Setting favorites enables you to save your custom settings and use them repeatedly.

To save report settings, click Set as Favorite.

Note:  To clear all information on the Mass Create pane, click Clear.

7 Click Execute.

8 Select Run Now to execute the action immediately.

You can also select Schedule for Later and specify a date.

9 Click OK.

10 To verify if the action is successful, select Action > Task Monitor on the main menu.

See “Monitoring Tasks” in the PAH Online Help.
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Mass sharing materials to partner suppliers
Share access to material records with all or selected suppliers.

Sharing materials to multiple suppliers
1 On the Material panel, right-click a record and click Mass Share To Partner.

You may select multiple materials to share with multiple suppliers.

2 On the Mass Share To Partner dialog box, click the Supplier drop-down list and select a supplier.
Click OK.

Optionally, select the (Select All) check box to share the style to all suppliers.

Note:  When you select multiple materials to share, the Supplier drop-down list displays only the
common supplier for all the selected style records.

3 Click OK.

Compliance testing of materials
Compliance tests enable you to verify that the development of a material follows rules and standards,
as prescribed within your company or by an international body in the fashion industry. In Infor Fashion
PLM, you define compliance testing of a material by adding tests or standards that you previously
defined within the application on the Compliance tab.

After defining compliance tests for a material, you can request for compliance tests from your supplier
in Partner Collaboration.

See the Infor Fashion PLM Partner Collaboration User Guide.

Adding compliance tests
Note:  Tests and standards that you drag and drop from the libraries are saved automatically.

1 Select Basics > Material and open a material item..

2 On the material details page, click the Compliance tab to display the Performance Testing page.

Add tests from a standard to the Compliance tab
1 From the main menu, open the Standard panel and dock it to any side of the main window.

Alternatively, you can click the Standards icon on the sidebar.
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2 Drag and drop a standard to the Performance Testing page of the Compliance tab.

Note:  If you drag a standard that has a different module type or category, a message will appear
in the workbench to confirm the action. Click Yes to continue.

Tests from that standard that are tagged as Mandatory and Default are displayed on the page.

To add specific tests from a standard to the Compliance tab, open a standard details page and drag
and drop tests to the Compliance tab.

To remove tests from the Compliance tab, right-click a test and select Delete. Deleting mandatory
tests will also delete the entire standard where the mandatory test is included.

To remove a standard from the Compliance tab, right click a test and select Delete Standard. All
tests associated to the selected standard will be removed.

Add tests to the Compliance tab
1 From the main menu, open the Test panel and dock it to any side of the main window.

Alternatively, you can click the Tests icon on the sidebar.

2 Drag and drop tests to the Performance Testing page of the Compliance tab.

Note:  You can also right-click an existing test on the Compliance tab and select Add Test. A window
showing tests that are not included in any standard or tests with Optional priority is displayed. Drag
and drop tests to the Compliance tab.

If you removed tests from a standard in the Compliance tab, you can add them again by right-clicking
and selecting the tests.

Defining compliance tests for a material
After adding tests to the Compliance tab of a material, you must define conditions and requirements
that will serve as the criteria in evaluating test results.

1 On the material details page, click the Compliance tab to display the Performance Testing page.

2 Specify this information:

Operator
Select a condition from the list.
• = requires the test result to be the exact value as the performance requirement.
• < requires the test result to be less than the value that you specify as the performance

requirement.
• > requires the test result to be greater than the value that you specify as the performance

requirement.
• <= requires the test result to be less than or equal to the value that you specify as the performance

requirement.
• >= requires the test result to be greater than or equal to the value that you specify as the

performance requirement.
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• <> requires the test result to be greater or less than the value that you specify as the performance
requirement.

• Between requires the test result to be between the value that you specify as the performance
requirement.

Performance Req.
Specify the performance requirement.

Notes
Provide any additional comments on the compliance test.

Issue Date
Specify an issue date.

Expiry Date
Specify an expiry date.

Attachment
Drag and drop files to the Attachment column to save related files to a test method.

3 Optionally, click the Material/Sourcing icon on the sidebar to view suppliers that are assigned to
the item.

4 From the Material/Sourcing pane, drag and drop a supplier to the Performance Testing page to
associate a supplier to the compliance test.

Test Result and Notes columns are added on the table for each selected color per supplier. If no
color is added, Test Result and Notes columns for each supplier are added to the page.

Note:  The cells on the Test Result column is highlighted in red if the test result does not meet the
required value of the compliance test.

Reports for a material
In Infor Fashion PLM, you can create and generate reports that provide specific information about a
material. These are the available reports that you can create for a material:

• Lab Dip Request
• Material Card
• Material Overview

See Generating reports on page 126.

Archiving material records
Archive material records to organize the Material panel items.
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Archiving material records
You may archive material records even if they have dependencies from other sources.

1 On the Material panel, right-click a record and select Archive.

Note:  You may select multiple records to archive.

2 On the Material dialog-box, click Yes.

Restoring archived material records
Restore archived material records through the Manage Archived Records action.

1 Select Admin > Manage Archived Records.

2 On the Manage Archived Records dialog box, specify this information to filter the archived records:

Module
Select Material.

Changed By
Select the user who archived the records.

Date From and Date To
Specify the date or span of date where the records were archived.

3 Click Filter.
4 Right-click a record, then select Restore.

Note:  You may select multiple records to restore.

Infor Fashion PLM User Guide | 260

 

Material



Chapter 7: Trim

Know how to use the Trim feature and learn other related topics.

Trims are applied ornaments to fashion apparel. By using Infor Fashion PLM, you can manage the
development of trim specifications. You can create trims using various colors, sizes, and characteristics.

Using the Trim feature, you can also define the financial and ownership information, as well as add
related files, associated to your trim.

Managing trims
You create a new trim by assigning various colors, sizes, characteristics, and extra details that you
defined at the version level.

Viewing trim records
By default, trim records in Infor Fashion PLM are displayed in discrete pages.

To display the records in a single list, clear the Enable Paging check box on the display bar.

Enable trim records paging
1 Select Basics > Trim.

2 On the display bar at the bottom of the screen, select Enable paging.

Note:  Enabling trim records paging applies per profile.

By default, the Grid Paging Settings is set to display 25 records per page that are sorted by changed
date in descending order.

Configure grid paging settings
1 On the display bar, click Grid Paging Settings.
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2 Specify this information:

Records per page
Specify the number of records to display per page.

Sort by
Select the default sorting criteria from the list.

Sort direction
Select ascending or descending from the list.

3 Click Save.

Note:  The settings defined on the Grid Paging Settings applies to all users.

Navigate through trim record pages
1 On the page number box, specify a page number.

2 Press Enter.
3 Alternatively, click |<, <, >, and >| to display the first, previous, next, and last page respectively.

Creating trims
1 Select Basics > Trim.

2 Click the New icon.

3 Specify main trim information:

Trim Number

Specify the trim number.

The number must be unique. Two or more items cannot have the same number.

Name
Specify a name for the trim.

Description
Specify a brief description.

Main Category
Select Generic, Label, or Embroidery.

Category

Select a category.

You can define categories in Generic Lookup.

Category Group

Select a category group.
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You can define trim category groups in Generic Lookup.

Material Type

Select a material type.

You can define material types in Generic Lookup.

Season

Select a season.

You can define seasons in Generic Lookup

Deliveries

Select a delivery method from the list.

You can define delivery methods in Generic Lookup.

Copied From
Displays the source record if the trim is a copy.

Brand

Select a brand.

You can define brands in Generic Lookup.

Division
Specify a division.

UOM

Select a unit of measure (UOM) from the list.

You can define UOMs in Generic Lookup.

User Defined Field 1

Can pertain to any information or detail.

You can define this field in Generic Lookup.

User Defined Field 2

Can pertain to any information or detail.

You can define this field in Generic Lookup.

User Defined Field 3

Can pertain to any information or detail.

You can define this field in Generic Lookup.

User Defined Field 4

Can pertain to any information or detail.

You can define this field in Generic Lookup.

User Defined Field 5

Can pertain to any information or detail.
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You can define this field in Generic Lookup.

User Defined Field 6

Can pertain to any information or detail.

You can define this field in Generic Lookup.

User Defined Field 7

Can pertain to any information or detail.

You can define this field in Generic Lookup.

Status

Select a userdefined status.

4 Specify additional information:

Construction

Select a construction type.

You can define construction types in Generic Lookup.

Finish

Select a trim finish.

You can define finish types in Generic Lookup.

Width / Unit

Specify the width by typing a value in the field and select a unit from the list.

You can define units in Generic Lookup.

Height / Unit

Specify the height by typing a value in the field and select a unit from the list.

You can define units in Generic Lookup.

Length / Unit

Specify the length by typing a value in the field and select a unit from the list.

You can define units in Generic Lookup.

Weight / Unit

Specify the weight by typing a value in the field and select a unit from the list.

You can define units in Generic Lookup.

Critical Material
Select the check box if the material is critical to a trim.

Chemical Warning

Select the check box if the trim contains chemicals that require extra care in handling.

Item Type

Select an item type.
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You can define item types in Generic Lookup.

HTS Code

Select an HTS code.

You can define HTS codes in Generic Lookup.

Waste
Specify the percentage of waste generated when producing the trim.

5 To specify the composition of the trim, specify a value in the percentage field and select a component
type from the list.

You can define components in Generic Lookup.

6 To add an image to the trim, drag and drop an image from your local folder to the Images section
of the Overview tab.

7 Specify main sourcing information:

Preferred / Main Supplier

Select a supplier from the list.

The available options are sourcing locations that you have assigned to the material.

See Assigning characteristics to a trim on page 271.

Preferred / Main Supplier Name
Displays the name of the main supplier.

Mill
Select a mill from the list.

Agent
Select an agent from the list.

Country of Origin
Select a country of origin.

8 Specify additional sourcing information:

Sample Min. Qty
Specify the minimum quantity.

Sample Price
Specify the sample price.

Unit of Measure
Specify the unit of measure.

Purchase Price / Curr.
Specify the purchase price and currency.
Note:  You can map a cost element to the purchase price.

See Defining cost element properties on page 62.
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Price Unit of Measure
Specify the unit of measure for the price.

Min. Order Qty
Specify the minimum order quantity.

Min. Order Qty / Color
Specify the minimum order quantity and color.

Lead Time
Identify the lead time.

9 Specify this information:

Colorways
Displays the colors that you have associated to the trim.

See Assigning colorways to a trim on page 270.

Size
Displays the sizes that you have associated to the trim.

See Assigning sizes to a trim on page 270.

Attachments

Displays the files that you have attached to the trim.

To attach a file, click Attachments on the toolbar.

Placement
Specify the placement.

Notes
Provide remarks or comments about the trim.

Free Field 1
Specify any information in the free field as additional information.

Free Field 2
Specify any information in the free field as additional information.

Date Field 1
Specify a date that is pertinent to the trim.

Date Field 2
Specify a date that is pertinent to the trim.

10 In the Miscellaneous Information section, specify if the trim is a template item by selecting Yes or
No.

Note:  A template item only serves as a basis for creating trims. It cannot be used and treated as
an actual trim.

11 Specify ownership and main responsibilities information:
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Note:  If a user is assigned as an owner and the same user is set to inactive status on the Manager
users module, the name of the user will still be displayed on the trim record unless the ownership
fields of the record is edited. You can edit ownership information either on the trim details page or
on the Trim panel. If you edit the ownership information on the Trim panel, changes are automatically
saved unless you press Esc on your keyboard.

See “Managing users” in the PAH Online Help.

Designer
Select a designer from the list.

Colorist
Select a colorist from the list.

Trim Manager
Select a trim manager from the list.

Responsible
Select a user profile from the list.

Creation Date
Displays the date and time when the trim was created.

Changed Date
Displays the date and time when the trim was last modified.

Changed By
Displays the user profile that last modified the trim.

12 Click Save or Save and Close.

Editing trims
In Infor Fashion PLM, you have two ways to edit main trims: normal mode and locked mode. To edit
a trim in normal mode, click the Edit icon on the toolbar or right-click a record and select Edit.

Another way to edit a trim is in locked mode. To edit a trim in locked mode, open the Trim panel.
Right-click a trim record and select Edit in Locked Mode.

Editing a record in locked mode opens the details page of a trim and enables a search-and-scan field
on the toolbar. By locking trims, you can:

• Browse records seamlessly.

Click Previous Record and Next Record to view trims without closing the current trim details page
that you are viewing.

• Search for and open records instantly.

In the Search field, type the trim number of the record that you want to edit and press Enter on your
keyboard. This takes you directly to the details page of the trim.

• Maintain a consistent view of tabs and panes.
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Click any tab on the current trim details page and open any pane in the sidebar. When you open
the previous or next record, the trim is displayed with the same active tab as the previous trim details
page.

Deleting trims
1 Select a trim record and click the Delete icon.

You can also right-click a trim and select Delete.

2 To remove multiple trims simultaneously, multiselect trims while pressing Ctrl on your keyboard.

Note:  You cannot delete trims that are associated to other items such as styles.

Adding comments to a trim
You can post comments to existing trim records, and reply to comments from other users, within Infor
Fashion PLM. Depending on authorities included in your user role, you can also edit and delete
comments. The most recent comments posted across the application will be displayed in the Latest
Comments widget on the home dashboard.

Comments can also be displayed through the List Comment view. This view opens as a new window
and shows all comments in a list format, with the most recent comments on top. The content of this
list depends on the current tab. The List Comment view can show the Context and Hierarchy tabs.

1 On the Trim panel, select a record and click the Trim/Comments icon found on the sidebar.

2 Specify your comment in the given field.

3 Click Post.
4 Optionally, to update the comments, click the Refresh icon.

Note:  You can add comments on every tab of a trim details page. To add comments that are specific
to a tab, open the trim details page. Select a tab and click the Trim/Comments icon.

Attach files to a comment
1 From your local computer, drag and drop a file to the Attachment field of a comment.

If the file that you have attached is an image, a thumbnail of that image is displayed.

If the file that you have attached is not an image, the Attachment field is updated with the number
of files in the comment.

2 Optionally, to view multiple images attached to a comment, click an image and use the arrow buttons
on your keyboard.

3 Optionally, to view nonimage attachments to a comment, click the Attachment field and select the
file that you want to view.
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Note:  You can edit attachments to a comment and save your changes in Infor Fashion PLM. Before
editing attachments, click Refresh in the Comments pane.

4 Optionally, to delete an image, right-click a thumbnail and select Delete.

5 Optionally, to delete nonimage attachments, double-click the Attachment field.

Select check box of the file and click the Delete icon.

Reply to a comment
1 Select a comment and click Reply.

2 Specify your comment in the given field.

3 Click Post Reply.

Search for a comment
1 Click the Search icon in the Comments pane.

You can also select a comment and press Ctrl+F on your keyboard.

2 Specify a keyword to display comments containing that keyword.

View the comment hierarchy
1 In the Trim/Comments pane, select the Hierarchy tab.

2 To view comments on a particular tab, expand the hierarchy view by clicking the drop-down arrow.

Defining trim attributes
Trim attributes pertain to properties or features that define a trim. In Infor Fashion PLM, trim attributes
include:

• Sizes
• Colorways
• Characteristics
• Sourcing
• Extra details

Note:  You cannot define attributes if the style is already set to Operational.
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Assigning sizes to a trim
You can retrieve your defined sizes and assign them to a trim. You can define various sizes using the
Size feature and store them in a repository for later use.

Before assigning sizes to a trim, you must first define sizes and trims.

See Creating sizes on page 92.

See Creating trims on page 262.

1 From the Setup menu, open the Size Range panel and dock it to any side of the main window.

2 From the Size Range panel, drag and drop a size range to the Size tab of a trim record.

3 To remove a size range assigned to a trim, go to the Size tab of the trim record.

Right-click a size and select Delete.

Assigning colorways to a trim
You can assign colorways to a trim or to any aggregate level in your product hierarchy values.

Before you start assigning colorways to a trim, you must first define colors, color palettes, and trims.

See these topics for reference:

• Creating colors on page 52
• Creating color palettes on page 58
• Creating trims on page 262

1 From the Setup menu, open the Color Overview panel and dock it to any side of the main window.

2 From the Color Overview panel, drag and drop a colorway to the Colorway tab of a trim record.

3 To see colorways assigned to a trim, select a trim record and click the Trim/Colorways icon on the
sidebar.

Note:  You can also assign color palettes to a trim. Open the Color Palette panel from the Basics
menu and perform the same steps.

Optionally, you can add or link the colorway to the color library. Right-click a colorway and select
Add to Library to add on-the-fly colors to the color library.

To update the color information in style to sync with the color library information, right-click a colorway
and select Link to Library.

To remove a colorway assigned to a trim, go to the Colorway tab of the trim record. Right-click a
colorway and select Delete.

Assigning care symbols to a trim
Before assigning care symbols to a trim, you must first define care symbols.
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See Adding care symbols on page 49.

1 On the trim details page, open the Care tab.

2 From the main menu, select Basics > Care and dock the Care panel to any side of the main window..

3 Drag and drop a care symbol from the Care panel to the Care tab.

4 Click Save or Save and Close.

To remove a care symbol assigned to a trim, open the Care tab of the trim record. Select a care
symbol and press Delete on your keyboard.

Assigning characteristics to a trim
Before you start assigning characteristics to a trim, you must first define characteristics and trims.

See Creating characteristics on page 50.

See Creating trims on page 262.

1 Open the Characteristic panel and dock it to any side of the main window.

2 From the Characteristic panel, drag and drop a characteristic to a trim record.

Note:  You can only drag and drop characteristics that have Trim as the type.

To see characteristics assigned to a trim, select a trim and click the Trim/Characteristics icon on
the sidebar.

You can retrieve your defined characteristics and assign them to a trim. You can define various
characteristics using the Characteristics feature and store them in a repository for later use.

To remove a characteristic from the trim, open the Trim/Characteristic pane. Right-click a
characteristic and select Delete.

Assigning sourcing to a trim
In Infor Fashion PLM, you can identify a sourcing location or multiple sourcing locations of a trim.

Before you start assigning sourcing to a trim, you must first define sourcing locations and trims.

See Creating trims on page 262.

See Defining sourcing locations on page 95.

1 Open the Sourcing panel and dock it to any side of the main window.

2 From the Sourcing panel, drag and drop a sourcing record to a trim.

To assign multiple sourcing records to a trim simultaneously, select two or more sourcing records
while pressing Ctrl on your keyboard. Drag and drop the records to a trim.

3 To see sourcing assigned to a trim, right-click a trim record and select Sourcing or click
Trim/Sourcing icon on the sidebar.
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Defining extra details
You can identify extra details for embroidery trims in Infor Fashion PLM.

1 On the trim details page, open the Extra Details tab.

2 Specify art details:

Repeat Type

Select a repeat type.

You can define repeat types in Generic Lookup.

Repeat Height
Specify the repeat height.

Repeat Width
Specify the repeat width.

# of Colors
Specify the number of colors to be used in the trim.

Placement
Displays the placement that you specified on the Overview tab.

3 Specify embroidery details:

Backing

Select the embroidery backing.

You can define embroidery backing in Generic Lookup.

Count
Provide the count of the trim.

Size
Specify the size.

Finish
Specify the finish.

Fiber Content
Specify the fiber content.

Type

Specify the type.

You can define the embroidery construction type in Generic Lookup.

Count
Specify the count.

Location
Specify the location.
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4 Specify print details:

Print Method

Select a printing method.

You can define printing methods in Generic Lookup.

Print Type

Select a printing type.

You can define printing types in Generic Lookup.

5 Click Save or Save and Close.

Trim/Where Used
The Trim/Where Used function enables you to track products that use a specific trim.

To view where a trim has been used, select a trim record and click the Trim/Where Used icon on the
sidebar. You can also open a trim record and click the Where Used tab.

Creating trims from existing trims
In Infor Fashion PLM, you can create multiple trims simultaneously by using info clusters. Info clusters
are sets of data from existing records that you can reuse to mass create new trims.

Mass creating trims
1 On the Trim Overview panel, click Mass Create.

2 Specify info cluster details:

Template Item
Select Yes or No.
Note:  A template item only serves as a basis for creating trims. It cannot be used and treated as
an actual trim.

Number Prefix
Specify a code.

Trim Name
Specify a name.

Description
Specify a brief description.
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No. of Item

Specify the number of items to be created.

Optionally, you can specify a limit to the number of items that can be created.

See Configuring mass create and mass update settings on page 32.

Single Source
Select Yes or No.
Note:  A source record supplies the data in an info cluster. A source record can pertain to an actual
style, material, or trim in Infor Fashion PLM or to a style, material, or trim template.

3 To specify info clusters that will be updated using information from the source record, select Yes
or No in these fields:

• Overview
• Colorways
• Extra Details
• Care
• Sizes
• Characteristics
• Sourcing
• Compliance

4 Optionally, set info clusters as favorites.

Setting favorites enables you to save your custom settings and use them repeatedly.

To save info cluster settings, click Set as Favorite.

Note:  To clear all information on the Mass Create pane, click Clear.

5 Click Execute to create the records.

6 Select Run Now to execute the action immediately.

You can also select Schedule for Later and specify a date.

7 Click OK.

8 To verify if the action is successful, select Action > Task Monitor on the main menu.

See “Monitoring Tasks” in the PAH Online Help.

Mass updating trims
In Infor Fashion PLM, you can change and update information on multiple trims simultaneously to
speed up process around changes.

1 On the Trim panel, right-click a record and select Mass Update.

2 To specify the number of source records, select Yes or No from the Single Source list.

Note:  A source record supplies the data in an info cluster. A source record can pertain to an actual
style, material, or trim in Infor Fashion PLM or to a style, material, or trim template. Selecting No
enables you to use multiple materials as source records.
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3 To update records simultaneously, drag and drop styles from the Trim panel to the Item Basket in
the Trim - Mass Update pane.

Optionally, you can specify a limit to the number of items that you can drag and drop in this field.

See Configuring mass create and mass update settings on page 32.

4 To customize your info cluster settings, specify the info clusters that will be updated by selecting
Yes or No.

• Overview
• Colorways
• Extra Details
• Care
• Sizes
• Characteristics
• Sourcing
• Compliance

5 To identify the source record for each info cluster, drag and drop a style from the Trim panel to the
Source column.

6 Select Add to combine information from the source record with existing data in the material.

You can also select Replace to substitute existing data in the trim with information from the source
record.

7 You have the option to set info clusters as favorites.

Setting favorites enables you to save your custom settings and use them repeatedly.

To save info cluster settings, click Set as Favorite.

Note:  To clear all information on the Mass Update pane, click Clear.

8 Click Execute to create the records.

9 Select Run Now to execute the action immediately.

You can also select Schedule for Later and specify a date.

10 Click OK.

11 To verify if the action is successful, select Action > Task Monitor on the main menu.

See “Monitoring Tasks” in the PAH Online Help.

Mass replacing trims in BOM
In Infor Fashion PLM, you can simultaneously replace trims in multiple BOMs to speed up process
around changes.

1 On the Trim panel, right-click a trim record and click the Mass Replace in BOM.

You can also multiselect trim records.

2 To know in which style the selected trim is used, click the Trim/Where Used icon on the side bar.

3 On the Trim - Mass Replace in BOM pane, specify this information:
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Style Status
Select status from the list.

Single Source
Select to replace the trims with a single source.

4 Drag and drop a trim from the Trim panel to the Replace with column on the Trims to Replace table.

Note:  To set the Replace with value individually for each trim, ensure that Single Source is cleared
and then select the row of the desired trim before dragging and dropping a trim to the Replace with
column on the Trims to Replace table.

If you drag and drop a trim on any space outside the Replace with column, a new row is added on
Trims to Replace table.

5 From the Trim/Where Used pane, select styles and then drag and drop the styles to the Style column
on the Trims to Replace table.

6 Optionally, under the Replace in column, select the BOM versions for each style.

7 Click Execute.

8 Select Run Now to execute the action immediately.

You can also select Schedule for Later and specify a date.

9 Click OK.

10 To verify if the action is successful, select Action > Task Monitor on the main menu.

See “Monitoring Tasks” in the PAH Online Help.

Mass creating request for trims
1 On the Trim panel, right-click a trim record and click the Mass Create Request.
2 To create requests for multiple records, drag and drop records from the Trim panel to the Item

Basket in the Request - Mass Create pane.

3 You have the option to specify the suppliers and size range for each trim in the Item Basket.

To select suppliers for a trim, click the Supplier cell and select suppliers from the list. Available
options depend on the suppliers that you have associated to the trim record.

To select a size range, click the Size Range cell and select a size range from the list. Available
options depend on the ranges that you have associated to the trim record.

4 To specify request details, specify this information:

Request ID
Specify the Request ID.

Request For
This field is updated automatically with the type of the requested items.

Type

Select a request type.

You can define types in Generic Lookup.
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Sub Type

Select a request sub type.

You can define request sub types in Generic Lookup.

Due Date
Select a due date.

Ship to
Specify the delivery address.

Delivery Method

Select a delivery method.

You can define delivery methods in Generic Lookup.

5 Select available reports and click >> to move them to the Selected Reports box.

To remove selected reports, click <<.

6 Optionally, set reports as favorites.

Setting favorites enables you to save your custom settings and use them repeatedly.

To save report settings, click Set as Favorite.

Note:  To clear all information on the Mass Create pane, click Clear.

7 Click Execute.

8 Select Run Now to execute the action immediately.

You can also select Schedule for Later and specify a date.

9 Click OK.

10 To verify if the action is successful, select Action > Task Monitor on the main menu.

See “Monitoring Tasks” in the PAH Online Help.

Compliance testing of trims
Compliance tests enable you to verify that the development of a trim follows rules and standards, as
prescribed within your company or by an international body in the fashion industy. In Infor Fashion
PLM, you define compliance testing of a trim by adding tests or standards that you previously defined
within the application on the Compliance tab.

After defining compliance tests for a trim, you can request for compliance tests from your supplier in
Partner Collaboration.

See the Infor Fashion PLM Partner Collaboration User Guide.
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Adding compliance tests
Note:  Tests and standards that you drag and drop from the libraries are saved automatically.

1 Select Basics > Trim.

2 On the trim details page, click the Compliance tab to display the Performance Testing page.

Add tests from a standard to the Compliance tab
1 From the main menu, open the Standard panel and dock it to any side of the main window.

Alternatively, you can click the Standards icon on the sidebar.

2 Drag and drop a standard to the Performance Testing page of the Compliance tab.

Note:  If you drag a standard that has a different module type or category, a message will appear
in the workbench to confirm the action. Click Yes to continue.

Tests from that standard that are tagged as Mandatory and Default are displayed on the page.

To add specific tests from a standard to the Compliance tab, open a standard details page and drag
and drop tests to the Compliance tab.

To remove tests from the Compliance tab, right-click a test and select Delete. Deleting mandatory
tests will also delete the entire standard where the mandatory test is included.

To remove a standard from the Compliance tab, right click a test and select Delete Standard. All
tests associated to the selected standard will be removed.

Add tests to the Compliance tab
1 From the main menu, open the Test panel and dock it to any side of the main window.

Alternatively, you can click the Tests icon on the sidebar.

2 Drag and drop tests to the Performance Testing page of the Compliance tab.

Note:  You can also right-click an existing test on the Compliance tab and select Add Test. A window
showing tests that are not included in any standard or tests with Optional priority is displayed. Drag
and drop tests to the Compliance tab.

If you removed tests from a standard in the Compliance tab, you can add them again by right-clicking
and selecting the tests.

Defining compliance tests for a trim
After adding tests to the Compliance tab of a trim, you must define conditions and requirements that
will serve as the criteria in evaluating test results.

1 On the trim details page, click the Compliance tab to display the Performance Testing page.

2 Specify this information:
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Operator
Select a condition from the list.
• = requires the test result to be the exact value as the performance requirement.

• < requires the test result to be less than the value that you specify as the performance
requirement.

• > requires the test result to be greater than the value that you specify as the performance
requirement.

• <= requires the test result to be less than or equal to the value that you specify as the performance
requirement.

• >= requires the test result to be greater than or equal to the value that you specify as the
performance requirement.

• <> requires the test result to be greater or less than the value that you specify as the performance
requirement.

• Between requires the test result to be between the value that you specify as the performance
requirement.

Performance Req.
Specify the performance requirement.

Notes
Provide any additional comments on the compliance test.

Issue Date
Specify an issue date.

Expiry Date
Specify an expiry date.

Attachment

Drag and drop files to the Attachment column to save related files to a test method.

3 Optionally, click the Trim/Sourcing icon on the sidebar to view suppliers that are assigned to the
item.

4 From the Trim/Sourcing pane, drag and drop a supplier to the Performance Testing page to associate
a supplier to the compliance test.

Test Result and Notes columns are added on the table for each selected color per supplier. If no
color is added, Test Result and Notes columns for each supplier are added to the page.

Note:  The cells on the Test Result column is highlighted in red if the test result does not meet the
required value of the compliance test.

Reports for a trim
In Infor Fashion PLM, you can create and generate reports that provide specific information about a
trim. These are the available reports that you can create for a trim:
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• Trim Card
• Trim Overview

See Generating reports on page 126.

Archiving trim records
Archive trim records to organize the Trim panel items.

Archiving trim records
You may archive trim records even if they have dependencies from other sources.

1 On the Trim panel, right-click a record and select Archive.

Note:  You may select multiple records to archive.

2 On the Trim dialog-box, click Yes.

3 To restore archived records, select Admin > Manage Archived Records.

4 On the Manage Archived Records dialog box, specify this information to filter the archived records:

Module
Select Trim.

Changed By
Select the user who archived the records.

Date From and Date To
Specify the date or span of date where the records were archived.

5 Click Filter.
6 Right-click a record, then select Restore.

Note:  You may select multiple records to restore.

Restoring archived trim records
Restore archived trim records through the Manage Archived Records action.

1 Select Admin > Manage Archived Records.

2 On the Manage Archived Records dialog box, specify this information to filter the archived records:

Module
Select Trim.
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Changed By
Select the user who archived the records.

Date From and Date To
Specify the date or span of date where the records were archived.

3 Click Filter.
4 Right-click a record, then select Restore.

Note:  You may select multiple records to restore.
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Chapter 8: Troubleshooting

Learn how to troubleshoot known issues in Infor Fashion PLM.

Fixing values in exported grids or generated reports
In Infor Fashion PLM, you can export grids or generate reports in CSV format. Cells that contain fractions
may be displayed by Excel as dates. If there are discrepancies on the values in the exported grid or
generated report, format the cells to text.

Cannot load assemblies from remote resources
Upon launching the application, users may encounter an error "Cannot load assemblies from remote
resources". This is encountered when servers have tighter security policies. To correct the issue, open
the Ird.SC.Launcer.exe.config file in the Assembly Area folder where the main application is
installed, and insert these lines:

<runtime>
     <loadFromRemoteSources enabled="true"/>
   </runtime>

Images updated through an external editor are not
updated in the application
Images that have been edited from an external editor application may not be displayed as updated in
the application. To correct the issue and display updated images, restart the application.
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Attachments being updated are not reflected in the
application
Attachments, such Microsoft Word documents or Excel spreadsheets, may not be displayed as updated

in the application. To correct the issue, save the record first before editing an attachment.
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Appendix A: Working with user exits

Learn how to create and run user exits to customize the predefined subroutines in Infor Fashion PLM.

User exit parameters
A user exit is a customized program which is called by a software package to replace the predefined
subroutines in the program. Infor Fashion PLM supports user exits for its costing module.

This table shows the parameters that you can use in Infor Fashion PLM user exits:

NotesParameter Name

Style_BrandName

Style_SeasonName

This parameter is hidden in the user interface but can be
seen in Generic Lookup, Sourcing, and Cost Model.

Style_SeasonCode

This parameter is hidden in the user interface but can be
seen in Generic Lookup, Sourcing, and Cost Model.

Style_COOCode

Style_COOName

Style_RegionName

This parameter is hidden in the user interface but can be
seen in Generic Lookup, Sourcing, and Cost Model.

Style_RegionCode

Style_CollectionName

This parameter is hidden in the user interface but can be
seen in Generic Lookup, Sourcing, and Cost Model.

Style_CollectionCode

Style_CategoryName

This parameter is hidden in the user interface but can be
seen in Generic Lookup, Sourcing, and Cost Model.

Style_CategoryCode

Style_SubCategoryName

This parameter is hidden in the user interface but can be
seen in Generic Lookup, Sourcing, and Cost Model.

Style_SubCategoryCode
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NotesParameter Name

Style_SubSubCategoryName

This parameter is hidden in the user interface but can be
seen in Generic Lookup, Sourcing, and Cost Model.

Style_SubSubCategoryCode

Style_GenderName

This parameter is hidden in the user interface but can be
seen in Generic Lookup, Sourcing, and Cost Model.

Style_GenderCode

Style_UOMName

This parameter is hidden in the user interface but can be
seen in Generic Lookup, Sourcing, and Cost Model.

Style_UOMCode

Style_UserDefinedField1Name

This parameter is hidden in the user interface but can be
seen in Generic Lookup, Sourcing, and Cost Model.

Style_UserDefinedField1Code

Style_UserDefinedField2Name

This parameter is hidden in the user interface but can be
seen in Generic Lookup, Sourcing, and Cost Model.

Style_UserDefinedField2Code

Style_UserDefinedField3Name

This parameter is hidden in the user interface but can be
seen in Generic Lookup, Sourcing, and Cost Model.

Style_UserDefinedField3Code

Style_UserDefinedField4Name

This parameter is hidden in the user interface but can be
seen in Generic Lookup, Sourcing, and Cost Model.

Style_UserDefinedField4Code

The field name HTS Code in the user interface is mapped
with this parameter.

Style_HTSName

This parameter is hidden in the user interface but can be
seen in Generic Lookup, Sourcing, and Cost Model.

Style_HTSCode

Style_Number

Style_Name

This parameter is hidden in the user interface but can be
seen in Generic Lookup, Sourcing, and Cost Model.

Style_AltProductCode

Style_FreeField1

Style_FreeField2

Style_FreeField3

Style_FreeField4

Style_NumericValue1
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NotesParameter Name

Style_NumericValue2

Cost_CurrencyCode

Cost_CurrencyName

This parameter is hidden in the user interface but can be
seen in Generic Lookup, Sourcing, and Cost Model.

Cost_ModelCode

Cost_ModelName

This parameter is hidden in the user interface but can be
seen in Generic Lookup, Sourcing, and Cost Model.

This parameter appears in the Style Costing tab.

Supplier_Code

This parameter appears in the Style Costing tab.Supplier_Name

Supplier_CountryCode

Supplier_CountryName

Supplier_LeadTime

Supplier_LeadTimeUOMCode

Supplier_LeadTimeUOMName

Supplier_MinimumQuantity

Supplier_MinimumQuantityUOMCode

Supplier_MinimumQuantityUOMName

Supplier_DeliveryMethodCode

Supplier_DeliveryMethodName

Supplier_DeliveryTermCode

Supplier_DeliveryTermName

This parameter is hidden in the user interface but can be
seen in Generic Lookup, Sourcing, and Cost Model.

Supplier_CurrencyCode

Supplier_FreeField1

Supplier_FreeField2

Supplier_FreeField3

Supplier_InternalExternal

Supplier_BOMVersionNumber

Supplier_BOMVersionName
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Managing user exits
When creating user exits, make sure that the script follows the required source code template or
signature to enable the Infor Fashion PLM application to recognize and execute them.

These scripting languages are supported:

• .NET (any .NET language, C#, Visual Basic, F#)
• VBScript
• JavaScript

These are source code templates or signatures for each language:

• .NET

using System;
using System.Collections.Generic;
using System.ComponentModel.Composition;
using System.Linq;
using System.Text;
using System.Threading.Tasks;
using Ird.SC.Arp.Assortment.UserExits;
using System.IO;

namespace SampleUserExits
{
    [InheritedExport(typeof(IOperation))]
    [ExportMetadata("Id", "86fa59f4-483e-4cdf-908f-dd2704311d4e")]    
         //Unique Id for the UserExit, use GUID
    [ExportMetadata("Name", "My User Exit in C#")]                    
         //Display Name for the User Exit
    [ExportMetadata("Description", "This is a sample UserExit written 
in C#")] //The description for the User Exit
    public class MyUserExits : IOperation
    {
        #region IOperation Members
        
        //This Execute() method is called every time you run a User Exit.

        public object Execute(params object[] args)
        {
            //Retrieve and assign the parameters passed to a Dictionary
 key pair value object.
            Dictionary&lt;string, object&gt; parameters = args[0] as 
Dictionary&lt;string, object&gt;;

            // return the value in decimal type
            return &lt;value&gt;;
        }

        #endregion
    }
}
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• JavaScript

var Id, Name, Description, Args
Id = "9d43780a-2eb8-425d-a1c9-8dc189758878";   //Unique Id for the 
Script, use GUID
Name = "UserExit using JavaScript scripting"; //Display Name for this 
User Exit Script   
Description = "This is a UserExit using JavaScript scripting"; //Descrip►
tion for the Script
Args = []; //This will hold the parameters

//This Execute() method is called everytime you run a UserExit, do not
 remove.
function Execute() {
    var result;
    //return the value.
    return result;
}

• VBScript

Dim Id, Name, Description, Args

Id = "206eeb59-d83b-4459-aec1-3e7b6bd78fbe"                 '* Unique 
Id for the Script, use GUID
Name = "UserExit using VBScript scripting"                  '* Display
 Name for this Plugin Script
Description = "This is a sample User Exit using VBScript"   '* Descrip►
tion for the Script

'* This will hold the parameters
Set Args = CreateObject("Scripting.Dictionary")

'* This Execute() method is called everytime you run a UserExit, do not
 remove.
Function Execute() 
 
  Execute=FormatNumber(123.456)

 '* Always set the Args variable to Nothing after using it.
 Set Args = Nothing
End Function

Creating a user exit in .NET
1 Create a class library project in Visual Studio.

2 Reference Ird.SC.Arp.Assortment.UserExits.dll from the Assembly Area of your installed Infor
Fashion PLM application in your Visual Studio project.

3 Create a class and inherit and implement the IOperation interface from the
Ird.SC.Arp.Assortment.UserExits namespace.
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4 Copy the output .dll file of your project to the Extensions folder of the application, located at C:\
Users\<username>\AppData\Roaming\Infor\Extensions.

This is a sample source code written in C#:

using System;
using System.Collections.Generic;
using System.ComponentModel.Composition;
using System.Linq;
using System.Text;
using System.Threading.Tasks;
using Ird.SC.Arp.Assortment.UserExits;
using System.IO;

namespace SampleUserExits
{

    [InheritedExport(typeof(IOperation))]
    [ExportMetadata("Id", "86fa59f4-483e-4cdf-908f-dd2704311d4e")]    
         //Unique Id for the UserExit, use GUID
    [ExportMetadata("Name", "My User Exit in C#")]                    
         //Display Name for the User Exit
    [ExportMetadata("Description", "This is a sample UserExit written 
in C#")] //The description for the User Exit
    public class MyUserExits : IOperation
    {
        #region IOperation Members
        
        //This Execute() method is called every time you run a User Exit.

        public object Execute(params object[] args)
        {
            //Retrieve and assign the parameters passed to a Dictionary
 key pair value object.
            Dictionary&lt;string, object&gt; parameters = args[0] as 
Dictionary&lt;string, object&gt;;

            decimal cost = 0.00m;

            //how to check if the parameters contain a particular key
            if (parameters.ContainsKey("Supplier_CountryCode"))
            {
                string countryCode = parameters["Supplier_Coun►
tryCode"].ToString();
                switch (countryCode.ToUpper())
                {

                    case "US": //United States
                        cost = 112.50m;
                        break;
                    case "CN": //China
                        cost = 45.00m;
                        break;
                    case "SE": //Sweden
                        cost = 99.50m;
                        break;
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                    case "VN": //Vietnam
                        cost = 36.75m;
                        break;
                    case "FR": //France
                        cost = 87.10m;
                        break;
                    default:   //Other Countries
                        cost = 100.00m;
                        break;
                }
            }

            // return the value in decimal type
            return cost;
        }

        #endregion
    }

}

Note:  There is no file name requirement for .NET user exit dll. As long as the code has the signature
and is implementing the IOperation interface under the Ird.SC.Arp.Assortment.UserExits
namespace that is defined for user exits, the application will execute the script.

For example, you can name your .NET user exit dll as M3BEConnector.dll or TaxTable.dll.

Creating a user exit in JavaScript or VBScript
1 Using any scripting editor tool, copy the source code template for the particular language.

2 Create your own implementation of the Execute method.

3 Specify a file name for your script in this format:

<script filename>.<script engine>.uxt

where:

• script filename is any name that identifies your user exit
• script engine is the script you are using: vbs for VBScript and jvs for JavaScript

4 Access the Extensions folder, located at C:\Users\<username>\AppData\Roaming\Infor\
Extensions, and copy your script file in the folder.

These are sample scripts for each language:

• JavaScript

var Id, Name, Description, Args

Id = "9d43780a-2eb8-425d-a1c9-8dc189758878";                   //Unique
 Id for the Script, use GUID
Name = "UserExit using JavaScript scripting";                //Display
 Name for this User Exit Script   
Description = "This is a UserExit using JavaScript scripting"; //De►
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scription for the Script
Args = []; //This will hold the parameters

//This Execute() method is called every time you run a UserExit, do 
not remove.
function Execute() {

    //Retrieve and assign a parameter to a variable.
    var htsCode = Args["Style_HTSCode"];
    var taxCost;

    if (htsCode == '6105.10.00001') {
        taxCost = 0.07;
    }
    else if (htsCode == '6105.10.0010') {
        taxCost = 0.197;
    }
    else if (htsCode == '6105.10.00') {
        taxCost = 0.20;
    }
    else {
        taxCost = 0.10;
    }
    //return the value.
    return taxCost;
}

• VBScript

Dim Id, Name, Description, Args

Id = "206eeb59-d83b-4459-aec1-3e7b6bd78fbe"                 '* Unique
 Id for the Script, use GUID
Name = "UserExit using VBScript scripting"                  '* Display
 Name for this Plugin Script
Description = "This is a sample User Exit using VBScript"   '* Descrip►
tion for the Script

'* This will hold the parameters
Set Args = CreateObject("Scripting.Dictionary")

'* This Execute() method is called every time you run a UserExit, do
 not remove.
Function Execute() 
  Dim categoryCode
  categoryCode = Args.Item("Style_CategoryCode")
  
 If categoryCode = "SH" Then
  Execute=FormatNumber(100.25)
 ElseIf categoryCode = "DR" Then
  Execute=FormatNumber(215.123456, 6)
 ElseIf categoryCode = "PT" Then
  Execute=FormatNumber(890.89, 3)
 Else
    Execute=FormatNumber(950.564351)
 End If
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 '* Always set the Args variable to Nothing after using it.
 Set Args = Nothing
End Function

Running a user exit
1 In Infor Fashion PLM, open a style item and click the Costing tab.

2 Double-click any cost element.

3 In the Type field, select User Exit.
4 In the User Exit field, select a user exit on the list and click Run User Exit.

Note:  The user exit is executed only when you click Run User Exit. It will not be executed when
you click Recalculate or when you save the record.

Configuring user exits that can be stored in a server
1 Locate and open the Ird.SC.Launcher.exe.config file in Notepad or any text editor application.

Note:  You must open the .config file using administrator privileges to successfully save changes.
You can also copy and edit the .config file in a folder that is not write-protected and then overwrite
the original file.

2 Search for APPLICATION_DATA_REDIRECTION tag.

Specify a location to store the user exit.

3 Save your changes and close the file.
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